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1.1 Overview 

GEOPAK is a comprehensive software package that covers every project phase from 
conceptualization to final quantities.  The software works within the MicroStation graphic 
environment providing true interactive design.  For example, a horizontal alignment can be 
created graphically, it can be calculated with the coordinate geometry component of GEOPAK or 
some interactive combination of the two.  Dynamic on-screen design provides immediate 
interpretation of plan view geometrics for making design choices through visualization. 
 
Using GEOPAK helps ensure consistency and accuracy of design work and generate significant 
timesaving in the overall effort of producing construction plans. 
 
For GEOPAK support, please contact the CADD Support Center. 

1.2 File Names 

GEOPAK uses and/or creates files during the design process.  The files you need to be familiar 
with are listed below:  

job###.gpk This binary file is created when the user starts a coordinate geometry (COGO) 
session for the first time or through Project Manager and may be appended to 
during the design process. All coordinate geometry elements are stored in this 
file. Multiple users can access this file at the same time, and only one file 
should be created for each project.  The "###" is the only variable in this name.  
It represents a job number (up to 3 alphanumeric characters) unique to a project 
and is defined by the user upon creation.  MoDOT users should use the last 3 
digits of the job number.  Example J1P0999 -> job999.gpk 

fname.inp  Any ASCII input file for running GEOPAK processes.  Name is user defined 
with a .inp extension. Example: shape.inp 

fname.log ASCII file used to capture results from processing input files, proposed cross 
sections, and earthwork. 

fname###.ioc ASCII input file for loading data during a COGO session. "###" represents the 
job number and "oc" is the operator code (users initials). Example: align999.icu 

fname###.ooc ASCII output file created by GEOPAK during a COGO session. Variables are 
the same as defined above. Example: align999.ocu 

fname.dat A binary file that contains string and point information to be used for digital 
terrain model construction. 

fname.tin A binary file containing triangular surfaces also known as the digital terrain 
model (DTM). 

project.prj Binary file resulting from the creation of a new project. 
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1.3 Accessing GEOPAK Road 

GEOPAK is started upon entering a MicroStation File with User: set to design, as shown in the 
following dialog.  This setting is very important for two reasons.  First, GEOPAK is configured 
to work in the design Interface.  Second, MicroStation stores all elements in meters and converts 
those values to the working units for the design file (Settings > Design File…).  Design user files 
are set to use the U.S. Survey foot (0.304800609601219 meters per U.S. Survey foot), which is 
the basis for the Modified State Plane Coordinates used by the State of Missouri for all survey 
related work including highway alignments.  Bridge user files use the International foot (0.3048 
meters per International foot), which is the standard for structural drawings.  Since GEOPAK 
Road is used for alignment work, files set to the U.S. Survey foot should be used. 

 

 
 
Activate GEOPAK by going to the MicroStation pull-down Applications > GEOPAK > 
Activate GEOPAK.  Once GEOPAK is active, the Applications menu expands to show all 
installed products including GEOPAK Road.  When each tool is selected, the corresponding 
dialog appears.  To utilize the full potential of GEOPAK, GEOPAK dialogs may be interspersed 
with generic MicroStation commands.  Several dialogs may be opened simultaneously. 
 
To close a dialog, simply click the X in the upper right corner of the dialog.  In addition, the 
Coordinate Geometry dialog and Design and Computation Manager may be closed by selecting 
the File > Exit option.  Other various dialogs will have a Cancel button, which will exit the 
dialog.  Exiting the MicroStation file automatically closes all GEOPAK dialogs. 
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1.4 Starting A New MicroStation File For Use With GEOPAK 

As stated in the previous section, GEOPAK Road as used at MoDOT utilizes the actual Modified 
State Plan coordinates assigned to the project.  This coordinate system uses the U. S. Survey 
Foot as the master unit.  For consistency, the MicroStation design file should also use the same 
master unit.  For this to occur, the MicroStation seed file should be selected from the following 
location: t:\standard\wsmod\design\seed_i.  The rest of this section guides you through the steps 
to manual create a new two-dimensional drawing using the U. S. Survey Foot as the master unit. 
 
To create a new MicroStation design file, select File > New from the pull down menu or 
click on the new file icon shown to the right.  This will bring up the following dialog: 

 

 
 
On the right side of the dialog is the Directories portion, which is outlined above.  Use it to 
navigate to the folder for the location of the new file.  Next, go to the bottom of the dialog and 
make sure the desired Seed File is listed.  If it is not, as is the case above, press the Select button 
in the lower right hand corner of the dialog to bring up the Select Seed File dialog shown on the 
next page: 
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As shown above in the Select Seed File dialog, use the Directories portion to navigate to 
 t:\standard\wsmod\design\seed_i. 
 
Select i_project_2d.dgn from the Files list on the left side of the dialog as shown above and 
click OK. 
 
This will return you to the New dialog.  Type the name for the new file in the Files: field, which 
is outlined in the following figure, and click OK to create the file. 
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1.5 User Preferences 

The User Preferences dialog is used to set items that determine how distances, directions, and 
stationing is displayed and calculated, as well as the units that are used.  The User Preferences 
dialog can be accessed from Applications > GEOPAK Road > User Preferences.  The 
following dialog appears. 
 

 
 

Most of the settings in this dialog will be set when the project is setup.   
 
The Working Directory is used to tell GEOPAK where the data files for a particular project can 
be found.  If a user does not want to work within a specific project, they can delete the 
information out of this field, and GEOPAK will use the directory that the open MicroStation file 
is located in. 

1.5.1 Feature Preferences 
The Feature Preferences button activates the following dialog. 

 

 
 
The SMD File is used to control the symbology of survey elements.  Users will not be able to 
edit the SMD File, however, the Edit SMD… button can be used to view the feature codes.  The 
Apply Best Match Feature toggle should be checked to allow for proper import of survey data.  
The scale of the features can be controlled using the Plot Scale.  This should be set to the scale 
of the plan sheets to be created. 
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1.5.2 COGO Preferences 
The COGO Preferences button will activate the following dialog. 

 

 
 
The Job (GPK) Open Mode allows the user to set certain constraints used upon creation of a 
new coordinate geometry data file.  So each time the Coordinate Geometry window is invoked 
for a job number that does not correspond with a job###.gpk file in the specified working 
directory, GEOPAK creates a new job###.gpk file based on the constraints set up in the COGO 
Preferences.  The three constraints are Create, No Create, and Query.  The Create mode 
automatically creates a new .gpk file without giving the user any warning.  The No Create mode 
does not allow the creation of a new .gpk file and gives the user a warning.  The Query mode 
gives the user a warning that this job###.gpk file does not exist in the current working directory 
as well as giving the user the option to proceed with the creation of the file or cancel it.  The 
default MoDOT Mode is set to Query. 
 
The Job Directory must be set to indicate the location of the coordinate geometry database 
(.gpk), which is automatically placed in the working directory when a GEOPAK job is first 
created.  If this field is not set, GEOPAK Survey will not run correctly.  The COGO Input File 
Directory and COGO Output File Directory can be set to indicate the location of the COGO 
input and output files respectively.  If these fields are not set, GEOPAK will look in the Job 
Directory.  If the Job (GPK) Directory is not set, GEOPAK will look for the files in the 
working directory.  If the Working Directory is not set in the GEOPAK User Preferences 
dialog, GEOPAK will look for the files in the directory where the active MicroStation file is 
located. 
 
The Redefinition of Elements toggles on or off the COGO redefine option.  This option is 
discussed further in Chapter 5.  The Force redefinition off at Cogo Activation will turn the 
COGO redefine toggle off whenever GEOPAK’s coordinate geometry tools are activated. 
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2.1 Objectives 

• Be able to start a new GEOPAK job with the Start Job dialog. 
• Be able to add a new user to an existing GEOPAK job with the Start Job dialog. 

2.2 Definition 

Start Job is a tool that will set up a GEOPAK job for a user, or add users to an existing job.  
Start Job creates the job directories and copies default MicroStation files to the directories.  
Start Job also appends the job number to the end of the copied MicroStation files if that option 
is activated.  Once a job has been created, Start Job adds a user to the job.  Start Job is only 
available in the design user interface in MicroStation. 

2.3 Accessing 

Start Job can be accessed from the MicroStation menu MoDOT > Start GEOPAK Job/Add 
User. 

2.4 Start Job Dialog 

Once the user has accessed the Start Job 
dialog box, shown right, the tool can be u
to either create a new job or add users to an 
existing job. 

sed 

 
If the user is creating a new job, do not 
check the Add Users to Existing Job 
toggle.  The user then types in the 
appropriate number in the Job Number 
field.  Note that the Browse button for 
selecting a job number is ghosted out.  This 
is because the job doesn’t exist yet.  The 
user needs to specify the path in which the 
job will be placed.  The Browse button can 
be selected to navigate through the path.  
The next step is to choose the userids of the 
people that will be working on the job. The user can select one or multiple user ID’s. 
 
In addition, for a new job, select the Units and the Sheet types that will be used for the job.  This 
will create a directory for each Sheet type selected to place the sheets into as they are created. 
 
If a job already exists, and users are being added to the job, check the Add Users to Existing 
Job toggle.  Note that the Path, Units, and Sheets options will ghost out, and the Job Number 
Browse option will become available.  Because the job already exists, the user can browse 
through the job directory to select the Job Number. 
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Once all fields have been filled in, select the OK button.  The job directories will be set up as 
shown below. 

T:\ 
br-proj\ 

A_Geopak\ 
D# (last digit of district number) \ 

job number\ 
data\ 

dtm.dgn 
pattern_shape.dgn 
plan.dgn 
profile.dgn 
topo.dgn 
xs.dgn 
job###.gpk (### = last three letters of the job number) 
MoDOT.lpf 
MoDOT.ols 

plan_sheets\ 
100 
20 

project\ 
job number.prj (Project Name / Number) 
projdbs\ 

job number.rpt (User Preferences) 
userid\ 

job number.003 (Proposed Cross Sections) 
job number.004 (Earthwork) 
job number.005 (Cross Section Sheets) 
job number.006 (Survey) 
job number.008 (Define-Working Alignment) 
job number.009 (Existing Ground Profile) 
job number.00a (Vertical Alignment) 
job number.00c (Limits of Construction) 
job number.00d (Existing Ground-DTM) 
job number.00e (Existing Ground Cross-Sections) 
job number.00f (Reports and XS Quantities) 
job number.010 (Model) 
job number.011 (Draw Pattern) 
job number.012 (Calculate Superelevation) 
job number.014 (Plan / Profile Sheets) 
job number.ifo (User Id) 

 

The data directory contains any project data.  This is the directory that contains the MicroStation 
drawings, the GEOPAK coordinate geometry database (.GPK), and any input or output files.  
The plan_sheets directories contain the detail sheets drawn at specific scales for the project.  The 
project directory contains the GEOPAK project manager file (.PRJ), and the userid directories.  
The userid directories contain the user runs for the job. 
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3.1 Objectives 

• Learn how to set up a project using Project Manager. 
• Learn how to utilize Project Manager as a workflow guide. 
• Learn how to access GEOPAK dialogs from the Project Manager. 

3.2 Definitions 

Project Manager is a GEOPAK tool that associates a project with its respective gpk job number, 
users, working directories and project files.  Project Manager provides the user with an easy 
workflow system that keeps records of processes run throughout the design of a project.  

3.3 Accessing 

To access Project Manager: 
•  Select Applications >> GEOPAK 
Road >> Project Manager (as shown 
in the figure to the right) or  
 

• Select the Project Manager icon 
from the GEOPAK Road Tools 
(both are shown to the 
left), which are opened by 
selecting Applications >
GEOPAK Road >> 
GEOPAK Road Tools.   

> 

 
The following dialog depicted to the right appears:  

3.4 Project Manager Dialog 

3.4.1 General Description 
The current directory is displayed at the top of the 
dialog box, which can be changed by navigating to a 
different directory in the Directories list box.  This 
navigation is the first step in selecting an existing 
project or creating a new one.  Project files (.prj) 
are displayed in the Projects list box.  The project 
files should be located in the  
t:\br-proj\A_Geopak\district\jobnumber\project 
directory. 
 
The remainder of the Project Manager dialog box displays information after a project has been 
selected from the Projects list box.  At the bottom of the dialog are the OK and Cancel buttons.  
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If the user wishes to exit Project Manager, the Cancel button should be selected.  To continue in 
the Project Manager process, the OK button should be selected. 

3.4.2 Project Manager Menu Bar 
There is three pull down choices on the Menu Bar: Projects, Directory, and Admin.  Each of 
these choices has options contained in the pull down. 

3.4.2.1  Project Tools 
There is four choices under the Projects pull down: 
New, Edit, Delete, and Exit as shown below. 
 
As can be seen from this dialog box, the Windows 
motif also keeps track of the last few processes that 
have been executed.  These may be recalled as 
needed by selecting the desired process.  

3.4.2.1.1 New… 
The New menu option is used to create a new 
project.  The .prj file will be stored in the directory 
shown in the Directory path at the top of the Project 
Manager dialog box.  When the New menu option is 
selected, the Create New Project dialog appears 
(shown at the bottom of the page). 
 
The Project Name can be any number of 
alphanumeric characters.  For MoDOT projects, the 
Project Name needs to be the same as the job 
number. (i.e. j1p0999.prj)  The Working Directory 

specifies the location of the project data files.  The Working Directory may be keyed in or the 
Select button may be chosen and the appropriate directory selected.  For MoDOT Bridge, the 
Working Directory should be set to t:\br-proj\A_Geopak\district\jobnumber\data. 
 
The next field is for typing in the 
COGO job number, or the Select 
button may be chosen and the 
appropriate COGO job number 
selected. 
 
Next the Preferences button 
should be chosen and the Project 
Preferences dialog appears, 
which is depicted on the 
following page. 
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The user may set the particular 
parameters for each project as 
well as the Working 
Directory.  This keeps the u
from re-setting them when
changing projects since the 
project’s preferences are 
recalled when entering the 
project.  After all of the 
information is entered, select 
OK to accept the changes, or 
Cancel to reject them.  For 
more about User Preferences, 
see Section 1.5 in Chapter 1. 

ser 
 

 
Shown below is a sample project that includes a project description, which may be keyed in at 
the bottom of the Create New Project or Project Info Edit dialog box.  The Working 
Directory is set to: 

t:\br-proj\a_geopak\d5\j5p0100\data. 
 

 

3.4.2.1.2 Edit… 
The Edit menu option is used to change any settings associated with the currently selected 
project.  When chosen, the Project Info Edit dialog box shown above appears. 

3.4.2.1.3 Delete… 
The Delete menu option is used to delete any project that has been stored.  The user highlights 
the project in the Projects and selects Delete. 

3.4.2.1.4 Exit 
The Exit menu option closes the Project Manager and writes the settings to a resource file. 
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3.4.2.2 Directory Tools 
There are two options under the Directory pull down, Create New Directory and Current 
Working Directory as shown below. 

 

 
 

The Create New Directory option creates a new directory on the disk. 
 
If the Current Working Directory option is chosen, the directory path in Project Manager is 
changed to that directory. 

3.4.2.3 Administration Tools 
The Administration menu option is used to set a password on a project.  It is recommended that 
a password not be used since the project will need to be accessed by more than one user. 
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3.5 Project Users Dialog 

Once a project is highlighted and OK is selected, the Project Users dialog appears.  
 
This dialog has three sections: Project Users, 
User Info, and Description.  The Project 
Users list displays a list of users that have been 
created to work with any project that resides in 
the current projects home directory.  The names 
shown in Project Users will be the userid’s of 
the people working on that project as specified 
in the Start Job dialog.  Within the User Info 
group box, the Full Name field further 
identifies the user, and displays the full name of 
the user that is currently selected.  The OP 
Code field displays the GEOPAK Operator 
Code of the currently selected user.  The 
GEOPAK Operator Code is used for all 
coordinate geometry operations during this 
session.  The Operator Code, along with the Job 
Number, will be utilized whenever an input or 
output file is created by the software.  The 
Operator Code will be the user’s first and last 
initials.  The Description field displays the 
description of the currently selected user. 
 
Four tools are supported on the Project Users 
pull down as depicted in the exploded view to 
the right. 

3.5.1 New 
The New pull down menu option creates new users.  This option is not to be used in MoDOT.  
To create a new user for a project, use Start Job/Add User under the MoDOT menu with Add 
Userids to Existing Job activated, as show in the following figure.  Start Job/Add User must be 
used for the user to have the default MoDOT runs. 
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3.5.2 Edit 
The Edit pull down menu option allows the user to change any of the parameters of the currently 
selected user.  (Note: The User cannot be changed.  This will change the user information for the 
current project only.) 

3.5.3 Password 
The Password tool creates or modifies a password for the selected user.  If the selected user 
already has a password, the user is prompted to enter the current password before continuing. 

3.5.4 Exit 
The Exit option closes the User dialog and returns back to the Project Manager dialog. 

3.6 Road Project Dialog 

After a minimum of one user has been defined, selecting the OK button on the lower left corner 
of the Project Users dialog or double clicking on a Project User will open the Road Project 
dialog. 
 

 

3-6 Missouri Department of Transportation 6/28/05 



GEOPAK Road for Bridge  Chapter 3 Project Manager 

3.6.1 General Description 
The top of the dialog displays the Working Directory, Working Alignment (if defined), User 
and GEOPAK Job Number.  In addition, a toggle for Working Alignment Influence Runs is 
also supported.  The bottom portion of the dialog box displays the various processes supported 
during the design process.  The small square in the upper right corner (to the right of the Job 
Number) will condense the dialog as depicted in the graphic below. 
 

 
 

3.6.2 Road Project Dialog Menu Bar 
The three pull down menu bar options are: F
Remember, and Options.  When the File 
option is selected, the choices are Close and 
Exit.  

ile, 

or 

ediately 
., which 

ggle is 

 
If the Close option is selected, the user is 
returned to the Project Manager dialog.  If Exit is selected, the user is exited from Project 
Manager. 
 
When the Remember option is selected, the 
user can instruct the software to remember the 
Project or the User in subsequent sessions.  F
example, if all both toggles are activated, and 
the Project Manager is completely closed, the 
invocation of the Project Manager imm
invokes the Road Project dialog (flow chart) and utilizes the project name, username, etc
were active when the Remember toggles were selected.  If only the Project toggle is activated, 
the user is returned to the Project Users dialog in subsequent sessions.  If only the User to
activated, the user is returned to the Project Manager dialog in later sessions, but will skip the 
Project Users dialog.  This option is particularly useful when the user is working on more than 
one project but always enters Road using a single user id. 
 
The Options menu allows the user to toggle on 
the Auto Sink option.  When toggled on, this 
option sinks (move behind the open drawing 
views) the Road Project Manager dialog when a 
tool is chosen from the Project Manager.  When 
a tool is closed, the Road Project Manager 
dialog becomes the active dialog. 
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3.6.3 Working Alignment 
The concept of a working alignment enables the designer to organize a project and to access 
project information without continually typing the required information.  On a simple project, 
only one working alignment may be needed.  However, on a more complicated project, an 
unlimited number of working alignments may be defined.  The designer can easily change from 
one working alignment to another by highlighting the desired alignment listed in the Select 
dialog.  Three tools relating to working alignments are located at the top of the Road Project 
dialog: 
 

• Select Button 
• Define Button 
• Working Alignment Influence Runs (toggle on left side of dialog) 

 

 
 

3.6.4 Select Option 
When the Select button is pressed, the Select Working Alignment dialog appears as depicted to 
the right.  If no working alignments have been defined, MoDOT appears in the Run List box.  If 
working alignments have been defined, they are listed with the last run time.  The description of 
the working alignment can be seen in the bottom of the dialog when each Name is highlighted.  
To select a previously defined working alignment, highlight the run from the list then press the 
OK button at the bottom of the dialog.  Double clicking on the Name also selects a previous 
working alignment for subsequent processing.  Pressing the Cancel button closes the Select 
Working Alignment dialog without any 
working alignment change.  Several file 
option are supported as depicted in the 
exploded view below.  These include 
New, Copy, Rename, and Delete.  
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• Run > New – allows the user to 
create a new working alignment.  
(Do not use this option as it will 
not copy the default MoDOT 
settings for the working alignment.  
Instead, use Run>>Copy>>Run to 
copy the MoDOT run.) 

 
• File > Copy – allows the user to 

copy an existing Project, User or 
Run. 

 
• File > Rename – allows the user t

change the name of the existing 
working alignment. 

o 

t 
gnment 

 
• File > Delete – allows the user to 

delete an existing working 
alignment. 

 

3.6.5 Define Option 
Once a Working Alignment is 
selected, pressing the Define button 
invokes the dialog depicted to the 
right.  The information that can be 
associated with a working alignment is 
listed in the left portion of the dialog 
box.  As each option is chosen, the 
right side of the dialog box changes to 
reflect the information needed as can 
be seen in the dialog box to the right 
after Profile View was selected.  
 
All information entered in these fields 
can be used in subsequent processes 
run from Project Manager.  In the 
beginning of a project, much of this 
information is not known but, as the 
user goes through the design process, i
can be added to the working ali
definitions.   
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For example, as soon as the c
has been stored in COGO, the 
user can enter that infor
the Plan View fields as depicte
to the right.  For a more comple
explanation of each option 
shown, please see the on line 
GEOPAK Help by going to the
MicroStation menu path: 
Applications > GEOPAK Road 
> Help. 

hain 

mation in 
d 
te 

 

3.6.6 Port Viewer 
The Port Viewer is a tool that enables the user to view all three major aspects of a road design 
simultaneously even though they are located in different files.  The three views include: 

• Plan 
• Profile 
• Cross Section 

 
As a prerequisite to invoking the Port Viewer, a working alignment must be defined with the 
following information. 

• Alignment Specification 
• Plan View Design File and Chain 
• Profile Information 
• Cross Section File 
• Digital Terrain Models 

 
The Port Viewer is covered in more detail in Chapter 16 of the manual.  The tool is invoked by 
clicking on the accented button in the following figure.  A error message is generated if all of the 
prerequisite information is not defined prior to activating the tool. 

 

 

3-10 Missouri Department of Transportation 6/28/05 



GEOPAK Road for Bridge  Chapter 3 Project Manager 

3.7 Project Manager Process 

The primary Road Project dialog is depicted below.  The advantage of utilizing the Road 
Project dialog rather than selecting functions directly from the Road menu is that pertinent 
information stored within the Project Manager is automatically displayed within the invoked 
dialog.  Therefore, job numbers, chain names, stationing, file names, and data associated with the 
project do not have to be typed in each time a dialog is utilized.  However, the user can change 
information in the fields. 
 

 
 
Many of the Project Manager processes function identically to their corresponding dialog’s 
invocation from the Road menu.  However, some of the procedures invoke the Select Run dialog 
prior to invoking the actual dialog.  The Select Run dialog allows the user to set up different 
options to use in alternative design choices. 
 
Each of the Road Project dialog processes is covered individually in the remaining chapters. 

3.7.1 Select Run Option 
When certain procedures are selected from the Project Manager dialog, the Select Run dialog 
is invoked.  The Select Run dialog allows the user to save the settings for each procedure in a 
Run that can then be recalled whenever the user needs to execute that same procedure.  With the 
individual runs, a user can keep a history of the project, and can access the various procedures 
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with the settings that were previously 
used.  This way a user can repeat various 
procedures with the same settings 
previously used.  
 
When the Select Run dialog is invoked, 
MoDOT appears in the Run List box.  
(Some Select Run boxes will display 
default run names such as English, 
Metric, I100, I20, etc.)  If Runs have 
been defined, they are listed with the last 
run time.  The description of the Runs 
can be seen in the bottom of the dialog 
when each Name is highlighted.  To 
select a previously defined Run, 
highlight the run from the list, and then 
press the OK button at the bottom of the 
dialog.  Double clicking on the Name 
also selects a previous Run for subsequent processing.  Pressing the Cancel button closes the 
Select Run dialog without any run settings change.  Several file option are supported as depicted 
in the exploded view below.  These include New, Copy, Rename, and Delete.  
 

• File > New – allows the user to 
create a new run.  (Do not use this 
option as it will not copy the 
default MoDOT settings for the 
procedure selected.  Instead, use 
Run>>Copy>>Run to copy the 
MoDOT run.) 

 
• File > Copy – allows the user to 

copy an existing Project, User or 
Run. 

 
• File > Modify – allows the user to 

change the name of the existing 
Run or its description. 

 
• File > Delete – allows the user to 

delete an existing Run. 
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Exercise 3-1 

This is an individual exercise to practice setting up the directory structure and files for a new 
GEOPAK job. 
 

1. Open any MicroStation file. 

 

2. Create the following job with the Start Job dialog (MicroStation menu path: 
 
 MoDOT > Start GEOPAK Job/Add User).  
 
Use the settings shown in the following dialog. 

 

 
 

3. Review the directory structure and the files created in the directory.  
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4. Use the Project Manager dialog to review the following project:  
 

Go to the directory t:\br-proj\A_Geopak\D3\j3p0497\project\ 
 

  
 

Choose Projects > Edit… as shown to the right: 
 

 Compare the information in the Project Info Edit dialog to that shown below. 
 
Project name: j3p0497 
Working Directory: t:\br-proj\A_Geopak\D3\j3p0497\data 
Job Number: 497 

 

 
 Set up the Preferences as shown below: 
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Click OK to accept the changes. 

 

5. Add User2 and User3 as users to the project.  
 

 

D) Click OK 
to finish 
the 
process. 

B) Continue 
by using 
this 
Browse 
button to 
choose 
the Job 
Number 
and Path.

A) Start by 
toggling on 
Add 
Userids to 
Existing 
Job. 

C) Select the 
USERIDS 
to be added. 
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Exercise 3-2 This is an individual exercise to practice setting up a new working alignment. 

1. Open the Microstation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

 
 

3. Select userc as the Project User. 
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4. Click on Select button at the top of the Road Project dialog as depicted below. 
 

 
 

In the Select Working Alignment dialog that appears, select the menu option:  
 Run > Copy… > Run. 
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 This will display the Select Run to  
Copy From dialog shown to the right.   
Select the default MoDOT run and  
click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Enter J2P0300 in the new Run  
Name field as depicted in the figure  
to the right and click OK to create  
the new run. 
 
 
 
 
 
 

 
Select the J2P0300 working alignment  
as shown below and enter the alignment  
by clicking OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

5/10/05 Missouri Department of Transportation 3-2-3 



Ex. 3-2 Working Alignment Setup GEOPAK Road for Bridge 

5. Enter the working alignment definition by clicking on the Define button to the right of the 
Select button in the Road Project dialog as shown below. 

 

 
 

6. Set up the default DGN files for the J2P0300 project as shown below: 
 
In the Plan View section, change the Design File to plan_j2p0300.dgn. 
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 In the Pattern section, change the Design File to pattern_shape_j2p0300.dgn. 
 

 
 

In the Shapes section, change the Design File to pattern_shape_j2p0300.dgn.  
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 In the Profile View section, change the Design File to profile_j2p0300.dgn.  
 

 
 

Save the changes to the working alignment definition by clicking OK.  This default 
alignment for the project will be modified and used as the basis for other parts of the project 
in later exercises. 
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Chapter 4 Digital Terrain Modeling 

4.1 Objectives 

• Understand Digital Terrain Models (DTM’s) 
• Learn how to analyze a digital terrain model 

 

4.2 Definitions 

A Digital Terrain Model (DTM) represents the topography of a project in the form of a 
triangulation network.  The DTM can be drawn in a three-dimensional file, and rotated to see the 
existing surface of the project area. 
 
Digital Terrain Models can be generated from various sources including MicroStation Elements, 
survey data, photogrammetry data, GEOPAK cross-sections, and geometry data. 
 
Triangulation is a mathematical process applied to stored elevation points and stored elevations 
along DTM break lines to create surfaces.  The result of triangulations is the creation of a .tin file 
from which original ground profiles and original ground cross sections can be generated. 
 
Digital Terrain Models (DTM) are made up of a network of triangles.  A triangle is used 
because three points define a particular plane in space.  This triangle then represents a slope on 
the existing ground passing through these three points. 
 
The DTM is made up of several types of elements including points, breaklines, boundary, voids, 
and islands. 

4.2.1 Points 
Points represent a particular location with an X, Y, and Z coordinate.  Each of these points will 
represent a vertex on a triangle in the digital terrain model.  Below is an example of a digital 
terrain model made from a set of points.   
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If a section is cut through this digital terrain model at the location A-A, where the elevation of 
the triangle leg as linearly interpolated between the triangle vertices is plotted along the distance 
of the section, the section would look as shown in the picture below. 

4.2.2 Break Lines 
Break lines represent a line along a change in slope.  Examples of breaklines may include the 
edge of shoulder, the toe of a slope, or the flow line of a ditch.  A triangle cannot cross a 
breakline.  If a triangle crosses a breakline, it is split into multiple triangles so that no triangle leg 
will cross the break line, and the triangles adjacent to the breakline will have a leg that lays on 
the breakline.   
 
Adding a breakline to the same set of points used above will produce the digital terrain model as 
shown below.   

 
Cutting a section at the same location will produce very different results as shown in the section 
below. 
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4.2.3 Boundary 
A boundary is the maximum external limits a digital terrain model can extend.  No triangles will 
be created outside of this boundary.  

4.2.4 Voids 
A void is an area where no contours can pass through.  Examples of voids include ponds, lakes, 
buildings, concrete pads, etc. 

VOID AREAS

4.2.5 Islands 
An island represents an area inside a void that contains contours.  

ISLAND 
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4.3 Accessing 

Selecting the Existing Ground push-button from Project Manager or 
the DTM Tools icon, and selecting a run will bring up the tool palette 
shown to the right.  All of the DTM tools can be accessed from the 
tool palette or from the DTM menu that can be accessed from the first 
icon in the tool palette.  
 

4.4 Settings 

Two user-defined stroking values need to be defined before graphics can be extracted to create a 
DTM.  Stroking is the process of automatically adding shots to the DTM Input file by 
interpolating new shots from the linear and curved sections of the data.  If the source topography 
data is mapped in a 3D-design file, stroking may be applied.  Stroking is not available if the 

pography data resides in a 2D-design file. 

rc and the chord used to approximate the arc 
 the DTM. 

ent such that the distance between the points is not 
ar Distance. 

 Extract Graphics or from the 
hic

 g the input data.  If file 

File Type 

process faster.  For ASCII files, the number of 

ile Open indicates if you are creating a new file or appending data to an existing file. 

to
 

Curve Stroke Tolerance  The maximum distance 
between the a
in
 

 
Minimum Linear Distance If a linear segment is greater than the Minimum Linear Distance, 
points are interpolated and added to the segm
greater than the Minimum Line

4.5 Extract Graphics 

The Extract Parameters tool translates MicroStation elements into DTM 
input data.  The dialog box shown below can be accessed from the GEOPAK 
DTM pull down by single clicking Extract >>
Extract Grap s icon in the DTM toolbox.   
 

specifies the name of the file to be created for storinFile Name
already exists, it may be found using the Files button.   

 
specifies the format of the new file.  Either format will produce the same results.  
The difference between the two is ASCII files can be viewed and edited with a 
text editor while Binary files 
decimal places can be chosen. 

 
F
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determines the type of fFeature Type eature to 
extract from a design file. 

 
Spots e 

vertices of a line or line string. 
 

Breaks
ents, ditch 

bottoms, ridges, etc. 

Bound dary of 
the digital terrain model. 

Contou
r otherwise imported 

contours. 

Void –

, headwalls, concrete pads, 
etc.) 

slands – an area within a void that contains contours. 

Graph gles from a TIN model that has 
been otherwise created or imported. 

Drape ame as void, except uses the elevation from the triangulated 
model.   

Break e as void except edges are inserted as breaklines instead of 
drapelines. 

Mode  

 along linear MicroStation elements.  This 
mode works in both 2D and 3D files. 

Select Criteri

ch, Display, 
and Reset will assist you in interactively defining the search criteria. 

– random survey points. Can b

 – designate linear features such 
as edges of pavem

 
ary – the external boun

 
rs – for use in extracting 
digitized o

 
 closed shapes representing an 
area with no contours.  (i.e. 
ponds

 
I
 

ic Triangles – for use in extracting trian

 
 Void – s

 
Void – sam

 
the extraction mode calculates XYZ data directly from the coordinate values of 
3D MicroStation elements.  The interpolation mode produces XYZ data by 
interpolating between spot elevations

 
a   provides ways to specify the features to be extracted.  When an “X” is placed in 
the box next to Levels, the Select box is activated.  You may then click the Select 
button to indicate only those levels you want GEOPAK to search for when 
extracting data.  If the Levels box is not turned on, GEOPAK will search all 
levels.  The same procedure is true for the other criteria selections.  The three 
buttons located at the bottom of the Select Criteria group box Mat
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Extract 

o define elements for extraction.  Fence will extract all elements 
within a fence boundary.  View 1 etc. will extract all the elements displayed in the 
se

cluded under the Build pull down and icons are options for creating, 
a

 

uild > Triangles processes the information stored in a DTM input file (.dat) to create a 
sents a triangular irregular network. 

e is the name of the DTM input file 
here the extracted topological features are 

e is the name of the file in which the 
iangulated model will be stored in binary 

e and 
ou can always navigate to an existing file using 

The Di hat are not representative of the surface.  The 
three o

Sliver 
Side – external triangles whose external side is longer than a user specified length are 

dissolved.  (Recommended Option) 
 

there are four options for data extraction.  Complex Chain reads those elements 
along adjoining MicroStation elements.  Selection Set uses a MicroStation 
Selection Set t

lected view. 

4.6 Build 

In
m nipulating, and merging DTM models.  
 
 
 

 

4.6.1 Build Triangles 
B
triangulated model (.tin).  The file extension repre
 
Data Fil
w
stored.   
 
TIN Fil
tr
format. 
 
In either of the above cases, you do not have to 
enter the file extension with the file nam
y
the magnifying glass button. 
 

ssolve Option eliminates external triangles t
ptions are: 
None – no external triangles are dissolved. 

– long, thin triangles are dissolved. 
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4.6.2 Additional Build Options 
Build > Lattice creates a grid (.lat) that can be draped over the triangulated data (.tin) to create a 
three dimensional visual display of the topography. 
 
Build > Merge allows two triangulated models to be merged together as long as the boundary of 
one model overlaps the other.  This process will create a third model (.tin) from the combination 
of the two existing models. 
 
Build > Clip creates a new model (.tin) from a clipped portion of an existing model. The area is 
defined as internal or external to a user defined clip polygon. 
 
Build > Pad defines a pad (such as a building slab) and integrates the pad into the existing 
terrain with a variety of slope options. 
 
Build > Delta Surface creates a new model based on the difference between two other models, 
or a model and elevation surface.  The Z value in the model that is created is equivalent to the 
difference between the two specified models, or model and surface. 
 

4.7 Reports 

The options under the Reports pull down and icons include a way to check for 
duplicate points or crossing breaklines, and the ability to generate statistics 
associated with a .tin file. 

 
Duplicate Points – reports points with the same x and y 
coordinates. 
 
Crossing Features – reports intersecting breaklines or 
contours. 
 
Triangle Statistics and Lattice Statistics - displays a 
summary indicating the total count of each element type 
and minimum and maximum X, Y, Z ranges for the 
specified .tin or .lat file.  
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4.8 Utilities 

Options under the Utilities pull down and icons include a way to check the 
validity of a triangulated file, converting triangulated files from previous 
versions of GEOPAK, converting the DTM data file between ASCII and 
binary format, converting the DTM from English to Metric, and exporting 
a TIN to Trimble DTX model or Leica GSI model. 
 
 
 
 
 
 
 

Convert TIN – permits the conversion of a triangulated file from a previous version of 
GEOPAK to a GEOPAK 98 format. 
 
ASCII to Binary and Binary to ASCII - permits conversion of the DTM input file (.dat) 
 
Check Triangulation - starts an internal process that verifies the integrity of the triangulated 
file.  A message will appear indicating "Triangulation Valid". 
 
Metric <-> English – converts a file from 
English to Metric units, or from Metric to 
English or Imperial units.  A custom scale 
factor can also be used.  The DTM can 
also be translated or rotated.  If translation 
or rotation is desired without scaling, a 
Custom scale of 1.0 can be used.  This 
process will create a new DTM file.  
 
Export DTM – uses a LAT or TIN to create 
files suitable for GPS controlled construc-
tion equipment. This tool supports both 
Trimble and Leica file format. 
 
Import LandXML - uses a LandXML file 
to create a DAT readable by the various 
DTM tools. 
 
Export LandXML – uses a TIN file to create (or 
append to) a LandXML file, suitable for import 
into external programs 
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4.9 Load 

Load is the process by which we can visualize the DTM data, the TIN 
model, the lattice model, and the contours.  By clicking on Load >> 
DTM Feature, or by clicking on the icon, the following dialog will 
appear. 

 
 

 
 
 

The user can choose to load 
the DTM data (.dat), the TIN 
file (.tin), or the lattice file 
(.lat).  Each of these files can 
be loaded for the model 
extents, within a fence, or 
within a window.  
 

oggling on Display Only 
 
T
will allow the user to view 
the elements without writing 
them to the MicroStation file.  Conversely, toggling Display Only off will store the viewed 
elements as MicroStation elements.  If Display Only is on, updating the active screen will clear 
the display of these elements.  When Display Only is off, the elements can be placed as a 
graphic group using the Graphic Group toggle.   
 
The user can set what data to 
visualize, the symbology, and the 
contour interval (if Contours is 
turned on). 
 
The default MoDOT symbology to 
visualize DTM items is stored in a 
preference file. To load the file 
into dialog box, go to File >> 
Open and navigate to t:\gpk_std\DTM\ MoDOT.lpf.  
 

 Will turn on all items. 
 

 Will turn off all items. 
 

 Will turn on only the selected item. 
  

 Will turn off only the selected item. 
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4.10 Other Pull Down Menus 

4.10.1 Edit 
The Edit pull down provides the ability to edit the digital terrain model. 

 
Triangles - Allows the user to add, delete, or modify triangle vertices, triangle legs, and 
breaklines. 
 
Duplicate Points – Reports and allows interactive editing of points in a survey data file with the 
same X and Y coordinates. 
 
Crossing Features – Reports and allows the correction of crossing breaklines. 
 
Filter Vertices – Reduces the amount of vertices by deleting the vertices based on a user 
specified distance. 
 
Join Linear Features – Allows the user join two linear features into one feature. 
 
Z Range Clip – Deletes information from the survey data file (.dat) based on given elevation 
information. 

4.10.2 Drape 
GEOPAK provides three tools for draping MicroStation elements onto a triangulated model, 
vertices, vectors and elements. 
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4.10.3 Analysis 
 

 
 
 
 

The Analysis tools allow the user to view the digital terrain model through 
many different methods such as a profile, themes, and drainage. 
 
Height – Show the user the x, y, and z coordinates and the slope of a given 
data point.  The contour at that elevation, the triangle the point lies within, 
and the direction of flow can be displayed. 
 
Profile – Will display the profile of the digital terrain model between two 
points. 

 
To set up the Profile tool preferences according to CADD Standards, the 
user will need to load the file MoDOT.ols set up by CADD support, which 
is located under t:\gpk_std\DTM\.  This file will set up the element 
attributes in the selection and preferences tab. 
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Volumes – Will calculate the volume between two TIN models, the volume between a TIN 
model and a plane, or the cut and fill totals between two TIN models. 
 
Elevation Differences – Will display the elevation difference, or the amount of cut and fill 
between two TIN models, or a TIN model and a plane. 
 
Slope Area – Displays the slope area of a TIN model, or a portion of a TIN model. 
 
Themes – Displays the digital terrain model based on different user definable themes such as, 
elevation ranges, slope percentage, slope degree, or aspect. 
 
Drainage Tools – Allows a user to display and analyze drainage patterns with in a TIN model.  
Tools include delineating watersheds, drawing flow arrows, determining upstream and 
downstream traces, and finding high and low points. 
 
Visibility – Displays lines of sight (which triangles can and cannot be seen), or what is visible 
between two specified points. 

Trace Slope Path –Traces a path along a TIN file, or if site modeler is active, a site model or 
object.  

Trench Volumes – Using pipes from a Drainage project and / or Water Sewer project, this tool 
uses a TIN file (and optional offset) to compute trench and bedding volumes.  

For more information on these items, see the GEOPAK Help Applications > GEOPAK Road > 
Help. 
 
Camera – Supports a wide variety of tools and options to view Digital Terrain models within a 
MicroStation 3D file. 
 

Once a 3D model has been created in Geopak, 
the DTM Camera Tools shown to the left can be 
used to create a drive or fly through of the 
project.   

 
Before a fly through can be created, the camera and targets must be set using the Locate 
Camera and Target Tools.  This is done by setting two data points, the location of the 

camera and the target view.  Once both the camera and targets are set, the next two tools in the 
pallet can be used to adjust them individually. 

 
Locate Camera Tool 
 
Locate Target Tool 
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The Fly Path Tool  allows the user to start the fly through once all the Surface Camera 

Settings  are defined. 
 
The Surface Camera Settings dialog is shown below. 
 
Control View and Camera Views should be set to MicroStation view 1 and view 2 respectively.  
The Control View is typically a top view, which is used to define the camera and target locations 

 
 
 
 
 
 
The user can set the camera and target elevation 
based on a distance from TIN elevation, by a 
fixed elevation or by a distance from the 
elements.  This distance above the elements 
determines the perspective of the model. 
 
The Inherit Z when navigating and the Orient 
Control view and Camera Center can be 
toggled on/off as preferred by the user. 
 
The Inherit Z when navigating can be 
turned on/off from the icon on the DTM 
Camera Tools  
 
The Front Clip Distance from Camera sets the 
distance (in working units) from the camera to 
the front clipping plane.  If this is set to zero, the 
front clipping plane is set at the camera origin.  

The Back Clip Distance from Camera controls the 
distance (in working units) from the camera to the back 
clipping plane.  

 
  

 

The rest of the settings in the dialog are used for the fly path, 
which can be defined by two data points, a graphic element or a 
chain. 
 

The increment determines the distance between each step of the flight along the flight path. 
 
The last options shown to the left determine whether the camera and target are stationary or 
moving during the flight.   
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The Skew to Target toggle can be turned on or off. 
 
The last four icons on the tool bar are used for 
camera navigation. The icons are listed below.
  

 Navigate camera 
 

   Zoom Camera Out 
 

 Zoom Camera In 
 

 Display More Camera Settings 
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Exercise 4-1 

This is a group exercise to present several GEOPAK Digital Terrain Modeling (DTM) tools. 
 

1. Open the Microstation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn. 

 

2. Open the project j2p0300.prj.  Enter the project as user userc. 

 

3. Make sure that the Working Alignment is J2P0300.  

 

4. Select Existing Ground from the upper left corner of the Road Project dialog flow chart. 
 

 
 

Copy the MoDOT run to J2P0300, and open the J2P0300 run.  This is the same Run > 
Copy… > Run process used in creating a new working alignment.  GEOPAK uses runs to 
keep track of specific dialog and tool settings.  A run allows the user to repeat a task without 
having to reenter all of the needed information. 

 

 
 

The DTM tools for the following steps may be accessed from either the  
toolbox shown to the right or the DTM Menu bar depicted below. 

 

 

This icon 
opens the 
menu bar.
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5. Use the Build Merge TINs tool (DTM menu path Build > Merge TINs or the  
raised icon shown to the right) to merge the 20201dm.tin with the 20302dm.tin.  

 
To do this, set 20201dm.tin as the Old Tin and 20302dm.tin as the Mrg Tin.   
You can either type in the TIN names or use the Files button to select the TINs. 
 
Set the New Tin to J2P0300.TIN.  This needs to be typed since this file needs to  
be created.  This Files button is used only if the already exists. 

 
Click on Process to initiate the merge tin process. 

 

 
 

6. Check the Triangle Statistics (DTM menu path Reports > Triangle Statistics  
TINs or the raised icon shown to the right) of the tin file j2p0300.tin.  Use the  
Files button shown below to select the TIN or type its name into the field.  Select  
the Process button to calculate and report the TIN statistics. 

 

 
 

It is a good idea to check the statistics for any new DTM to make sure that its information 
matches the known project data.  The minimum X and Y values can be used to set the custom 
coordinates for a MicroStation file created to display the DTM. 
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7. Open the Load DTM Features dialog (DTM menu path Load > DTM Feature  
or the raised icon shown to the figure to the right).   
 
To load the MoDOT preferences, select File > Open in the Load DTM Features  
dialog and select the file: MoDOT.lpf in the working directory, as shown below. 

 

   
 

 
 

Set the Load File to TIN and the file to J2P0300.TIN.  Load the Tin Hull as a Graphic 
Group, by setting up the dialog as shown below.  (See the manual for instructions on how to 
use the “light bulb” icons to toggle an items Display on and off.) 

 

 
 

Fit the MicroStation view so you can see the boundary of the TIN model. 
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8. Turn off the Tin Hull and turn on the Contours, Major and Minor Lines, and Major 
Label items.   
 
With the Contours line highlighted, set the following parameters: 

 Minor Interval: 2.000 
Major Interval: 10.000 

 

 
 

Switch to the Major Label line.  Set the text size to 12 by double-clicking on the preview 
window outlined below.  Set the Distance Between labels to 1000.  Load the contours as a 
Graphic Group. 
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9. Close Load DTM Features and save changes to the MicroStation drawing. 

 

10. Turn on Level 22.  It contains a line indicating the location of an upstream valley section. 
 

Open the Site Profile tool.  It can be opened by going to DTM pull down menu item 
Analysis > Profile or clicking on the second icon in the Analysis tool box, which is depicted 
below and is the tool box in the lower left hand corner of the DTM tools pallet. 

 

 
 

The Site Profile dialog is shown below.  Go to File > Open and select the file DOT.ols in the 
working directory to load the settings in the Object List File. 
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11. Under the Selection tab, add the J2P0300.TIN to the list by clicking on the icon  to the 
right of the Tin File field and clicking on the Add List Item icon: .  Once the TIN has 
been added to the list, the list area should look like the following: 

 

 
 

12. Under the Profile tab, click on Select Element.  Data point on the line locating the valley 
section and accept.  This will place the valley section in the dialog, as shown below. 
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13. Under the Preferences tab, modify the preferences for the grid to the settings shown below.  

Because the OLS file was opened only the Minimum and Maximum Elevations need to be 
set so that the vertical grid starts and stops at values rounded to the vertical scale of 1”=10’. 

 

 
 

14. Return to the Profile tab.  The dialog should look similar to the one shown below. 
 

 
 

Navigate to a blank area of the MicroStation drawing.  Click on Place Profile in the Site 
Profile dialog and place the profile in the MicroStation file. 
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15. Close all DTM dialogs and save changes to the MicroStation drawing. 
 

16. Return to the Road Project dialog by selecting the Project Manager Icon in the Road 
toolbox.  Click on the working alignment Define button.  Go to the DTM section and set 
both the Existing Ground Tin and Portview Tin to J2P0300.TIN as shown below. 

 

 
 

Click the OK button and Exit Project Manager. 

4-1-8 Missouri Department of Transportation 7/7/05 



GEOPAK Road for Bridge 

Chapter 5 

Coordinate Geometry 
5.1 Objectives .............................................................................................................................. 5-1 
5.2 Definitions.............................................................................................................................. 5-1 

5.2.1 Coordinate System........................................................................................................ 5-1 
5.2.2 Points............................................................................................................................. 5-2 
5.2.3 Lines and Line Segments .............................................................................................. 5-3 
5.2.4 Curves ........................................................................................................................... 5-4 
5.2.5 Spirals ........................................................................................................................... 5-5 
5.2.6 Chains ........................................................................................................................... 5-5 
5.2.7 Profiles .......................................................................................................................... 5-6 

5.3 Accessing ............................................................................................................................... 5-6 
5.4 Coordinate Geometry Dialog Box ......................................................................................... 5-7 

5.4.1 File Commands ............................................................................................................. 5-8 
5.4.2 Edit Commands........................................................................................................... 5-10 
5.4.3 Element Commands .................................................................................................... 5-11 
5.4.4 View Commands......................................................................................................... 5-17 
5.4.5 Tools Commands ........................................................................................................ 5-18 
5.4.6 User Preferences ......................................................................................................... 5-19 

5.5 COGO Navigator ................................................................................................................. 5-20 
5.6 Merging GPK Elements....................................................................................................... 5-22 
5.7 Importing CEAL Data.......................................................................................................... 5-23 
5.8 Bridge Deck Elevation Commands...................................................................................... 5-23 

5.8.1 Bridge Name ............................................................................................................... 5-24 
5.8.2 Profile Name ............................................................................................................... 5-24 
5.8.3 Tie Value..................................................................................................................... 5-24 
5.8.4 SE Command .............................................................................................................. 5-25 
5.8.5 ALI Name ................................................................................................................... 5-25 
5.8.6 Pier Command ............................................................................................................ 5-26 
5.8.7 Span Command........................................................................................................... 5-26 
5.8.8 CB Command.............................................................................................................. 5-27 
5.8.9 FC Command.............................................................................................................. 5-28 
5.8.10 GU Command ........................................................................................................... 5-29 
5.8.11 Beam Command........................................................................................................ 5-29 
5.8.12 End Span Command ................................................................................................. 5-31 
5.8.13 Edit Text Command.................................................................................................. 5-31 
5.8.14 Point Elevation Command ........................................................................................ 5-31 
5.8.15 Example .................................................................................................................... 5-32 

5.9 Store ASCII XZ DAT file to COGO 3PC ........................................................................... 5-32 
5.10 Additional Information ...................................................................................................... 5-34 

7/7/05 Missouri Department of Transportation 





GEOPAK Road for Bridge Chapter 5 Coordinate Geometry 

5.1 Objectives 

• Learn to set up and access the coordinate geometry database. 
• Become proficient in using Geopak Coordinate Geometry. 

5.2 Definitions 

Coordinate Geometry (COGO) is a method of using XYZ coordinates to store geometric 
elements such as points, lines, curves, spirals, chains, parcels, and profiles.  The Coordinate 
Geometry dialog box is an interactive graphical user interface for storing coordinate geometry 
elements. 

5.2.1 Coordinate System 
The coordinate system is defined with XYZ coordinates.  The X and Y coordinates define a 
horizontal plane, while the Z coordinate defines the vertical dimension.  All points in a cogo 
element are defined by at least an X coordinate and a Y coordinate.  If an elevation is to be 
stored, the Z coordinate will also be defined.   
 

 
The XYZ coordinates can also be referred to in Northing (N), Easting (E), and Elevation (Z) 
coordinates.  The Northing coordinate refers to the Y value, the Easting coordinate refers to the 
X value, and the Elevation refers to the Z value.   
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The user must be aware of the coordinate system the data is in, and the coordinate system that 
GEOPAK is using.  When referring to the XYZ coordinate system, the coordinates are listed as 
(X, Y, Z).   When referring to the Northing, Easting, Elevation coordinate system, the 
coordinates are listed as (N, E, Elev.).  When translating this to the XYZ coordinate system, the 
coordinates would be (Y, X, Z). 

5.2.2 Points 
Points are defined by a single set of coordinates.  Each point will have an X and a Y coordinate.  
The point may also have a Z coordinate if an elevation is defined.   
 
Point names are alpha-numeric.  If alphabetic characters are used, they must come before any 
numeric characters.  The point name must contain at least 1 numeric character at the end of the 
name.  Names can be up to 9 characters in length, although limiting the name to 8 characters is 
recommended. 
 
Points can be stored from a set of coordinates, or located from other elements.  To define a point 
from another point, a distance and direction need to be defined.   

 
 
Modifiers can be added to the direction and distance.  An offset can be applied.  This will locate 
the point at the specified distance and direction from the starting point, then perpendicular to the 
specified direction for the specified offset distance.  A positive offset will go to the right of the 
specified direction, and a negative offset will go to the left of the specified direction. 
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Distances and directions can also be found mathematically.  Values can be added, subtracted, 

 

multiplied, divided, or computed with a trigonometry function  

5.2.3 Lines and Line Segments 
d a direction, and are infinite in length.  Line Segments 

 

loc 115 trav 102 dis 107 to 108 m 20.50 n 40 18 33 w off 30 

Lines are defined by a location point an
are a portion of a line that is defined by a beginning and an ending point.  Line Segment names 
can be alpha-numeric up to nine characters, but cannot be numeric-alpha. 
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5.2.4 Curves 
Curves are a segment of a circular arc.  Curves can be defined by either the arc method (central 
angle that produces a 100’ arc) or chord definition (central angle that produces a 100’ chord).  
MoDOT uses the arc definition for all new alignments, however the chord definition has been 
used in the past, and may still be shown on old plans. 
 
A curve has several points associated with it.  These points help to define the curve, and are 
stored automatically when the curve is stored. 
 
PC – Point of Curvature; Beginning of the curve. 
PT – Point of Tangency; End of the curve. 
PI – Point of Intersection; Point where the two tangents meet. 
CC – Circle Center; Point at the center of the circle from which the curve is segmented. 

 
 
 
Curve names can be any alpha-numeric characters up to nine characters in length. 
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5.2.5 Spirals 
Spirals are a transitional curve.  Typically a spiral will transition from a tangent (infinite radius) 
to a specified radius defined by a curve.  Spirals can also transition between 2 specified radii as 
defined by 2 curves. 
 
Several points are also stored with a spiral.  They are as follows: 
 
TS – Tangent to Spiral Point 
SC – Spiral to Curve Point 
CS – Curve to Spiral Point 
ST – Spiral to Tangent Point 
PISCS – Overall Point of Intersection for the spiral-curve-spiral combination. 

 
 

5.2.6 Chains 
Chains are a combination of other elements.  They can consist of points, curves, spirals, or other 
chains.  Chains can represent horizontal alignments, or the horizontal location of some element.  
Chains have stationing associated with them.  Locations along the chain can be determined by 
the stationing.  If the stationing is adjusted along the chain a station equation is used.  The 
stations from the beginning of the chain to the first station equation are referred to as Region 1.  
The stations from the first station equation to the second station equation or the end of the 
chain are referred to as Region 2. 

 
 
Chain names can be any alpha-numeric characters up to a length of nine characters. 
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5.2.7 Profiles 
Profiles are vertical alignments defined by stations and elevations.  They are generally 
associated with some horizontal chain.  Profiles can be stored with or without vertical curves.  
Profiles without curves generally represent the existing ground profile, or a ditch profile.  
Profiles with vertical curves are generally used as proposed alignment profiles. 

5.3 Accessing 

From Project Manager choose Coordinate Geometry, or choose the Coordinate 
Geometry icon.  

 
When Coordinate Geometry is started, the Start-Up 
Dialog Box appears.  
 
Project Name – shows name displayed on reports 
(optional entry, 60 alphanumeric characters max).  If 
Project Manager is used, this field will be filled in 
automatically. 
 
Job Number  - identifies coordinate geometry database (3 

alphanumeric characters, max) (required). If Project Manager is used, this field will be filled in 
automatically. 
 
Operator Code – identifies a unique 2-character operator code.  Allows multiple users access to 
database.  (Required, user’s initials suggested). If Project Manager is used, this field will be 
filled in automatically. 
 
Subject - description of work (48 alphanumeric characters, max) (optional) 
 
Once these parameters have been defined, the coordinate geometry dialog box will appear. 
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5.4 Coordinate Geometry Dialog Box 

The coordinate geometry dialog box is made up of three separate display areas: 
 

1) Tool Bar consisting of pull down menus and icons.  The icons displayed are 
customizable. 

 
2) Command Key-in allows commands to be typed in.  The drop down button 

allows for a history of commands to be seen. 
 

3) Output Window shows the results generated by the commands. 
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5.4.1 File Commands 

 
 
File Utility – this tool is for manipulating input files.  When this tool is selected, the dialog with 
a list of available input files below appears.  File utilities include Load, Append, Catalog, 
Delete, Output, Print, and Save. 
 

Load - Highlight a file then click 
the Apply button. The input lines 
from the highlighted file are now 
displayed in the output buffer and 
are ready for modify, delete, edit or 
read. 
 
Append - A new input file is 
created by copying the contents of 
an existing input file to the end of 
the current input file; you must use 
the Save command to store this new 
file. 
 
Catalog - when selected, a menu 
appears listing all saved input files 
in the project directory.  This is for 
reference only no action is taken. 
 
Delete - when selected, a menu 

appears listing all saved input files. Highlight a file then click the OK button to remove this file 
from your project directory. 

 
Output - writes a Geopak output file from your current output buffer session to a newly created 
file for reviewing and printing. (Fname999.ooc) 

 
Print Input File - sends your input file to the printer. 
 
Print Output File - sends your out file to the printer. 
 
Save - will save the current input buffer to a file. (Fname999.ioc) 
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File Restore – converts an ASCII file of Geopak 
commands to a Geopak COGO input file. 
  
Import - will import horizontal and vertical 
alignments and points from RDS, SDMS, LandXML 
1.0 Geometry, and Virginia Department of 
Transportation file format into the Geopak .gpk file. 
 
 

 
Export - will export Geopak, points, chains and 
profiles into into SDMS format and LandXML 1.0 
Geometry. 
 
Since most surveying software now reads LandXML 
format, it is recommended to extract geometry into this 
format for providing it to contractors. 

 
 
The Export option in GEOPAK for 
profile is only activated (visible on 
the dialog) when you are also 
exporting chains.  You cannot export 
just a profile by itself as LandXML 
does not permit this. 
 
 
 

 
Exit - closes the COGO dialog box and ends the coordinate geometry session. A prompt to save 
the session appears. Yes saves the input buffer, No exits without saving, Cancel returns to the 
COGO session. Whether you pick Yes or No everything you did is still saved in the .gpk file. 
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5.4.2 Edit Commands 

 
Clear - empties the memory of the current input and output buffers without saving and initializes 
the line numbers to begin a new sequence of commands. 
 
Delete - deletes input commands in the input buffer by line number (or range of line numbers) 
and re-sequences the line numbers for the remaining commands. 
 
Insert - allows the user to add a command line to the current input buffer before a specified line 
number; the other command lines will shift down and line numbering will automatically be re-
sequenced 

 
Modify - allows the user to change a word in a command line. The modified command line will 
not be computed until the operator uses the Read command. 
 
Read All - the lines in the output buffer are processed. This may be done for the entire file (All) 
or by specifying a range of line numbers (Line Range). 
 
Type All - displays the content of the current input file, (All) or a portion of the file by 
specifying a range of line numbers (Line Range). 
 
Line Range - displays a portion of the file by specifying a range of line numbers. 
 
Editor - opens the GEOPAK COGO Command Editor, which allows the user to edit an input 
file before executing. 
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5.4.3 Element Commands 

5.4.3.1 ELEMENT>>POINT 

 
 
Utility - The Point Utility tool displays a list of all stored points, and 
has options for deleting, printing, or visualizing points.  
 

Delete – deletes one point or multiple points currently stored in 
the .gpk file.  User must highlight the points to be deleted in the 
utility tool display list, then click on the delete icon. 

 
Print - prints point data currently stored in the .gpk file 
including coordinates and other associated data. 

 
Visualize– visualizes currently stored points in the .gpk file 
according to the visualization settings in the coordinate 

geometry dialog.  If visualization is turned off, points will not be visualized. 
 
Cell - assigns a cell name to a previously stored point 
 
Copy – copies points or a point range to a new point number or range within the same Geopak 
database 
 
Elevation - assigns an elevation to a previously stored point 
 
Equate - stores a new point with the same values as a previously defined point 

 
Station - allows you to specify a station for an existing point. 
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Store - stores a point located by key-in or by 
digitizing a point on the screen. A station, elevation, 
point code, cell, feature, or description can be added 
to the point.  
 
Transformation - transform one set of points into a 
new coordinate system. 
 
Compare Points to TIN – computes the elevations 
of a given set of points based on a given DTM, and 
outputs the elevations to a text file. 
 
Set Elevation From Tin – computes the elevations 
of a given set of points based on a given DTM, and 
stores the elevations to the points. 

5.4.3.2 ELEMENT>>LINE 

 
 
Utility - displays all stored lines, and has options for transposing, 
deleting, printing, or visualizing lines. 
 

Transpose – Changes the direction of the selected lines. 
 
Delete – Removes the selected lines from the GPK. 
 
Print – Writes information about the selected lines to the 
COGO output window. 
Visualize - Plots lines based on current COGO visualization 
settings. 

Store - stores a line based on one point and a direction or two 
points.  The line name can be alpha-numeric (but not numeric-
alpha) to a maximum of nine characters. 
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5.4.3.3 ELEMENT>>CURVE 

 

 
 
Utility - displays all stored lines in .gpk file, and has options for 
transposing, deleting, printing, or visualizing lines. 
 
Copy - copy a specified curve to another curve name 
 
Data - calculates the geometric parameters of a curve, displaying 
values for Delta, Degree, Tangent, Length and Radius 
 
Segment – defines new curves by dividing a stored curve into segments. 
 
Station - allows the user to identify a curve and the position on the curve (PC, PI, or PT) that a 
station value may be assigned. 
 
Store – provides the following three options for defining and storing 
curves: By Tangents, By End Points (from PC and PT previously 
stored) and Concentric as shown to the right.  
 
Storing a curve By Tangents is the most commonly used tool to store curves.  Its dialog is 
shown below. 
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5.4.3.4 ELEMENT>>SPIRAL 

 
 

Utility - displays all stored spirals in the GPK file, and has options 
for deleting, printing, and visualizing spirals. 

Copy - copy a specified spiral to another spiral name 
 
Store – provides various options for defining and storing spiral combinations.  The dialog for an 
Spiral-Curve-Spiral (SCS) combination is shown below. 
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5.4.3.5 ELEMENT>>CHAIN 

 
 
Utility - displays all stored chains in the .gpk file, and has options for 
computing area, deleting, printing, describing, or visualizing chains. 
 

Area – calculates the area of a closed chain previously stored in 
the GPK file. 

 
Delete – deletes chains stored in the .gpk file. 
 
Print – displays the name of each chain element. 
 
Describe – displays the alignment data of each element in the 
selected chain. 

 
Visualize - plots chains based on current COGO visualization settings.  
 

Layout Offset – computes the station and offset of a point or a chain based on a given chain. 
 
Station - provides a method for 
stationing or re-stationing a 
chain. 
 
Station Equation - provides a 
method for applying a station 
equation to a chain 
 
Store - provides three options for 
storing a chain in the database, 
From Elements, From Offset 
Chain, and Transition Chain.  
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5.4.3.6 ELEMENT>>PARCEL 

 

Utility - displays all stored parcels in .gpk file, and has options for describing, deleting, printing, 
or visualizing parcels. 

Store - allows a user to store a parcel by adding points, curves and spirals. 
 
Subdivide – divides a parcel into individual lots. 
 
Editor – edits a parcel 

 
Manual Entry - Parcel Commands 
 
Store Taking - allows you to store the portion of a parcel taken by entering point and curve 
names in either a clockwise or counterclockwise direction. 

 
Store Easement - allows you to store an easement by entering point and curve names in either a 
clockwise or counterclockwise direction. 
 
Own Parcel - stores the name of the owner associated with a previously stored parcel.  

 
Make Legal - creates a legal description and writes it to a user named text file. 
 
For more detailed parcel information, see GEOPAK Help. 

5-16 Missouri Department of Transportation 7/7/05 



GEOPAK Road for Bridge Chapter 5 Coordinate Geometry 

5.4.3.7 ELEMENTS>>PROFILES 

 
 

Utility - displays all stored profiles in .gpk file, and has options 
for deleting or printing profiles. 

Elevation - provides three options for reporting elevations along 
a selected profile, Station, Even Station, Incremental Stations 
 
Offset – stores a new profile at a given vertical offset. 
 
Restation - creates a Target Profile based on a Source Profile 
and Chain, but uses the Begin Station specified in the dialog. 

5.4.4 View Commands 

Icons – allows the user to customize which icons appear in the tool bar. 
 
Redefine – shows the Redefine box on the tool bar. 
 
Visualization – shows the visualization items on the tool bar.Format – shows the format items 
(i.e. number of decimals, station format, etc.) on the tool bar. 
COGO Key-in – shows the COGO Key-in box for entering commands in the dialog. 

7/7/05 Missouri Department of Transportation 5-17 



Chapter 5 Coordinate Geometry GEOPAK Road for Bridge 
 
Command Output - show the Command Output Window in the dialog box, and controls 
options for the Command Output Window. 
 
Error Alert – allows the user to turn on a beep and/or bring up the COGO dialog when an error 
occurs.   

5.4.5 Tools Commands 

 
 
Intersect – stores a point at the intersection of the defined elements 
 
Locate – locates a point from another point by several methods such as distance and direction, or 
station and offset.  (To locate by distance and bearing, use the Tools >> Locate >> Traverse) 
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Superelevation – calculates the superelevation for a given chain.  (This will be covered in more 
detail in Chapter 11) 
 
Inverse – calculates the distance and direction between points.   
 
Navigator – starts the COGO Navigator.  (This will be covered in more detail in Section 5.5) 
 
Best Fit – calculates a best-fit chain through a set of points. 
 
Translation and Rotation – moves, rotates, and scales a data set. 
 
Map Check – edits a parcel. 
 
Roadway Intersection – calculates the data for the intersection of two roadways. 
 
Cul-de-sacs – calculates the data for a cul-de-sac. 
 
Redraw Visualized Elements – re-syncs the coordinate geometry data with the data displayed 
in the Microstation file. 
 
Clear Visualized Elements (Temporary) – clears the temporary visualized elements from the 
view. 
 
Clear Visualized Elements (All) – clears the visualized elements from the Microstation file. 

5.4.6 User Preferences 

 
Dialog - allows access to COGO Preferences dialog box. 
 
Redefinition of Elements – toggles the Redefine option on/off.  If Redefine is on, COGO data 
can be redefined/overwritten.  (It is recommended to work with Redefine off so the user does not 
overwrite another user’s data.) 
 
Visualization – allows the elements to be displayed in the Microstation file permanently or 
temporarily. 
 
Coordinate Display – toggles between displaying NE or XY coordinates. 
 
Angle Display – toggles between displaying Bearing or Azimuth. 
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5.5 COGO Navigator 

COGO Navigator is a tool to easily view and 
edit COGO data.  Navigator can be accessed by 
the pull down menu COGO >> Tools >> 
Navigator or by the Navigator icon.  The following dialog 
box will appear.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the Navigator, points, lines, curves, spirals, chains, 
survey chains, parcels, and profiles can be added, deleted, 
modified, identified, visualized, printed, or selected. 
 
 

5.5.1 Select 

Select All – selects all data items of a certain type.  (I.e. all 
points) 
 
Invert Selection – selects all items not previously selected, 
and unselects all items previously selected. 
 
Clear Selection – unselects all items. 
 

Selection Set - allows the user to create a selection 
set that meets particular criteria.  This is the same as 
using the Selection Set icon.  

 
Fit View (Selection Set) – fits the items selected to the active Microstation window. 
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Show Selected Elements Only – only the items in the selection set will be displayed in the 
MicroStation window. 
 
Show All Elements – all items in the database will be displayed in the MicroStation window. 

5.5.2 Tools 
Add Element – allows the selected type of 
element to be stored. 
 
Delete Element – deletes the selected type of 
element.  
 
Edit Element – allows the selected element 
to be edited. 

 
Identify Element – allows the user to select 
an element by selecting it graphically. 

 
Print/Describe Element – displays the 
selected element’s coordinate or alignment 

data. 
 
Edit Element Feature – Changes the feature code 
of the element. 

 
Visualize Element – displays the selected elements according to their feature codes. 
 

Unvisualize Element – un-displays the selected elements. 
 
Visualize All – displays all of the elements of a certain 
type, or all elements. 
 
Redraw Visualized Elements - re-syncs the coordinate 
geometry data with the data displayed in the Microstation 
file. 
 
Clear Visualized Elements (Temporary) – clears the 
temporary visualized elements from the view. 
 
Clear Visualized Elements (All) – clears the visualized 
elements from the Microstation file. 
 
Settings – allows the user to define certain actions and 
behaviors of the Navigator.  
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5.6 Merging GPK Elements 

A Visual Basic Application (VBA) is available to allow users to merge elements from one GPK 
to another.  This VBA is located under the MicroStation Add-Ons pull down menu.   
Add-Ons>>Geopak Utilities>>Merge GPK Elements – Geopak must be running.   
 

 
 
When opening the tool, the user will get the following dialog box.  Select OK to dismiss. 
 

 
 
The tool requires a source and a 
target GPK.  Both databases must 
exist before running the tool.  The 
source GPK is defined as the 
database from which the elements 
are extracted, and the target one is 
where the elements will be 
transferred. 
 
The user can select multiple type 
geometry at one time.  To select an 
element, first select the type of 
geometry and then high light from 
the available list.  The tool offers 
two options for handling existing 
geometry in the target GPK with the same name.  One is to always “Ask Before Redefining 
Elements”, and the second one is to “Always Redefine Elements”.  If any redefinition of 
elements must be done, the Redefine toggle must be checked on in the Coordinate Geometry 
dialog box. 
 
Once the tool is set up, select Merge Elements.  Once 
the tool is done merging elements, the user will get the 
message to the right. To view the log file select Yes. 

5-22 Missouri Department of Transportation 7/7/05 



GEOPAK Road for Bridge Chapter 5 Coordinate Geometry 
5.7 Importing CEAL Data 

A CEAL interface file can be imported using the following command: 
 
 LOAD CEAL FILE filename 
 
where filename is the name of the CEAL interface file.  This command will create a Geopak 
input file that can be saved or read.  Points, curves, spirals, chains, and alignment profiles can be 
transferred to Geopak from CEAL.  Once the above command has been executed, to store the 
data into the .gpk file the input file must be read by going to Edit>>Read All. 

5.8 Bridge Deck Elevation Commands 

COGO solves the deck elevation requirements for the design of highway bridges.  The elevations 
computed by GEOPAK are top of slab elevations within the limits of the bridge.  The program 
computes deck elevations on a per span basis along the edge of the deck, gutterlines, centerline 
bearings, beams parallel to any line defined by two points, curves or lines concentric to the 
baseline, or non-parallel lines defined by unequal spacing along the piers.  The software is also 
capable of computing deck elevations between parallel or non-parallel piers.  Note these 
commands are not located on pull down menus and must be keyed in. 
 
Most of the commands in this chapter are provided with graphic illustrations and are indexed in 
the following order: 
 

BRIDGE name name of the bridge for output 
PROFILE name a profile already stored in GPK. 
TIE value defines the location of the profile grade line 
SE commands width and slopes across the bridge 
ALI name a chain already stored in GPK. 
PIER command defines the direction of the piers (optional) 
SPAN command defines the layout of the span 
CB command refers to Centerline Bearing Elevations (optional) 
FC command refers to the edge of the deck elevations (optional) 
GU command refers to the gutterline elevations (optional) 
BEAM commands set the framing plan for the current span 
End Span command initiates the calculation 
Edit Text command displays the results of the calculation 
 

The following convention will be used in presenting the bridge deck commands:  Words in all 
upper case letters indicate command names.  Lower case words indicate alphanumeric values 
provided by the user.  Since many keywords can be abbreviated, the minimum required is 
underlined.  As always, it is recommended that COGO element names be limited to nine 
characters.  For a full presentation of the COGO conventions go to Applications >> GEOPAK 
Road >> Help >> Coordinate Geometry and select the topic General Reference / General 
Conventions. 

7/7/05 Missouri Department of Transportation 5-23 



Chapter 5 Coordinate Geometry GEOPAK Road for Bridge 
5.8.1 Bridge Name 

BRIDGE name
 

The Bridge name command stores the name of the bridge.  The name of the bridge and the name 
of the span together form the name of the Deck Elevations Table for the current span. 

5.8.2 Profile Name 
PROFILE name 

 

The Profile name command refers to a previously defined profile utilized to define the deck 
elevations of the bridge.  If the profile name is not stored, a message will be printed.  Station 
equations along this profile, if any, must match the station equations along the chain (ALI name). 

5.8.3 Tie Value 
TIE value 

 

The Tie Value command defines the horizontal location of the Profile Grade Line (PGL) by a 
radial distance (or value) measured from the baseline or centerline of construction of the bridge.  
When the PGL is located to the left of the baseline the tie value is negative. 

 
When the profile grade line is coincident with the baseline, the Tie value is zero as depicted 
above. 

 
When the profile grade line is to the right of the baseline, the Tie value is positive as depicted 
above. 

 
When the profile grade line is to the left of the baseline, the Tie value is negative as depicted 
above. 
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5.8.4 SE Command 

SE station (R region) LT slope1 dist1 slope2 RT slope1 dist1 slope2
 
The SE command set the slopes in percentage across the bridge from the PGL, left and right.  
The slope1 in percentage applies across the distance dist1, and slope2 applies to any point 
beyond the distance dist1 (left and right).  Slopes are negative when going down away from the 
PGL.  Three examples are given below. 
 

 
SE sta1 LT s1 dist1 s2 RT s1 dist1 s2  

 

 
SE sta2 LT s1 dist1 s2 RT s1 dist1 s2 

 

 
SE sta3 LT s1 dist1 s2 RT s1 dist1 s2 

5.8.5 ALI Name 
ALI name 

 
The ALI name command refers to a chain already stored in the GPK.  It defines the stationing of 
the bridge.  Station equations along this alignment or chain, if any, should match the station 
equations along the profile. 
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5.8.6 Pier Command 

PIER BK direction AH direction 
 
The Pier command sets the direction from right to left of the pier centerline.  When the Pier 
command is not used, the piers are assumed perpendicular or radial to the baseline. 

 
Pier BK N 40 12 34 E   AH  N 0 E 

 
Pier BK AZ 37 40   AH AZ 37 40 

5.8.7 Span Command 
The Span commands define the beginning station (bk_sta) and the end station (ah_sta) of the 
current span along with the location of the required elevations. 
 
Format A: 

 
SPAN (name) bk_sta ah_sta segments (+) 

 

Defines the current span defined from pier on bk_sta to pier on ah_sta, where: 
 name = the name of the span,  
 bk_sta = the station value for the centerline of the back pier, 
 ah_sta = the station value for the centerline of the ahead pier, and 
 segments = the number of equal length segments along the span. 

 

Elevations are calculated perpendicular or radial to the baseline at each segment.  The optional 
(+) calculates elevations on the pier ahead. 
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Format B: 

 
SPAN (name) bk_sta ah_sta segments (+) P

 
Current span defined from pier on bk_sta to pier on ah_sta, with the terms used as defined above.  
Elevations are calculated at each segment and parallel (P) to the pier on bk_sta.  The optional (+) 
calculates elevations on pier ahead. 
 

5.8.7.1 FORMAT C 

 
SPAN (name) bk_sta ah_sta IN v (+) 

 
Current span defined from pier on bk_sta to pier on ah_sta, where: 

 v = interval length and the rest of the terms are used as define above.  
 
Elevations are calculated at equal intervals (IN v) measured from the pier on bk_sta. The 
optional (+) calculates elevations on pier ahead. 

5.8.8 CB Command 
CB value 

 
The CB commands calculate deck elevations at the Centerline Bearing of the current span.  
When value is positive, the elevations are computed along a line parallel to and right of the pier 
on the back station; when value is negative the elevations are computed along a line parallel to 
and left of the pier on the ahead station.  Centerline bearing elevations are specified with 
asterisks (*) in the table of elevations for the current span. 
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5.8.9 FC Command 
The FC commands calculate deck elevations along the Face of Coping or edge of the deck.  
This edge is defined by a line concentric to the baseline at the offset distance offset_left or 
offset_right, or along a line designated by two points. 
 

Format A: 

 
FC offset_left offset_right 
Deck elevations along a line concentric to the baseline at offset distances, left and right. 
 
Format B: 

 
FC pa, pb offset_right 

Deck elevations along a line to the left of the baseline, from pa to pb, and along a line to the 
right and concentric to the baseline at offset distance. 
 
Format C: 

 
FC pa, pb pi, pj 

Deck elevations along a line to the left of the baseline, from pa to pb, and to the right of the 
baseline from pi to pj. 
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Format D: 

 
FC offset_left pi, pj 

Deck elevations along a line to the left and concentric to the baseline at offset distance 
offset_left, and along a line to the right of the baseline from point pi to point pj. 

5.8.10 GU Command 
The GU commands calculate deck elevations along the gutterline of the current span.  The 
gutter is defined by a line concentric to the baseline at the offset distance offset_left or 
offset_right, or along a line designated by two points pa, pb (to the left of the baseline) or pi, pj 
(to the right of the baseline).  It uses the same four formats as the FC Command 

5.8.11 Beam Command 
The Beam commands calculate deck elevations along beams defined by offset distances 
concentric to the baseline (Format A); parallel to a line pa, pb (Format B); by points (Format C) 
or along unparallel lines defined by unequal spacing along the piers (Format D). 
 
Format A: 

 
BEAM OFF offset1 offset2 offset3 . . . offsetn 

 
Negative offsets are to the left of the baseline and positive offsets are to the right. 
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Format B: 

 
BEAM PAR pa, pb beam_spacing number_of_beams 

 
The beams are laid out parallel to the line from pa to pb, which defines the location of the left 
most beam as shown above.  The value Beam_spacing designates the spacing between the 
beams with the value number_of_beams indicates the number of beams. 
 
Format C: 

 
BEAM BY POI pa, pb 

 
Locates a single beam running from pa to pb. 
 
Format D: 

 
BEAM pe, pf FROM n1 SPS v1 n2 SPS v2 . . . TO m1 SPS w1 m2 SPS w2 . . . 

 
The line from the previously defined point pe to the previously defined point pf locates the left 
most beam with the other beams located along the back (FROM) pier at n1 spaces of length v1, 
n2 spaces of length v2…and located along the ahead (TO) pier at m1 spaces of length w1, m2 
spaces of length w2…. 
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5.8.12 End Span Command 

END SPAN 
 
The End Span command initiates the calculation of elevations for the current span and stores, on 
disk, a table of elevations with a name composed of the name of the bridge, a hyphen, and the 
name of the span (bridge-span).  An ASCII file is also stored for digital terrain modeling 
purposes.  This ASCII file has a name composed of the name of the span, a dot, and the 
extension xyz.  If no name has been stored for the current span, COGO, assigns numbers to the 
span starting with number 1.  The XYZ file can be used to store COGO points at each of the 
locations where a deck elevation was calculated.  This procedure is presented in Section 5.9 
Store ASCII XZ DAT file to COGO. 

5.8.13 Edit Text Command 
EDIT TEXT bridge-span.TXT 

 
The Edit Text command displays the table of deck elevations stored on disc as bridge-name, 
hyphen, span-name.  When the table exceeds 8 columns, COGO breaks the table into groups of 8 
columns.  The file can also be viewed with any text-editing program. 

5.8.14 Point Elevation Command 
POI/EL list 

 
The Point elevation commands calculate deck elevations for any points on the deck, which has 
been stored in the coordinate geometry database file, where list is the list of points.  This 
command is active only when the Alignment, Profile, Tie, and Cross-slopes (SE commands) 
have been previously designated. 
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5.8.15 Example 

 
 
The input commands for the above figure are: 
 
*1     BRIDGE K1 
*2     PROFILE ABC 
*3     TIE 0 
*4     SE 60+00 LT -2 24 -3 RT -2 24 -3 
*5     SE 63+00 LT -2 36 -3 RT -2 36 -3 
*6     SE 65+00 LT 4 24 4 RT -4 24 -4 
*7     ALIG IN 
*8     GU -33 33 
*9     FC -34 34 
*10    PIER BK N 40 W AH N 40 W 
*11    SPAN A 61+00 62+00 8 P 
*12    BEAM OFF -32 -11.90 14.50 32 
*13    END SPAN 
*14    END 
 
The resulting output is: 
 
Bridge deck elevation 
Span K1-A  61+00.00 to 62+00.00 
LFC   11.4187  11.1029  11.3712  11.3712  11.3554  11.3396  11.3237  11.3079 
LGT   11.4490  11.4331  11.4015  11.4015  11.3856  11.3698  11.3540  11.3381 
BM 1  11.4792  11.4634  11.4475  11.4317  11.4159  11.4000  11.3842  11.3684 
BM 2  11.9250  11.9042  11.8834  11.8625  11.8417  11.8209  11.8000  11.7792 
BM 3  11.8811  11.8603  11.8394  11.8186  11.7978  11.7769  11.7561  11.7353 
BM 4  11.4941  11.4783  11.4625  11.4466  11.4308  11.4150  11.3991  11.3833 
RGT   11.4644  11.4485  11.4327  11.4169  11.4010  11.3852  11.3694  11.3535 
RFC   11.4346  11.4188  11.4029  11.3871  11.3713  11.3554  11.3396  11.3238 
PGL   12.1667  12.1458  12.1250  12.1042  12.0833  12.0625  12.0417  12.0208 

5.9 Store ASCII XZ DAT file to COGO 3PC 
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The XYZ data file created when calculating the 
deck elevations as described in Section 5.8.12 
End Span Command above can be used to store 
COGO points at the locations where an 
elevation was calculated.  A 3PC application 
has been written to accomplish this task.  It can 
be launched from the 3PC section of the Design 
and Computation Manager. 

5.9.1 Launching the Tool 
To launch the application, go to the D&C 
Manager path 3PC Tools\Store ASCII XYZ 
DAT File to COGO, which is highlighted in 
the following figure. 

5.9.2 GPK Job Number Prompt 
Double-clicking on the Store ASCII 
XYZ DAT File to COGO entry brings 
up the following Prompt. Enter the 
GPK Job Number (for example enter 
“300” for job300.gpk) and click OK. 

5.9.3 Select Redefine Option for COGO 
The next step is to determine if you want 
Redefine to be On or Off when the 
points are stored.  Off is used for the 
example.  If you set it to on, make sure 
you choose a safe beginning point 
namer.  Click OK to accept your choice.   

5.9.4 Select ASCII XYZ DAT F
me of t

ile 
The na he file containing the XYZ data is requested next, as shown below. 

 

 
 
t can be typed in or the File button can be used to navigate to the file and sele t it using the I

following dialog. 
c
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Click OK to proceed to the next prompt. 

5.9.5 Keyin Starting Point Number 
This prompt asks for the name to be 
assigned to the first point number to be 
stored.  Since the names for the 
successive points are incremented by 1 
be sure to use a starting name that will 
allow for a sufficient range of unused 
point names.  1000 is used below.  Click 
OK to proceed. 

5.9.6 Keyin Optional Point Descriptions 
A description can be assigned to the 
points using this prompt.  Enter the 
description you wish to use and click OK 
or leave in blank if you do not wish to 
use a description.  This completes the 
process and the points are added to the 
GPK.  At any point in the process you may click the Cancel button to end it at this point.  Any 
values entered to that point are remember the next time you launch the application. 

5.10 Additional Information 

Additional COGO commands and information can be found in the GEOPAK Help. 
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Exercise 5-1 

This is an individual exercise to practice using COGO.  All of the steps are given to you.  Make 
sure you understand each step, because later you will need to determine which tools are needed 
to store COGO elements 
 

1. Open the MicroStation file t:\br-proj\Exercise_Rte_24\Route_24.dgn. 
 

2. Go to Applications>>Geopak Road>>User Preferences and delete the working directory 
and set the Coordinates to Northing and Easting (NE). 

 

 
 

3. Open the Coordinate Geometry dialog.  
 
Use the settings shown to the right: 
 Create Job Number: 123 
 Set the Operator Code to your initials. 
 
Say Yes to create the coordinate geometry database  
when the following Alert dialog box appears: 
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Create the following alignment as shown on the following pages. 
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4. Store points 501 and 505 with the coordinates shown (Element > Point > Store). 
 

  
 

Key-in Commands: 
Store Point 501 2500 4000 
Store Point 505 2519.2 5192.19 

 

5. Locate points 502 and 504 (Tools > Locate > Traverse). 
 

  
 

Key-in Commands: 
LOCATE 502 TRAVERSE 501 DIS 450 N 59 24 E 
LOCATE 504 TRAVERSE 505 DIS 360 N 62 28 W 
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6. Locate point 503 by using the Intersect tool (Tools > Intersect). 
 

 
 

Key-in Command: 
LOCATE 503 INTERSECT LINE 502 501 TO 502 P 66 LINE 504 504 TO 505 M 72 

 

7.  Store CURVE1, CURVE2, and CURVE3 (Element > Curve > Store > By Tangents). 
 

 
 

Key-in Command: 
Store Curve CURVE1 PB 501 PI 502 Tangent 158 PA 503 
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7. (Continued) 
 

  
 

PT CURVE1 To 503 M 100 
 

Key-in Command: 
Store Curve CURVE2 PB 502 PI 503 Tangent PT CURVE1 To 503 M 100 PA 504 

 

 
 

Key-in Command: 
Store Curve CURVE3 PB 503 PI 504 Tangent 85 PA 505 
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8. Store the alignment chain Route24 (Element > Chain > Store > From Elements). 
 

 
 

Key-in Command: 
Store Chain ROUTE24 501 CUR CURVE1 CUR CURVE2 CUR CURVE3 505 

 

9. Station the centerline at the beginning with station 10+12.6 (Element > Chain > Station). 
 

 
 

Key-in Command: 
Station Chain ROUTE24 BEG 10+12.6 501 AH 

 

10. Describe the chain (Element > Chain > Utility or Tools > Navigator) and save the output 
file (File > Utility).  Review the output file in UltraEdit or another text editor. 

 

11. Use COGO Navigator (Tools > Navigator) to view the data. 

 

12. Exit Coordinate Geometry. 
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Exercise 5-2 

This is an individual exercise to practice storing a horizontal alignment.  It is to be done outside 
of a GEOPAK project. 
 

1. Open the MicroStation file t:\br-proj\Exercise_5-2\Route_50.dgn. 

 

2. Enter Coordinate Geometry creating a new GPK called 053, as shown in the following 
dialog. 

 

 
 

3. Use Coordinate Geometry to create the alignments as shown on the following pages. 
 
Note that all of the coordinates are in XY format. 
 
Do not worry about the graphics (stationing, curve data, etc.) being plotted.  These items will 
be discussed in later chapters. 

 
4. Upon completion of storing the alignments in coordinate geometry, close coordinate 

geometry. 
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Route50 
 
Beginning Point: X = 1698102.3440 Y = 999551.4260 

 
Ending Point:  X = 1702419.9216 Y = 1000116.5660 

 
 Intersect the PI point using the direction back and direction ahead of curve. 
 
 Direction Back of Curve = S 82° 41’ 55” E 
 
 Degree of Curve = 2° 00’ 00” 
 
 Direction Ahead of Curve = N 49° 10’ 00” E 
 
 Station the chain beginning at 445+30.94 
 
 Name the alignment Route50. 
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Route 50 
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Big Horn 
 
 Beginning Point: X = 1700104.5480 
    Y = 1000188.1340 

 
Ending Point:  X = 1700092.3040 
   Y = 998143.9168 

 
PI of the first curve is exactly 248.8954’ from the beginning point on a bearing of  

S 1° 04’ 27.8” W 
 
 Direction Back of first curve = S 1° 04’ 27.8” W  
 
 Degree of Curve for first curve = 5° 00’ 00” 
 
 Direction Ahead of first curve = S 6° 32’ 27.3” E 
 

The direction back of second curve matches the direction ahead of the first curve, 
which is S 6° 32’ 27.3” E  

 
Degree of Curve for second curve = 5° 00’ 00” 
 
Direction Ahead of second curve = S 6° 42’ 48.6” W 
 
Intersect the alignment chain Route50 with a line segment between the PT of the first 

curve, and the PC of the second curve.  Note: The Route 50 station value shown is 
approximate. 

 
Store the alignment as BigHorn (be sure to include the Route50 intersection point) 
 
Station the alignment with station 10+00 at the intersection point with the Route50 chain. 
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Big Horn 
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Ramp 1 
 
 Beginning Point is at station 452+56.52; offset 66’ LT of Route 50 
 
 The PC of the curve is the Beginning Point 
 
 Direction Back of the curve is S 82° 41’ 55” E 
 
 Degree of Curvature = 4° 00’ 00” 
 
 Direction Ahead of the curve is N 83° 27’ 28.56” E 
 
 Alignment ends at Big Horn, at about Station 6+55.32 
 
 Station the alignment beginning at 0+00 
 
 Name the alignment Ramp1 
 
Ramp 3 
 
 Beginning Point is at station 479+48.31; offset 66’ LT of Route 50 
 

Ending Point is at end of Ramp1; however, use different point numbers for the ending 
point of each ramp.  Hint: Element > Point> Equate. 

 
 PC of the first curve is the alignment beginning point. 
 
 Direction Back for the first curve is S 67° 41’ 47.7” W 
 
 Degree of Curvature for first curve = 6° 00’ 00” 
 
 Direction Ahead for the first curve is N 69° 50’ 21.3” W 
 

Point Back of the second curve is the PI of the first curve 
 

PI of second curve is at the intersection of a line through the PI of the first curve 
with a bearing of N 69° 50’ 21.3” W and a line through ending point of Ramp1 
with a bearing of N 83° 27’ 28.56” E.  Hint: Do not use the same point number as 
the ending point for both ramps. 

 
 Degree of Curvature for the second curve = 8° 45’ 00” 
 
 Point Ahead of the second curve is the alignment end point 
 
 Station the alignment beginning at station 0+00 
 
 Name the alignment Ramp3 
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 Ramp 1 & 3 

 



GEOPAK Road for Bridge Exercise 5-3 B1 

Exercise 5-3 This is an optional individual exercise. 

1. Open the Microstation file t:\br-proj\Exercise_B1\B1.dgn 
 

2. Open the Coordinate Geometry dialog.  
 

Create Job Number: 456 
 

Set the Operator Code to your initials. 
 

 
 

3. Use the Coordinate Geometry tools to create chain B1 as shown below.  Verify the area of 
the chain. 

 
Hints: 
 
Angles at 604 and 605 are not 90° 
 
Store point 604 and the curve before storing 

points 607 and 608 
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Exercise 5-4 

This is a group exercise to demonstrate how survey points stored in a GPK file can be use to 
store a chain and profile. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn. 
 
If it is not already attached, attach t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn 
as a reference file. 

 

2.  Enter Coordinate Geometry. 
 
If the dialog box to the right appears, enter the following  
settings as shown to the right: 

 
 Project Name: J2P0300 
 Job Number: 300 
 Operator Code: cu 
 Subject: Survey Points 

 

3. Set the Visualization to Temporary Visualization and open the COGO navigator by clicking 
on the icon circled following dialog.  
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4. With the Element set to Point, highlight points 1-25 as shown below.  Visualize the points by 
clicking on the Visualize Element icon (the paint brush), which is circled in the figure. 

 

 
 

These points are the field survey and contain XY&Z information for the streambed.  
Typically these points are used to store a 3D survey chain.  Many parts of GEOPAK Road 
cannot work with a three dimensional chain, a 2D chain and profile need to be created from 
the points. 
 
In most instances the District Designer will have already done this.  The following steps 
show how the points can be used the 2D chain and profile.  The process is to store a point-to-
point chain using the points, which assigns station values to the points based in the station 
value assigned to the beginning of the chain. 
 
Once the chain is stored, a key-in command can be used to create the profile from the 3D 
points with the station value assigned to them 
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5. The chain can be created from a list of points by going to the COGO pull down menu 
Element > Chain > Store > From Elements:  The chain can be stored in either direction, 
depending upon the order in which the points are listed.  If the chain and profile are desired 
to run in the same direction as the increasing numerical order of the points the element list 
for the twenty-five points in the example is “1-25”.  However, if the chain and profile are to 
run in the opposite direction of the numerical order of the points, the element list needs to be 
reversed so it is “25-1”.  If this reverse order is used, COGO assigns the beginning station 
value to point 25 and increase the stationing as the chain proceeds to points 24, 223, etc. 
 
Since we are going to use upstream stationing, fill our the Store Chain From Elements using 
the following values as shown in the following dialog as well: 

 
 Chain Name: UPSTREAM 
 Stationing: Begin at 0.00 
 Element List: 1-25 

 

 
 

Once the dialog is complete, click on Store Chain to store the chain. 

 

6. The profile must be created using a key-in command.  It is of the form:  
 
 S PRO name list, 
where: 
S is short for STORE command, 
PRO is short for PROFILE, 
name is the name of the profile to be stored, and 
list is the list of previously stored points. 
 
The list of points may be listed as individual points, a point range, or a combination of the 
two. 
 
Type in the following command intn the COGO Key-in field and hit ENTER to execute the 
command: 
 S PRO UPSTREAM 1-25 
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7. Use the COGO navigator to describe the chain and profile just stored. 
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6.1 Objectives 

Create and store coordinate geometry elements using the Graphical Coordinate Geometry tools. 

6.2 Definitions 

Graphical Coordinate Geometry (Graphical COGO) is a set of tools that allows the user to store 
or modify coordinate geometry elements (points, lines, curves, spirals, chains, and parcels) by 
key-in or a mouse click.  (Note: Use a “left click” to data point or accept and a “right click” to 
reject.)  The elements are stored directly into the coordinate geometry database (.gpk) while 
being created or modified graphically on the screen. 

6.3 Accessing 

The Graphical Coordinate Geometry tools can be accessed from the Road tool frame or from the 
MicroStation Application pull down menu.  Click on the second icon in the Horizontal & 
Vertical Geometry tools shown below to access the tool from the Road tool frame. 

 

 
 
Or select Applications > GEOPAK Road > Geometry > Graphical Coordinate Geometry to 
access the tool.  If the user attempts to activate Graphical COGO without an active session of 
coordinate geometry, a warning dialog will appear advising the user that a coordinate geometry 
session must be started.  

6.4 Tool Frame 

When Graphical COGO is started, the tool frame shown in the figure to the right 
appears.  It contains the following four toolboxes.  When a tool in one of the 
toolboxes is selected, a dialog box will appear for the user to key-in any required 
information. 

6.4.1 Store Elements 
 

6.4.2 Modify Elements 
 

6.4.3 Manipulate Elements 
 

6.4.4 Groups  
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6.5 Store Elements Tools 

The Store Elements toolbox is used to store points, lines, curves, and spirals.  The following 
tools are contained in the Store Elements toolbox. 

6.5.1 Store Point 

   
 
The user can store a point by either Cartesian coordinates (XYZ), or curvilinear coordinates 
(station and offset).  The XY and/or Z coordinates or the station, offset, and/or elevation can be 
locked or a data point can be used to place the point.  

6.5.2 Store Equally Spaced Points 

 
 
Stores a given number of points spaced equally between two specified points.  The points may be 
either previously stored to COGO points or may be stored automatically by data pointing at the 
location of the desired point. 

6.5.3 Locate Point 

 
 
Stores a point by distance and direction.  The distance, direction, offset, and slope can be locked.  
A line segment can also be stored. 
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6.5.4 Store Line 

 
 
Stores a line segment between two previously stored points. 

6.5.5 Store Line by 2 Points 

 
 
Stores a line segment and its endpoints.  The distance and direction of the line segment can be 
specified. 

6.5.6 Store Tangent Line 

   
 
Stores a line segment that is tangent to a curve.  The two endpoints of the line segment are also 
stored.  The angle and the length of the tangent line can be specified.  Four Truncate options 
affect what happens to the original COGO element.  They are: 
 
Existing: The original COGO element is truncated or extended to the end of the new COGO 
element. 
 
None: The original COGO element is unchanged and is not truncated. 
 
Copy: The original COGO element is copied and the copy is truncated or extended so that the 
original element is left unchanged 
 
Copy (Remove Overlap): If the end of the new COGO element is not on the original element, a 
copy is made of the original element.  The copy is extended to the new element and any overlap 
with the original element is removed. 
 
Note: Redefine must be activated for the original element to be modified. 
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6.5.7 Store Curve by 3 Points 

 
 
Stores a circular curve by data pointing to locate the beginning (PC) and ending points (PT) of 
the curve.  The radius of the curve may be specified (by entering and locking its value in the 
Radius: field) or set dynamically by a data point locating a point on the curve (prompt requests a 
Through Point).  If the radius is specified the final data point determines which of the possible 
solutions is stored. 

6.5.8 Store Curve by Center 

 
 
Stores a curve by specifying the center and the beginning location of the curve.  The Radius may 
be specified or set dynamically by a data point locating the start of the curve.  The Delta Angle 
may be specified or set dynamically by locating the ending point. 

6.5.9 Store Tangent Curve Constrained 

  
 
Stores a curve tangent to a previously stored COGO element selected with a data point.  The 
curve Radius may be specified or set dynamically by a data point locating the center of the 
curve.  Once the radius is set, the length of the curve may set manually by specifying either the 
Delta angle, the Direction ahead, or the Length of the curve with the final data point 
determining which of the possible solutions is stored.  If the length of the curve is not specified, a 
data point sets it dynamically. 
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6.5.10 Store Tangent Curve Unconstrained  

 
 
Stores a curve tangent to a previously stored COGO element selected by the first data point.  The 
second data point dynamically specifies the through point.  The Radius and/or the Length of the 
curve may be specified or set dynamically by a data point.  The Truncate options are the same 
as those described for Store Tangent Line. 
 
Note: Redefine must be activated for the original element to be modified. 

6.5.11 Stores Tangent Spiral  

 
 
Stores a spiral tangent to a previously stored COGO element.  To use the tool, manually enter the 
Spiral Exit Radius and Spiral Length.  Once these are set, identify the COGO element.  The 
Spiral Entry Radius is calculated from the identified element and displayed.  Move the cursor 
to see the possible solutions and data point when the desired one is displayed. 

6.6 Modify Element Tools 

The Modify Elements toolbox is used to modify previously stored cogo elements.  The Redefine 
toggle must be turned on to modify existing elements.  Note: When using the tools it is very 
important to pay attention to the prompts in the lower left hand corner of the MicroStation 
window.  This is because may of the tools require the user to identify the element to be modified 
and than accept or reject the selection before moving on to the next step.  This functionality is 
provided because unlike the MicroStation, Graphical COGO does not have an undo function.  
The following tools are contained in the Modify Elements toolbox. 

6.6.1 Partial Delete 
Deletes part of a COGO element creating two separate COGO elements.  Additional points will 
be stored if needed.  It works like the MicroStation Partial Delete tool.  The first data point 
indicates the start of the deletion.  With this defined the movement of the cursor shows the 
dynamic deletion with the second data point indicating the end of the deletion.   
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6.6.2 Extend Plan Element 

  
 
Extends or shortens any COGO element.  The tool work similar to the MicroStation Extend tool 
with the addition that the total Length of the modified element or only the amount of the 
Extension may be specified manual.  A positive extension value lengthens the element and a 
negative value shortens it.  If the New Segment is toggled on and the new length is longer than 
the original element, the original element is left unchanged and a new COGO line segment is 
created to bridge the gap.  New Segment has no effect if the original element is shortened. 

6.6.3 Trim Elements 
Trims or extends COGO elements to another COGO element.  Its function is similar to the 
MicroStation Trim Element tool.  First select and accept the COGO element to be used as the 
cutting element (2 separate mouse data points).  With the cutting element selected, identify the 
COGO element to be trimmed or extended by a data point on the end of the element to trimmed 
or extended.  COGO will display the tentative solution.  Data point on the screen to accept or 
press the mouse resent button to reject.  If desired, additional elements can be modified based on 
the cutting line by identifying the end of the next COGO element to be modified. 

6.6.4 Intersect Elements 

 
 
Stores a new COGO point at the intersection of two COGO elements.  The original elements are 
not modified.  If the elements do not actually cross, Extend must de activated (toggled on) for 
the element(s) that needs to projected.  An Offset may be specified for either of the elements by 
activating the option and entering the offset amount (positive for an offset to the right and 
negative for an offset to the left).  The steps to using the tool are to identify the first element and 
accept it; identify the second element and accept it; and accept the proposed solution.  Clicking 
the mouse-reset will stop the process. 

6.6.5 Extend Element to Intersection 
Lengthen or shorten a COGO element to another COGO element.  Works functionally the same 
as its MicroStation counterpart with the addition of the accept/reject option. 
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6.6.6 Extend Elements to Intersection 
Lengthens or shortens two elements to intersect each other.  Works functionally the same as its 
MicroStation counterpart with the addition of the accept/reject option. 

6.6.7 Construct Circular Fillet 

  
 
Stores a circular curve between two COGO elements.  To use the tool, specify the name of the 
curve to be created and its radius or accept the next available name.  There are four Truncate 
options determine whether or not the original elements are modified:  None—neither element is 
modified, Both—both original elements are lengthened or shortened as need, First—only the 
first element is modified, and Second—only the element selected second is modified.  After 
identifying and accepting the first element and identifying the second element, at tentative 
solution will be displayed if there is one.  Moving the cursor will through the four possible 
quadrants will vary the solution.  With the desired solution displayed data point to accept the 
solution. 

6.6.8 Construct Chamfer 

  
 
Stores a line and its endpoints between two nonparallel elements.  To use the tool, specify the 
name of the line to be created or accept the next available name. Distance 1 is the distance along 
the first selected COGO element from the intersection point of the two original elements to the 
start of the chamfer.  Distance 2 is the along the second COGO element from intersection point 
to the end of the chamfer.  After identifying & accepting the first element and identifying the 
second element, the movement of the cursor will display the different possible solutions.  Data 
point when the desired solution is displayed to accept that solution.  The four Truncate options 
are the same as those for constructing a circular fillet. 
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6.6.9 Cut Element 
The tool cuts a COGO element into segments.  Keep original 
element causes the original element(s) to remain unchanged 
and only copies of the element are modified if this option is 
activated.  There are four operation modes for the tool.  The 
figure to the right is used to describe the first two modes. 
 
One Cut Many:  If a MicroStation selection set is not used, 
the first element identified is the element to be cut and the 
second element is the cutting element.  However, if more 
than one element is to be cut, a MicroStation selection set 
must be used.  For this option, place the elements to be cut 
into a selection set, activate the Cut Element tool, identify 
the cutting element, and accept/reject the proposed solution.  As an example:  L1, L2 and the 
curve can be cut at the same time by placing them into a MicroStation selection set and selecting 
L3 as the cutting elem

L2 

L3 

L1 

ent. 

 

ength.  After identifying the element to 

ut by Interval:  Divides a COGO element into segments of 
 

tion 

 
Many Cut One:  If a MicroStation selection set is not used, 
the first element identified is the cutting element and the 
second element is the element to be cut.  However, if one 
element is to be cut by many, a MicroStation selection set 
must be used.  For this option, place the cutting elements in a
selection set, activate the Cut Element tool, identify the 
element to be cut, and accept/reject the proposed solution.  As an example:  To cut L3 using the 
other element, place L1, L2 and the curve into a MicroStation selection set, activate the tool, and 
select as the element to be cut. 
 
Cut by Distance:  The original COGO element is divided 
into segments of the user specified length starting at the 
beginning point of the element.  The length of the original 
element determines the number of segments.  The final 
segment will be shorter than the others unless the length of 
the original element is evenly divisible by the segment l
be cut, the tentative solution is displayed, which can be accepted or rejected. 
 
C
equal length.  The number of segments is determined by the
value entered into the field to the right of the Mode toggle.  
After identifying the element to be cut, the tentative solu
is displayed, which can be accepted or rejected. 
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6.7 Manipulate Elements 

The Manipulate Elements tools allow the user to adjust previously created COGO elements.  If 
an element is moved, the redefine toggle must be turned on.  The following tools are in the 
Manipulate Elements toolbox. 

6.7.1 Move Plan View Element 

  
 
Moves or copies a COGO element.  The Number of Copies toggle determines if the element is 
moved or copied.  If activated, the number of copies may be specified.  To use the tool, identify 
and accept the element, data point to locate an origin point and data point a second time to locate 
the end point. 

6.7.2 Rotate Plan View Element 

 
 
Rotates the element about a specified point.  The user may specify the Angle of rotation and the 
Number of Copies, if any.  After identifying and accepting the element, data point to locate the 
point of rotation, data point to locate a first point, and data point to locate the second point or to 
accept the solution using the specified angle. 

6.7.3 Copy Parallel 

 
 
Copies an element parallel to the original element.  The user may specify an offset distance by 
activating the Distance toggle and providing the value.  If this option is not activated, the user 
provides the parallel offset dynamically. 

6.7.4 Delete Element 
Deletes an element from a coordinate database (GPK file).  Warning: There is no undo for this 
command.  The tool functions just like it’s MicroStation counter part. 
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6.8 Groups 

The Groups tools allow the user to create a chain or parcel from a series of COGO elements that 
are connected end to end.  The elements cannot overlap or have a gap greater than the Max Gap 
amount specified.  The following tools are contained in the Groups toolbox. If COGO encounters 
an Opposing Element, the user has the option to Transpose the original element or to Create a 
new element going in the right direction.  Redefine must be activated for an element to be 
transposed. 

6.8.1 Store Chain 

.  The 

6.8.2 Store Parcel 
The tool stores property information to the GPK from 

O elements.  For a given piece of 

, 
re 

e Chain.  Method defines the way the 

 
the 

 
  

ction of the parcel, and the 

Stores a chain from previously 
stored COGO elements
user selects the first element 
and data points to accept each 
element connected to the 
previous element.  When all 
elements are selected, the user 
is prompted to data point for the direction of the stationing. 

previously stored COG
property, the Parcel must be stored first.  Once this is 
gone, the Type toggle may be switched to the other 
right of way features that are supported: Building, 
Easement, and Taking.  When the type is set to Parcel
the dialog may be expanded to enable the user to sto
the Owner Name and an Improvement description. 
 
The Opposing Element option works the same as it 

oes for Stord
elements are selected.  Automatic causes the tool to 
select elements in the same way as Store Chain.  
Manual allows the user to select the individual 

elements and
click on 
Complete 
button to store
the element. 
 
When all of the 
elements are 
selected, the 

user is prompted for the dire
point of beginning. 
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7.1 Objectives 

Create and store horizontal alignment elements using COGO based graphical tools. 

7.2 Definitions 

The Horizontal Alignment Generator enables the user to create or modify horizontal 
alignments elements and automatically stores them in the active coordinate geometry (COGO) 
database.  Because of this, a GEOPAK COGO session must be active before the generator can be 
used.  Spirals, curves, tapers, and ramps can all be placed according to user-defined parameters. 
 
As the tools in the generator are presented in the rest of the chapter the required mouse clicks 
will be described as follows: 
 
Data point—a regular mouse click, which is the left button on a standard mouse configuration 
Accept—a regular mouse click, which is the left button on a standard mouse configuration 
Reject—an alternate mouse click, which is the right button on a standard mouse configuration 
Reset—an alternate mouse click, which is the right button on a standard mouse configuration 
Snap—a center button click 

7.3 Accessing 

The Horizontal Alignment Generator can be accessed from the Road tool frame, from the 
MicroStation Application pull down menu, or from the Road Project flowchart.  To access it 
from the Road tool frame, click on the third icon in the Horizontal & Vertical Geometry tools 
shown below. 

 
 
Or select Applications > GEOPAK Road > Geometry > Layout Alignments Horizontal from 
the MicroStation menu bar.  To access it from the Road Project flow chart, click on the 
Horizontal Alignment button shown below. 
 

 
 
If the user attempts to activate Graphical COGO without an active session of coordinate 
geometry, a warning dialog appears advising the user that a coordinate geometry session must be 
started. 

7.4 Menu Bar 

When the Horizontal Alignment Generator is started, the menu bar shown above will open.  The 
Horizontal Alignment Generator menu bar has three items: File, Design Tables, and Tools. 
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7.4.1 File Menu 
The File menu has one option: Preferences, which allows the user to change the following 
items. 

7.4.1.1 ELEMENT SYMBOLOGY 
The Element Symbology section of the dialog, as shown below, allows the user to set the 
MicroStation symbology of NOT stored to the GPK.  If the items are stored as COGO elements 
the settings in the MoDOT.smd file override any of these settings.  To set the symbology for an 
item, do an alternate mouse click on the picture of the elements symbology, which brings up the 
menu shown below to the right.  From the menu, the symbology can be set using the standard 
dialog, the current MicroStation symbology, the attributes of a selected element, or the 
symbology copied and pasted from another element.  The Label Scale is applied to any text 
labels.  The Grouping options are None and Graphic Group. 

 

  

7.4.1.2 COGO ELEMENT NAMES 
If the Save as COGO 
Elements toggle is activated, 
the Element Symbology 
settings described in the 
previous section are ignored.  
Default Beginning Element 
Names can be set by 
activating the type of element 
and entering a name for the 
first item of each type.  For 
example, using the settings 
shown below, the first curve 
stored would be RTE50-1, 
the second would be RTE50-
2, etc. 
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7.4.1.3 CURVE AND SPIRAL DESIGN TABLES 
These two sections of the preference dialog set the design tables to be used for curves and 
spirals.  The tables are used to calculate the required geometry parameters based tool settings.  
CADD Support has configured GEOPAK to make use of the current standard curve tables being 
utilized by MoDOT and the user does not need set these standards.  Since MoDOT uses two 
super elevation max e values (8 and 4%) the user needs to select the appropriate table.  

7.4.1.4 TURNING PATHS 
Turning Paths is a new tool that has been added to GEOPAK and may be utilized by MoDOT at 
some point in the future.  Because MoDOT currently uses Auto Turn, which is more versatile, 
the GEOPAK Turning Paths tool is not supported. 

7.4.1.5 PI ALIGNMENT 
The PI Alignment tool allows 
the user to create or modify a 
chain in a table format.  See 
Section 7.9 to learn about the 
functionality of the tool.  The 
Component Navigation part 
of the dialog controls 
whether or not the element 
corresponding to the line in 
the PI Alignment Table is 
hilited or centered in the 
active MicroStation window.  
The Constraint Display 
Settings controls whether or 
not the items listed are displayed and the attributes of the items if they are displayed. 

7.4.1.6 GEOMETRY 
SETTINGS 
Geometry Settings controls 
the parameters for individual 
design elements.  The Curve 
Parameter may to be set to 
Radius, Degree (Arc), or 
Degree (Chord).  The 
Direction may be displayed 
in Bearing or Azimuth.  PI 
Coordinates may be given in 
XY or NE format.  The 
straight Distance may be 
displayed as the distance 
form PI to PI or as the length of the Tangent Segment.  The Spiral Parameter may be Length 
or A.  Consult the MoDOT Project Development Manual for the current parameters to be used. 
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7.4.1.7 DYNAMIC INCREMENTS 
Dynamic Increments allows the user to set Increment Values for various design parameters.  
The Round to Even 
Increment toggles controls 
whether the increment is 
rounded to the next even 
value (on) or applied to the 
current value without 
rounding to the next even 
value (off).  Activate 
PageUp/PageDown 
shortcut keys allows the 
user to use the keyboard up 
and down arrow keys as 
shortcut keys for clicking on 
the increment up or down 
arrows in the individual tool 
dialog boxes. 

7.4.2 Design Tables 
This pull down menu allows the user to view and/or set the Design Tables for a Symmetrical 3 
Centered Curve, an Asymmetrical 3 Centered Curve, a Symmetrical Taper Curve, an 
Asymmetrical Taper Curve, and a Spiral Curve.  Default design parameters are provided for 
various vehicle types and deflection angles.  Users should not vary these values since they are 
based on the current AASHTO standards utilized by MoDOT. 

 

 

7.4.3 Tools 
The Tools menu (shown to the right) allows access to the Main Alignment 
tool frame (shown below) or to any of the individual Horizontal Alignment 
tool pallets.  The rest of the chapter discusses the individual tool pallets. 
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7.5 Lines/Curves Tools 

The Line/Curves tools allow the user to place line and curve 
elements by various methods.  The Line/Curves toolbox 
(shown to the right) contains the following tools. 

7
Stores 

7.5.2 Store Tangent Line 
Stores  endpoints of a line.  It functions like its Graphical COGO 

7.5.3 Store Curve By 3 Points 
s ning point, the ending point of the curve, and a 

f the 

s er point, radius, and delta angle.  It functions like its 

7.5.5 Store Tangent Curve Unconstrained 
s ified point.  It functions like its 

7.5.6 Place Curve Between Two Elements 
s  

 

.5.1 Store Line By 2 Points 
a line and its endpoints.  It functions like its Graphical COGO counter part except that the 

name of the line is determined by the COGO Element Names preference discussed above. 

 a line tangent to a curve and the
counter part except that the name of the line is determined by the COGO Element Names 
preference discussed above. 

Store  a circular curve by selecting the begin
point on the curve.  It functions like its Graphical COGO counter part except that the name o
line and the curve design parameter are determined respectively by the COGO Element Names 
and the Geometry Settings preferences discussed above. 

7.5.4 Store Curve By Center 
 a circular curve by defining the centStore

Graphical COGO counter part except that the name of the line and the curve design parameter 
are determined respectively by the COGO Element Names and the Geometry Settings 
preferences discussed above. 

Place  a curve tangent to a line or curve, and through a spec
Graphical COGO counter part except that the name of the line and the curve design parameter 
are determined respectively by the COGO Element Names and the Geometry Settings 
preferences discussed above. 

 a circular curve between two elements.  A Back andPlace
Ahead Offset may be specified as well as the curve design 
parameter (Degree or Radius of curve) set in the Geometry 
Settings preferences.  The user may increment the values in 
these and similar fields by using the adjacent up and down 
increment buttons or up and down arrow keys if that option
has been enabled.  An exterior Loop can be constructed by 
activating that option.  There are four Truncate options for 
the intersecting elements: None, Both, Back, and Ahead. 
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To use the tool, specify the curve design parameter value (D
offset values.  Following the prompt in the lower left hand corner of the MicroStation window:
identify (data point) and accept/reject the first element; identify the second element with a data 
point; move the cursor to view the possible solutions; and data point with the desired solution 
displayed to initiate construction or reset to reject all solutions.  Note: See Section 7.2 for the 
definition of a data point, accept, reject, and the other mouse clicks used in this chapter. 

egree or Radius) and the optional 
 

7.5.7 Place Simple Transition 
s  or a line and 

 
he 

th

 a transition element between two arcsDraw
one arc.  The Transition element may be Tangent, a 
Curve, or a Spiral as shown to the right.  If a Curve 
transition element is chosen, the resulting Curvature
combination can be set to Compound or Reverse and t
value of the defining the amount of curvature needs to be 
specified, as shown below.  The curvature must be flat 
enough so the transition can span the two elements at ei

 
er end of the transition. 

   
 
f the transition element is a spiral, the beginning and ending radius are determined by the 

ead. 

7.6 Curve Combination Tools 

The Curve Combination Tools allows the user to define simple 
 
ls 

I
elements at each end of the transition.  The Truncate options are None, Both, Back, and Ah

turning paths and to place compound, three centered, tapered, and
reverse curves, using the tools shown to the right.  Many of the too
utilize the definitions shown in the following figure. 
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7.6.1 Place Turning Paths 
MoDOT currently uses Auto Turn to define turning paths because that tool is more 

versatile than the GEOPAK tool.  For this reason Place Turning Paths is not supported. 

7.6.2 Place Compound Curves 
Places a compound curve between two elements using the dialog shown below.  Optional Back 
and Ahead Offsets to the two elements may be specified.  The Entry Radius and Exit Radius 
must be specified.  A parameter to define the length of either the entry or exit curve must be 
supplied, which may be the Length; the deflection angle in decimal degrees (d.ddd), degrees-
minutes-seconds (d m s), Radians, or Grads; or the Offset, as shown in below in the figure to 
the right.  A Loop for Exterior Construction may be constructed by checking that option.  The 
standard Truncate options of None, Both, Back, and Ahead are supported. 

 

  
 
After entering the values in the dialog, construction is begun by selecting and accepting the two
elements.  Once a tentative solution is shown, the up and down arrows to the right of each of the 
fields can be used to dynamically adjust the solution.  It is also possible to ch

 

ange the quadrant 
of the solution by movement of the cursor.  A data point confirms the desired solution. 

7.6.3 Place Three Centered Curves 
Stores a three-centered curve between two elements.  In addition to specifying the offsets and 
curve radii, as was possible with the previous tool, this tool allows the user to fill in some of the 
parameters using the Design Vehicles section in the bottom right corner of the dialog. 
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Select etrical) and the Deflection range determines 
which of the Design Table is used.  T

les 
pull down menu. 
 
After completing the desired portions of the dialog, construction is begun by selecting and 
accepting the back and ahead elements.  If the deflection angle between the elements does not 
match the one selected in the dialog, GEOPAK displays an alert and adjusts the deflection range 
to match the two elements.  Once a tentative solution is shown, the up and down arrows to the 
right of each of the fields can be used to dynamically adjust the solution.  It is also possible to 
change the quadrant of the solution by movement of the cursor.  A data point confirms the 
desired solution.  The Truncate options are None, Both, Back, and Ahead. 

7.6.4 Place Taper Curves 

 

s 
m right corner of the dialog. 

 

ing the Table Type (Symmetrical or Asymm
he default design tables are based on the AASHTO Green 

Book.  Which set of tables is used is part of the determined by the user preferences (Horizontal 
Alignment Generator pull down menu File > Preferences.)  The individual tables can be viewed 
by selecting the desired set of tables from the Ho izontal Alignment Generator Design Tabr

Places a curve and tapers between two elements.  This tool has the same options as the previous 
one plus the ability to add a Back and Ahead Taper at the beginning and ending of the curve.  
The tapers are defined by specifying the taper Ratio and the either its Offset or Length using the
pull down toggle for each taper.  
 
As with the previous tool, the user may fill in some of the parameters using the Design Vehicle
section in the botto

 
 
After completing the desired portions of the dialog, construction is begun by selecting and 

tion is shown, the up and down arrows to the 
right of each of the fields can be used to dynamically adjust the solution.  It is also possible to 
change the quadrant of the solution by movement of the cursor.  A data point confirms the 
desired solution.  The Truncate options are None, Both, Back, and Ahead. 

accepting the back and ahead elements.  If the deflection angle between the elements does not 
match the one selected in the dialog, GEOPAK displays an alert and adjusts the deflection range 
to match the two elements.  Once a tentative solu
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7.6.5 Place Reverse Curves 
Stores reverse curves between two elements.  A tangent section between the curves can also be 
stored.  To use this option, activate it (as show by the check mark in the figure below) and 
provide the Tangent Length. 
 
The user must specify the Entry and Exit curve parameter and has the option to set the start of 
the reverse curves by activation the top toggle in the dialog below. 

 

 
 

If the back element is a line, only the Length option is available, which specifies the distance 
from the start of the back element to the start of the reverse curve.  However, if the back element 
is curved the user may determine the start of the reversed curve by specifying the back Length, 
Direction, or Delta angle, as shown in the following figure. 

 

 
 
The option to create a Loop (Exterior Construction) can be chosen by activating that toggle.  The 
standard Truncate options (None, Both, Back, and Ahead) are also available.   
 
After completing the desired portions of the dialog, construction is begun by selecting and 
accepting the back and ahead elements.  If it exists, the tentative solution is displayed.  The user 
may modify the solution by using the up and down arrows to the right of each value field.  If the 
first option has not been locked, movement of the cursor determines where the entry curve 
begins.  A data point confirms the desired solution. 
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7.7 S

 only spiral-curve-spiral 

7.7.1  Place SC Tangent To Line 
Stores a spiral-curve combination tangent to a specified line using the parameters shown below 
in the figure on the left.  The optional Tangent Length is the distance from the start of the 
specified line to the start of the spiral.  The pull down, expanded in the figure on the right below, 
lets the user specify the length of curve using the parameters shown. 

  

piral Combinations 

The Spiral Combinations tools in the toolbox to the right allow 
the user to place spirals with curves, tangents, and other spirals.  
Since MoDOT typically places
combinations between tangents, only that tool is discussed in 
detail. 

   

7.7.2 Place ST Tangent To Curve 
Stores a spiral-tangent combination tangent to a curve using the parameters shown below in the 
figure on the left.  The pull down, expanded in the figure on the right below, lets the user specify 
the location of the spiral-tangent combination using the parameters shown 

  

   

7.7.3  Place SC Tangent To Curve 
Stores a compound spiral-curve combination tangent 
to a curve.  The spiral will be placed between the 
curves.  The two pull downs contain the same options: 
Curve Length, Direction, Delta, and Total Delta.  
The top one can be used to control where the spiral 
starts and the bottom one can be used to control the 
length of the new curve. 
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cting Elements)  
ing elements.  The standard 
nhancement to this tool is the 

als.  As described in section 7.4.1.3, the 
n

sectio

7.7.4  Place SCS (Interse
Stores a spiral-curve-spiral combination tangent to two intersect
truncate options for the existing elements are available.  A major e
ability to have the spiral length calculated based 
on the design speed, the number of lanes, and the 
curvature of the new curve to be placed between 
the spir

 table is set in the Spiral Design Tables 
n of the horizontal alignment preferences 

desig

(Horizontal Alignment pull down menu File > 
Preferences).  The available tables are:  
 
Curve Parameter Max e File to be used 
Degree (arc) 8% HA_SpiralCurve_eMax8_2002MoDOT.tbl 
Degree (arc) 4% 
Radius 8% 
Radius 4% 
 
To use the tool, select the design speed and 
number of lanes (2 lanes for undivided and 4 
lanes for divided) from the pull down options 
available in the Design Table field.  The 
availa
of 8% are shown in the figure to the right.  These 

After setting the design speed and number of
lanes, the next step is to select the desired 
curvature for the curve from the pull down 
options available in the Degree or Radius field.  
The available options for rural projects with 
curve parameter (Geometry Settings section 
under File > Preferences) set to Degree (Arc) 
are shown to the right. 
 
Select and accept the tw

ombination.  The Truncate options are None, Both, Back, and Ahead. 

HA_SpiralCurve_eMax4_2002MoDOT.tbl 
HA_SpiralCurve_eMax8_2001english.tbl 
HA_SpiralCurve_eMax4_2001english.tbl 

ble options for rural projects with a max e 

conform to those shown in MoDOT Standard 
Plans 203.20 and 203.21. 
 

 

o intersectin
initiate construction.  A tentative solution will be 
shown if it exists.  Cursor location determines 
solution quadrant.  The up and down next to the 
field define the curve may be used to increment 
its curvature.  With the tentative solution at the 
desired location, data point to initiate 
construction of the SCS c

g elements to 
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7.7.5  Place STS (Disjoint Curves)  
Stores a spiral-tangent-spiral combination between two curves using the parameters shown 
below.  The Tangent Length is the length of the optional tangent between the two curves.  If no 
tangent is desired, set the distance to zero (0).  The Truncate options are None, Both, Back, and 
Ahead. 

  

 

7.7.6  Place SCS (Disjoint Curves)  
spiral-curve-spiral combination between two curves.  The length of the spirals may be 

set from the design tables by selecting the appreciate Design Table (speed and number of lanes) 
and the curve parameter.  The Truncate options are None, Both, Back, and Ahead. 

  

Stores a 
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7.8 C

nd Ahead.  The curve parameter 
 Geometry Settings section of the File > 

ates what can be constructed using these tools. 
 

omplex Transitions 

The two Complex Transitions tools allow the user to place simple to complex 
ramps and ramp connectors with a variety of options.  Both tools support the four 
standard Truncate options are None, Both, Back, a
may be either Degree (Arc) or Radius, as set in the
Preferences dialog.  The following picture illustr

 

7.8.1  Place Complex Ramp 
Places simple to complex ramp geometry using th
ahead elements may be either a spiral or a curve.  I
by MoDOT is the spirals length.  If a curve is used
may be set using the curves length, as shown b
elements. 

e parameters shown below.  The back and 
f a spiral is chose, the design parameter used 
, the length of the ahead and back elements 

elow, delta angle or offset from the intersecting 

 
 
The back and ahead elements may be offset from the intersection elements by toggling on the 
Back and Ahead Offsets, respectively, and entering an offset distance.  Tangent tapers may also 
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be includ
the T

ed before the back and after the ahead element by toggling on that feature and defining 
a urve parameter is defined in the middle of 

 

elect the tool. 
2. Populate the dialog using the options described above. 
3. Data point on the back element and accept it. 
4. Data point on the ahead element and accept it. 
5. The location of the cursor determines the quadrant for the tentative solution. 
6. Modify the dialog settings as desired. 
7. When the desired solution appears, data point to complete construction. 

7.8.2  Place Ramp Connector 
Places  parameters shown below.  Either an Exist 

t, back, and 
ahead elements, only spirals are supported in dditionally, an offset from elements 
being connected may be applied at the beginning and end of the ramp connector. 

 

per Length and Ratio.  The Intermediate C
the dialog by either degree (as shown above) or radius.  The ability to draw a Loop (Exterior
Construction) ramp is activated using its toggle at the bottom of the dialog. 
 
To initiate construction: 

1. S

 simple to complex ramp connector using the
Spiral or a Connecting Tangent is required in addition to the Intermediate Curve.  The 
optional elements are a second transition element (exit spiral or connecting tangent), a back 
spiral, an ahead spiral, and a tangent taper.  Although there is a pull-down for the exi

 this version.  A

 
 
The steps to initate construction are the same as those for the previous tool. 
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7.9 Alignment Tools 

The Alignment Tools (shown to the right) allow the user to store an alignment 
dynamically, in a table format, or from existing COGO elements. 
 

7.9.1  Place Dynamic Element 
Places an alignment dynamically.  The user need  to select a starting element and then specify 
the length of curves and length of tangents to create the alignment.  The user determines the 
length of the tangent element either graphically by a data point on screen or numerically by 
activating the Tangent Length field and enter the desired length.  Likewise, either dynamic or 
numerical inputs maybe used or the curve parameters.  If numerical inputs are desired, activate 
that option and choose the desired parameter: Curve Length, Direction ahead, curve Delta or 
SCS combination Total Delta, as shown below in the figure on the right.  The degree of 
curvature can be changed, and spirals can be added as the user moves along the alignment. 

 

s

      

7.9.2  Place PI Alignment 
Enables the user to create or modify chains in table form based on the points of intersection 
(PI’s), as shown in the following dialog.  To edit the table, double clicking in the desired field 
and changing the value.  New PI points can be added or deleted as well as the curve or spiral-
curve-spiral element at the PI. 
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The chain to be loaded can be selected from the pull down or picked graphically using the icon to
the right.  The use of this and the other icons is given in the following table taken from the 
GEOPAK help. 

 

 

7.9.3  Store Chain 
Stores an alignment by selecting graphical elements.  It is the same as the corresponding 
Graphical COGO tool. 

7.10 Manipulate Tools 

The Manipulate tools allow the user to move/copy, rotate, extend, and delete elements. 

7.10.1  Move Plan View Element 
Moves or copies an element.  It is the same as the corresponding Graphical COGO tool. 

7.10.2  Rotate Plan View Element 
Rotates the element about a specified point.  It is the same as the corresponding Graphical 
COGO tool. 

7.10.3  Extend Plan View Element 
ds or shortens a COGO element graphically or numerically by  

or the extension length.  Activate the New Segment option to leave  
existing element unchanged and create a new one. 

7.10.4  Delete Element 
Deletes an element from the coordinate geometry database (.gpk).  It is the same as the 
corresponding Graphical COGO tool. 

E
activating that option and entering the final Length of the Element  

xten
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Exercise 7-1 

This is an individual exercise to practice storing a horizontal alignment.  It is to be done outside 
of a GEOPAK project. 
 

1. Open the MicroStation file t:\br-proj\Exercise_7-1\Route_6.dgn. 

 

2. Use Coordinate Geometry, Graphical COGO, or Horizontal Alignment Generator to 
create the alignments as shown on the following pages. 

 
  Do not worry about the graphics (stationing, curve data, etc.) being plotted.  These items will 

be discussed in later chapters. 

 
3. Upon completion of storing the alignments in coordinate geometry, close coordinate 

geometry, graphical cogo, and Horizontal Alignment Generator.  
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Rte 6 
 
Hints: 

 
Beginning Point is at 
station 1268+90.8814 
with coordinates of 
X=45,417.1720 & 
Y=90,893.1483. 
 
The PI of the curve is 
located 984.25’ from 
the beginning point 
along a bearing of  
N 80° 36’ 26” E. 
 
Curve RTE6-1 has a 
decree of curvature of 
1° 30’ 00.0” and a 
deflection to the right 
of 25° 27’ 00.0”. 
 
The end point is 
located 3290.7634’ 
from the PT of the 
curve along a bearing 
of S 73° 56’ 34” E, 
which is the ahead 
bearing for the curve. 
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8.1 Objectives 

• Understand the use of the D&C Manager in creating construction plans 
• Understand the format of the hierarchical database and how to use it 
• Be able to use the D&C Manager in conjunction with Microstation to store roadway 

features and calculate their quantities 

8.2 Definitions 

The Design and Computation Manager (D&C Manager) is a tool that allows MoDOT to 
standardize graphics elements for drafting and pay item quantities. 

8.3 Database 

A hierarchical database is used with the Design and Computation Manager.  For MoDOT the 
default database is either MoDOT_English.ddb or MoDOT_Metric.ddb.  The database stores 
information concerning functional classification and display preferences for each feature and 
item used in a Microstation file. 
 
Categories are used to group and classify the features and items used in creating construction 
drawings.  The content the MoDOT databases are divided into four overall categories – Design 
Standards/, Drafting Standards/, Pay Items/, and 3PC Tools. The first three categories each 
contain sub-categories.  The sub-categories break down each classification into more specific 
sections.  (See dialog box next page).  3PC Tools has a list of the various tools available. 
 
For example, Pay Items/ is broken into several additional categories like Pipes/ and Lighting 
and Signals/.  Pipes/ is broken into many different categories representing various types of pipes 
and pipe features that may be used in the design of your project like Flared End Sections/.  
Within the category Flared End Sections/ the different pay items for flared end sections are 
listed. 
 
CADD Support personnel maintain this database.  You will find commands within the D&C 
menu that require a password before execution.  This is a security measure to protect the 
integrity of the database file and ensure its consistent application on a statewide basis. 
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8.4 Accessing 

Design and Computation Manager can be accessed from Project Manager >> Plan View 
Quantities or from the Design and Computation Manager icon. 
 
The following dialogs will appear. 
 

 
 

 

1

2 

3 

 
The D&C Manager dialog box is composed of three distinct areas: 
 
1) The D&C Manager may be configured to operate in seven different modes. A single click 

on an icon will change operational modes.  They are: Display Design Set Compute 
Shape Pavement Preferences 

 
 
 
 

Display  Design  Set  Compute  Shape  Pavement  Preferences 
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2) The Content box lists the sub-categories or items available at your current position 
within the database structure. 

 
3) The Operations box will appear differently depending on the set mode of operation. 
 
The D&C Manager dialog box can be used in two different modes.  The dialog mode as shown 
on the previous page, allows the user to access items in from a “directory tree” structure.  The 
icons at the top of the dialog allow the user to access the different operational modes of D&C 
Manager. 
 
The toolbox mode as shown below, allows the D&C Manager dialog to be docked on the 
Microstation toolbars.  With this format, the user accesses items from the pull-down menus, and 
can toggle the various tools from the tool bar.  
 

 
   

Categories Items    Up Level       Find    Display Options  Set    Key-in’s 
 
Place Influence   Down Level     Identify             Dialog Toggle 
 
The dialog box can be toggled using the appropriate icons.   
 
 
 
  Switch to toolbox mode    Switch to dialog mode 
 

8.4.1 File Commands 
For a MoDOT Geopak user, the only file command options needed are Open 
and Exit. 
 
MoDOT_English.ddb or MoDOT_Metric.ddb will be used for all MoDOT 
projects.  This file is password protected, so the users will not be able to make 
changes to it. 
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8.4.2 Edit Commands 
Find - will search the database (from your current location) for an item 

or category.  The display in the D&C Manager dialog box will 
change to each item/category as it is found. 

 
Identify – will show the item name and description attached to an 

element in the design file. 
 

 
 
 
 
 
 

8.4.3 User Commands 
Display Settings - temporarily changes the display of elements 
on the screen to one common color, then the user may specify 
additional elements to be viewed in their original colors.  This 
tool enhances visualization when working on a complex project. 

 
 
Design Settings - sets the maximum gap tolerance and 
deduction tolerance used in computations and the 
drawing scale for placing cells.  Do not use the Custom 
Line Style Creation option.  The Project in the 
Microstation Manager handles the line style scaling in the 
MoDOT Microstation configuration.  This dialog also 
sets the cell scale to adjust the cell size appropriate to the 
drawing scale. 

8.4.4 Recall Commands 
 
Add to Favorites - saves current 
D&C Manager path for easy recall in 
the future. 
 
Organize Favorites – allows the user 
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to edit and save the Favorites list. 

8.5 Operational Modes 

8.5.1 Design 
The Design mode allows the user to tag each roadway 
element as it is placed in the design file based on item 
parameters and/or write COGO elements to the file.  
 
 Place Influence will set the level, symbology and 
attribute tags of elements drawn or copied using 
Microstation commands.  When Place Influence is On, elements are drawn using the level, 
symbology and attributes as defined in the Geopak database file.  When Place Influence is Off, 
elements are drawn using the active level, symbology and attributes of Microstation. 
 
The Draw Cogo Element button is for drawing Cogo elements to a design file.  A single click to 
this button prompts the user for a job number then opens a dialog box that allows the user to 
choose a COGO item to draw. 
 

If a drafting item is 
chosen, the Draw Cogo 

Element button changes to Draw Plan and 
Profile.  A single click to this button prompts 
the user for a job number, and then opens the 
Geopak Plan and Profile Draw box shown 
to the right. 
 
There are nine possible COGO elements that 
may be recalled from the .gpk file: points, 
lines, curves, spirals, chains, stationing, 
parcels, profiles, and parallel chain.  Each of 
these options changes the dialog box to offer 
relevant draw and label features used when 
placing an element in a graphics file.  When 
using Plan and Profile Draw, be sure to turn 
off Place Influence. 
 
The points and lines dialog boxes have a key-
in field that allows the user to specify the 
names of the COGO elements to be drawn.  
To use the line operation, the user must use 
point numbers to specify the ends of the line.  
The points/lines are drawn immediately after 
you enter their respective names and press the 
enter key.  To draw more than one point or line, place a dash in-between the point numbers.  To 
draw a line without using consecutive point numbers, use a forward slash.   
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The dialog boxes for curves, spirals, chains, stationing, parcels, and profiles have a list box that 
display the names of all stored curves and chains.  Highlighting one of the available elements 
causes it to be drawn into the file.  Each type of item has a list of options that can be plotted. 
 
**Note that Geopak can draw elements to levels not turned on.  After elements are drawn, it may 
be necessary to turn on appropriate levels and fit screen. 
 
**Remember that Place Influence is for drawing Microstation elements.  Draw Plan & Profile 
is for drawing Cogo elements.  Do Not have Place Influence on when using Draw Plan & 
Profile. 

8.5.2 Display  
Display mode is 
used to enhance on screen 
visualization.  
 
The pay item to be 
visualized is added to the 
Collection box.  Three 
display options are 
available for the display of 
the items in the Collection 
box.  
 
Highlight - will change 
those items stored in the 
collection area to the 
Microstation highlight 
color. 
 
Not - simply turns off the display of the collection items leaving everything else on. 
 
Only - will turn off everything but the collection items. 
 
 

 
Normal   Highlight   Not   Only 

8.5.3 Set   
The Set mode allows you to assign attributes 
from the D&C Manager database to existing 
graphical elements in the file. With the Use 
Complex Chain option turned off, the Set 
mode is the same as MicroStation Element 
Select.  The user may tag several elements by 
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depressing the Ctrl key while data pointing each element or by using the MicroStation Power 
Selector.  This allows you to affect multiple elements with one Set command. 
 
The Complex Chain option automatically 
creates a chain from graphic elements and 
applies the attributes of the highlighted item 
in the content box. 
   

8.5.4 Compute  
mode 

the compute mode 

select the icon. 

 can be 

ctive Design File option will allow all elements 

The Compute 
provides quantity 
calculations from graphic 
elements placed using the 
D&C Manager.  Desired 
items for inclusion in the 
computation are added to 
the collection box at the 
bottom of the main D&C 
dialog as shown to the 
right. 
 
When 
is invoked the Plan 
Quantity Computation 
dialog appears.  The user can 
type in the job number in the 
field or 
 
The items to be compu
chosen by various options 
provided in the Extents 
pulldown, which include Active 
Design File, View, Fence, 
Boundary Element, Station 
Range, Sheet Range, Selection 
Set and Boundary Selection Set.   
 
The A

ted

found in the active design file and within the specified 
Range to be considered for computation, while the 
View option will allow only those elements in the 
current view to be used for computing quantities.  If the 
view includes elements outside range, the range will overr
 
 

ide. 
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The Fence option determines which elements to be used for computation based on the Fence 

ptions chosen as well as the range.  The fence modes include Inside, Overlap, and Clip.  

llows the user to select a

ve to the MicroStation Inside, Overlap and Clip modes.  
allows the user to use an element to specify the boundary 

ased on a station range for a particular cogo chain or

t Range option allows the user to compute quantities within GEOPAK generated 
lan/profile sheets by specifying a sheet range.  

te a selection set of the elements to be included 
 the computation prior to computing quantities. 

o
However, the Clip mode applies only to non-shape elements.  
 
The Boundary Element option 
a  
previously placed closed element 
to represent the boundary for 
computation.  This option is sensiti
Similarly, the Boundary Element Set 
for element selection to be included in the computation; however, the Boundary Element Set 
mode requires the user to create the selection set of the boundary prior to computing. 
 
The Station Range option allows the user to compute quantities 
b  
Microstation baseline.  The Station Range can be typed in the 
Begin/End Station fields or it can also be selected by data 
pointing. 
 
The Shee
p
 
The Selection Set option allows the user to crea
in
 

 
 
 

he Highlight in Computation toggle will highlight all MicroStation elements utilized in the 
omputations if activated. 

tions are set, the user can start the computation by selecting the 
ompute Quantities button and the Computation Results dialog appears. 

T
c
 
Once the computation op
C
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Each item computed is listed in the Computation Results dialog.  For each item the dialog lists 
the Pay Item Name, a Description, the computed Quantity, the Unit used for computation, and a 
toggle for Exporting to a report.  At this point, the user can create a file containing the 
calculations by specifying the format of such report.  Once a file has been created, the user can 
append other computed quantities.  Once the type of format has been selected, select the Export 
button to create the output file.  There are six types of report that can be exported. 
 
Comp Book – This is a report that lists pay item name, description, quantity summaries and their 
respective station/offsets for each occurrence of the pay item.  This file is in an ASCII format. 
 
Item Report – This reports lists a total quantity for each pay item, giving the description, unit 
used for calculation.  This file is in an ASCII format. 
 
Item Table – contains the same information as an Item Report.  It produces an ASCII formatted 
quantity table to be included in a drawing file or imported into the estimate program. 
 
DBMS – provides very detailed information including calculated and rounded quantities, 
geometric properties, pay item numbers, descriptions, station / offset values, etc. The format is 
the selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase. 
 
CSV By Item – is similar to Item Report, except that the file is in a CSV (comma separated 
value) format. 
 
CSV By Element – produces a more detailed report that lists not only quantity summaries, but 
also geometric properties such as plan view coordinates and station/offsets for located elements.  
File output is in CSV format. 
 
The Run and Phase fields are used only for the DBMS format for subsequent use in the 
Quantities Manager Tool.  MoDOT currently uses the Estimate 2000 software for estimating 
quantities. 
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8.5.5 Shape 
Shape mode provides tools for 
creating shapes to be used for area 
calculations such as pavement. 
 
Three options are available for choosing 
the elements to create the shape. 
 
Semi-auto – allows the user to trace around 
element, and then GEOPAK finds an intersection on that element.  The user clicks the data point 
button to accept the intersection, or reset to choose another intersection.  GEOPAK will then find 
the next intersection, which the user can accept or choose another.  This is repeated until the 
beginning of the shape is reached. 

the elements to create the shape.  The user picks an 

 
During the Semi-auto mode of shaping, the user can select various Ball Options to adjust the size 
of the circle showing the points determining the boundary of the shape.  The Ball Options 
include Resume, Time Out, Ball Enlarge, Ball Reduce, and Ball Restore.  The default is set to 
Resume. 
 
Resume – This option deletes the drawing circles automatically upon completion of drawing the 
shape. 
 
Time Out – This option suspends the shaping process to allow the user to use any MicroStation 
window commands, such as Zoom In, Zoom Out, etc. 
 
Ball Enlarge – This option allows the user to enlarge the size of the drawing circle.  This can be 
selected an unlimited number of times while drawing the shape. 
 
Ball Reduce – Opposite of the Ball Enlarge. 
 
Ball Restore – Resizes the circle to the radius size when the Draw button was last selected. 
 
Automatic – creates the smallest shape possible.  The user selects a data point inside the shape 
they are trying to create.  GEOPAK then moves up until it intersects an element, then traces 
around intersecting elements to create the shape. 
 
Exclusive – works the same as the Automatic mode, but allows the user to select elements that 
will create a whole in the shape. 
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8.5.6 Pavement 
The Pavement mode allows the user to place pavement marking including 
striping, and symbols.  
 

 Striping – allows the user to place single or double, solid or skip pavement stripes. 
 

 Separation – allows the user to place traffic separation pavement marking. 
 

 Chevron Diverge – allows the user to place pavement chevrons in areas of diverging 
traffic. 

 

 Chevron Merge – allows the user to place pavement chevrons in areas of merging 
traffic. 

 
These are discussed further in the following pages. 
 

8.5.6.1 SINGLE STRIPING 
This box offers predefined configurations for single 
stripe and double stripe options so the user can easily 
control the type of striping being placed. 
 
The pay item box will reflect the currently selected 
pay item in the D&C Manager dialog box; the user 
may change this at any time during the process. 
 
Next, define the start option by selecting Solid or 
Skip (or a combination thereof).  If Skip is active, the 
user must define the stripe and skip lengths.  If an 
ending stripe is shorter than the Tolerance value, it 
will not be drawn.  
 
The lower portion of the dialog box allows the user to 
set up the Reference Element.  The reference 
element can be selected from an existing cogo Chain 
or from MicroStation elements in the DGN.  If DGN 
is the method selected to set the Reference Element, 
the user then has three choices to make the selection. 

The three choices are Single Element, Complex Chain, or Selection Set.  In addition, the user 
needs to set up beginning and ending point for the limits of striping.  Once the reference 
MicroStation element has been chosen, the Begin/End fields will automatically populate with the 
total distance measured for the element.  The user can adjust this distance by using the  icons 
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to the right of the Begin/End fields.  If a cogo chain is chosen,  the Begin/End stationing of the 
chain are automatically populated.  The user can then adjust the station range by utilizing the  
icons. 
 
After selecting the Draw Stripes button, the user must enter a data point on either side of the 
reference element to begin striping.  Striping is placed at the indicated offset value; the data 
point controls whether striping is offset left or right.  Striping is placed as a graphic group. 

8.5.6.2 DOUBLE STRIPING 
 
The process for Double Striping is the same as Single, 
except for having two pay item placement options, Inside 
and Outside.  The user must select either the Inside or 
Outside button for the highlighted (D&C Manager) pay 
item to be displayed in the dialog box.  Separate 
quantities are calculated for each stripe.  
 
The remaining process is the same as described above. 

8.5.6.3 SEPARATION 
This option draws pavement markings between two sets 
of selected elements.  Elements may be either GEOPAK 

 
or Microstation generated.  

nce a pay item 

een

O
has been selected, 
the user may set 
the Distance 
Betw  Stripes 
and the Slash Stripe Angle.  Tolerance functions the 
same as for striping. 
 
A Begin Point and End Point should be issued before 
the Reference DP is identified.  The Reference Point 
must fall between the Begin Point and End Point.  It 
marks the location of the first pavement marking and 
determines the direction of the slashed stripe.  All other 
markings will be based on the first stripe. 
 
Tools for defining the limits of the pavement markings 
are located at the bottom of the Separation dialog box.  
Side 1 and Side 2 are the two edges to determine the 
separation marking.  Side 2 is used when turning the 

Slash Stripe Angle.  GEOPAK begins on Side 2, and draws the marking at the specified angle 
until it intersects the Side 1 element, where the marking stops.  It is desirable to have the total 
length of the Side 2 elements longer than those of Side 1.  
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The three methods available to select elements are the MicroStation Single Element, Selection 
Set, and Complex Chain. 
 
After the Draw Separation button is selected, the user must issue a data point in the graphics 
file for the pavement markings to be displayed.  

8.5.6.4 CHEVRON DIVERGE  
Once the pay item and its relative parameters have been 
defined, there are three points needed to define the 
chevron: Gore Point, Breaking Line and Diverge Point. 
 
The Gore point defines the wide end of the gore. 
 
The Breaking Line point must fall between the two sides 
of the gore and sets the location of the point at which the 
chevron diverts in a different direction. 
 
The Diverge Point represents the narrow end of the gore 
where chevrons are to stop. 
 
Use the two Side 1 and Side 2 buttons similarly to the 
Draw Separation tool to identify the sides of the gore. 
 
Once the Draw Chevron Diverge button is selected, the 
chevrons are displayed. 

8.5.6.5 CHEVRONS MERGE 
This process works similar to Chevron Diverge except 
the two points, Gore Point and Breaking Line, have been 
combined into one Gore/Break Point that serves both 
functions.  
 
The Gore/Break Point should be located near the wide 
end of the chevron.  It simultaneously sets the beginning 
of the pavement markings and the point at which the 
chevron will break. 
 
The Merge Point set up works similar to the Diverge 
Point. 
 
The remainder of the process is as described above. 
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8.6 DP Station/Offset 

The DP Station/Offset command works in 
conjunction with Microstation commands and the 
D&C Manager.  It can be used as the data point for 

any Microstation command.  DP Station/Offset provides 
precision placement of elements based on a station and 
offset of a stored chain.  Uses for this command include 
precision placement of elements and window functions. 

8.7 Draw Transition 

Draw Transition will draw a line/curve based 
on a beginning station/offset and an ending 

station/offset relative to a selected chain.  Use of this 
command includes turn lanes, mail box widening and 
lane transitions.  
 
Note: Elements placed with Draw Transition will 
have Microstation element type curve when the 
beginning and ending offsets are different and will have 
Microstation element type line and/or arc when the 
beginning and ending offsets are the same. 

8.8 Draw Cell By Feature 

Draw Cell By Feature will place cells stored 
in the D&C Manager pay items with the 
precision of a Station/Offset input.   

 
The user selects the Feature from the D&C Manager.  
The tool offers two settings for placement: On 
Element or By Point.  If By Point is chosen, the user 
has only the options of setting the active Angle and 
Dynamic Rotation available.  However, if On 
Element is selected, the user has additional options.  
The Angle can be set up Relative to the 
chain/element or Absolute.  With the Element 
method of Chain selected, the user can select a chain 
stored in the active GPK file and check the Station 
and Offset toggles to place the cell.   
 
If a GPK is not available, the user can set the 
Element method to DGN and select a complex chain 
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or an element from the DGN file. If the Dynamic Rotation is checked on, it will override the 
active angle.  Once all the settings are set, select the Draw button to place the cell. 

8.9 Draw Cell Group By Feature 

Similarly, the Draw Cell Group By Feature combines the precision of a Station/Offset input 
with the features stored in the D&C Manager.  This dialog consists of two tabs:  Feature 

Group and Location.  
  
The Feature Group tab defines the 
features and the offsets to be used for 
placing the cells based on a reference 
chain or element set in the Location 
tab.  The tool allows for placement 
of cell groups in up to three different 
rows simultaneously.  If placing 
groups of cell in more than one row, 
the user must check the appropriate 
toggles.  Offsets are measured from 
the graphic element or chain defined 
on the Location Tab.  The upstream 
and downstream spacing can be measured from origin to origin or from edge to edge of the cell.  
All cells are placed in a graphic group for easier manipulation. 
 
The Location tab defines the 
reference chain element as well as 
the spacing of each cell within the 
group being placed. Both Chain and 
Element methods have the option 
for defining the begin/end 
placement.  When using the Chain 
method, the user can enter the 
begin/end stations, but when using 
the Element method, the user must 
data point to define the begin/end 
stations.  The Buffer Distance is 
used for cases where the begin station is known, but the user must maintain a certain distance 
inside that stationing.  The tool offers several methods for spacing in between each cell within 
the group.  The most commonly used are Even and Increment. The Angle can be set up relative 
to the chain or absolute.  The tool also offers justification settings.   
 
Once all the parameters are set in both the Feature Group and the Location tabs, select the Draw 
button to place cells. 
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Exercise 8-1 

This is a combination group / individual exercise to introduce and practice using three GEOPAK 
plan view design tools: Design and Computation (D&C) Manager, DP Station/Offset, and Draw 
Transition.  The first part of the exercise will be done together to introduce the tools.  The last 
part is to be done individually to practice using the tools. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_j5p0100.dgn. 

 

2. Open the Design and Computation Manager dialog.  To access the tool, go to  
the MicroStation menu path:  
 

 Application > GEOPAK Road Design & Computation Manager  
 

or click on the raised icon shown in the figure to the right. 
 

Select the item:  
 

 Drafting Standards/Plan/Alignments/MoDOT Proposed Baseline 
 

 
 

Select the Draw Plan & Profile button. 
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3. If you open D&C Manager outside of a project, you will get the first dialog shown below on 
the left to indicate which GPK file is to be used.  (If you are inside of a project, GEOPAK 
already knows which GPK file to use.)  Click on Select to bring up the dialog shown to its 
right.  Pick job100.gpk in this dialog and click OK.  (If you do not see job100.gpk listed, ask 
an instructor for help.)  Click OK in the first dialog to continue to the third dialog depicted in 
the bottom figure on the right side of the page. 

 

  
 

 
 
 
 
 
 
 
 
Select the Chain Operation in the Plan & Profile Draw dialog. 
 
Set the Labeling Scale to 50 
 
Have the following options turned on:  
 
 Line Direction 
 Curve Label 
 Curve Data 
 Spiral Label 
 Spiral Data 
 
After all of the settings are checked, an  
item can be plotted by clicking once on its  
name. 
 
Select the Chain Route50 
 
Do a MicroStation fit view to 
see the plotted chain. 
 
 
 

 
 
 

8-1-2 Missouri Department of Transportation 5/12/05 



GEOPAK Road for Bridge   Exercise 8-1 D & C Manager 

4. Select the Stationing Operation. 
 

Be sure the Labeling Scale is set to 50. 
 
Have the following options turned on: 
 
 Tick Marks 
 Tick Mark Stations 
 PC & PT & CS … Labels 
 PI Labels 

 
Set the following options: 
 
 Small Ticks:  
  Ticks LT, Labels LT 
 
 Large Ticks: 
  Ticks Both, Labels LT 
 
 Control Point Labels: 
  As Per Preferences 
 
Select the chain Route50. 

 
Close the Plan & Profile Draw dialog. 

 

5. Open the Draw Transition tool by selecting the raised icon shown to the right;  
it is the third tool in the expanded tool palette shown below.   

 

 
 

This tool, shown below, can be used to draw linear elements relative to a chain  
by specifying the job number, chain, a beginning station & offset, and an ending  
station & offset. 

 

5/12/05 Missouri Department of Transportation 8-1-3 



Exercise 8-1 D & C Manager GEOPAK Road for Bridge 

6. Use Draw Transition to create the edges of pavement by switching to D & C Manager  
category: Design Standards/Roadway/ and item: EOP New – Edge of Pavement (New). 

 

 
 

Be sure that Place Influence is checked to have the MicroStation symbology match the pay 
item.   

 
 

Using the following information to draw the edges of pavement: 
 

Beginning Station Beginning Offset Ending Station Ending Offset 
 Start of Chain -56 End of Chain -56 
 Start of Chain -28 End of Chain -28 
 Start of Chain 28 End of Chain 28 
 Start of Chain 56 End of Chain 56 
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7. There are a pair of three span bridges on Route 50 as it crosses over BigHorn Drive.  From 
the previous step it can be determined that the centerline for the the east and west bound 
lanes of Route 50 are located 42’ to the left and right of its chain.  The tie station for the east 
bound bridge, which locates the transverse centerline of Bent 2, is located at the 466+04.6 at 
an offset of 42’ to the Route50 chain.  Furthermore, the skew of the bents for this bridge is 
determined by the angle of Big Horn Drive relative to Route 50 where the two chains 
intersect.  This occurs at Route 50 Sta. 466+27.32.  Big Horn is has a right advance skew of 
about 10° 49” (10.8167°) relative to Route 50 at that station.  The DP Station Offset tool 
will be used set the tie and skew of Bent 2.  Open the tool by selecting the third tool in the 
second tool in the Plans Preparation tool palette shown.   

 

 
 

This tool, shown below, can be used to locate a MicroStation data point at a specific station 
and offset.  The first step is to draw a line at Route 50 Sta. 466+27.32 from an offset of –42’ 
to +42’.  To do this, set up the tool as shown below on the left; activate the MicroStation 
Place Line tool; click on the DP to start the line; change the Offset value to the one shown 
below on the right; and click on the DP button a second time to end the line. 

 

  
 

This tool, shown below, can be used to locate a MicroStation data point at a specific station 
and offset.  The first step is to draw a line at Route 50 Sta. 466+27.32 from an offset of –42’ 
to +42’.  To do this, set up the tool as shown below on the left; activate the MicroStation 
Place Line tool; click on the DP to start the line; change the Offset value to the one shown 
below on the right; and click on the DP button a second time to end the line. 

 
Use the MicroStation Rotate tool to create a copy of the line at an active angle of 10.8167°. 
 
Use the MicroStation Copy tool in conjunction with the GEOPAK DP Station Offset tool to 
copy the rotated line from its current location to Route 50 Sta. 466+04.6 at an offset of 42’ to 
the right.  This last placed line locates the transverse centerline of Bent 2. 
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8. On your own, use Draw Transition to create the edges of shoulder for the alignment with 
the following parameters. 

   
Use D & C Manager category: Design Standards/Roadway/ and item EOS New Conc. 
Edge of Shoulder - Concrete (New). 

 

 
 

Be sure that Place Influence is checked. 
 

Beginning Station Beginning Offset Ending Station Ending Offset 
 Start of Chain -64 End of Chain -64 
 Start of Chain -26 End of Chain -26 
 Start of Chain 26 End of Chain 26 
 Start of Chain 64 End of Chain 64 
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Exercise 8-2 

This is an optional exercise to show additional uses for thee GEOPAK plan view design tools. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_bh_j5p0100.dgn.  
Window in on the area where the ramps intersect Big Horn Drive. 

 

2. DP Station/Offset and Design and Computation Manager will be used to plot  
some drop inlets and a culvert to demonstrate the use of this tool combination.   
Open DP Station/Offset by selecting the raised icon shown to the right.  It is the  
second icon in that tool palette. 

 
To place the correct item, open D&C Manager category:  
 Payitems/Drainage/Drop Inlets And Manholes. 
 
Double click on the item:  731-10.32 Precast Concrete Drop Inlet 3 ft x 2ft.  This will 
activate the MicroStation Place Active Cell tool. 

 

 
 

Be sure that Place Influence is checked or else the correct cell will not be placed. 
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3. Place the cell using DP Station/Offset at the following locations: 
   
  Chain   Station Offset Orientation Auto Angle 
  BIGHORN 7+00 -20.5 Radial Checked 

7+12 20.5 Radial Checked 
   

The dialogs for placing the cells are shown below.  After entering the correct information 
into the dialog, click on DP to place the cell.  (Note: Before pressing DP, make sure that 
Place Cell is still the active MicroStation tool since DP Station/Offset will work with and 
MicroStation or GEOPAK tool that requires as data point.) 

 

  
 

The instructor will demonstrate the other orientation options. 

 

4. Use DP Station/Offset or Draw Transition to draw the culvert between the two drop using 
the following beginning and ending stations and offsets. 

   
 Beginning Ending 

  Chain   Station Offset Station Offset 
BIGHORN 7+00 -19 7+12 19 

   
Use D & C Manager category: Pay Items/Pipes/RCP/  
and item 726-13.24 24 in. Class III Reinforced Concrete Pipe Culvert. 

 
Be sure that Place Influence is checked to have the MicroStation symbology match the pay 
item.  (Note: If you use DP Station/Offset, make sure that Place Line is still the active 
MicroStation tool.) 
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5. After placing the culvert, switch the D & C Manager Mode to Compute by clicking on the 
shaded icon shown below.  A new section, called the Collection Box, is added to the main 
D&C Manager dialog.  This mode can be used to compute quantities for items placed using 
D&C Manager. 

 

  
 

Add the items shown above to the collection box by navigating to the pay item and either 
double clicking on the item or clicking on the Add to Collection icon shown below.   
 
The id icon in D&C can be used to aid in navigating to the items in the Payitems list.  This is 
done by clicking on the icon and then data pointing on the plotted item in the MicroStation 
file.  The instructor will demonstrate the use of this option. 

 

 
 

After adding the items to the collection box, zoom out in the MicroStation window until all 
of BIGHORN chain is visible.  This needs to be done in order to compute all of the curb and 
gutter. 
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6. When D&C Manager is in Compute Mode, the Operations Box switches to the form shown 
below. 

 

 
 

Set up the dialog as shown above and click Compute Quantities.  The results of the 
computation will be displayed in the Computation Results window shown below.  If you 
want a permanent record of the output, chose the type of report you want, type in the name of 
the output file you wish to use (comp.txt is used in the figure), and click on Export. 

 

 
 

To see the other types of computation reports that D&C can generate, switch the Export 
Format to Item Report and Item Table and generate a report using these options. 
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Chapter 9 Labeling 

9.1 Objectives 

• Learn how to label information with Plan View, Profile View, and Cross-Section 
Labeler 

9.2 Definitions 

The GEOPAK Labeler is a tool that allows the user to construct labels using text inserts, 
computed inserts, and key-in text.  In Road there is a different Labeler available for the plan, 
profile, and cross-section views.  Although a labeler is also available for the other GEOPAK 
Suite projects (Drainage, Survey, etc.) only the labelers available in Road are discussed in this 
chapter.  The other labelers work similarly to the ones available in Road.  

9.3 Accessing 

9.3.1 Plan View Labeler 
The Plan View Labeler can be accessed from one of three locations.  It is available 
in the menu path Applications > GEOPAK Road > Plans Preparation > Plan 
View Labeling.  It can also be selected from Plans Preparation tool pallet, which is 
the pallet outlined in the Road toolbox shown to the right.  It is the first icon in the 
Plans Preparation tool pallet shown below. 
 
 
 
 
 
 
The third way that the Plan View Labeler can be accessed is from the Road Project dialog by 
clicking on Plan View Design, shown below on the left.  This will bring up the Plan View 
Design tool pallet shown below on the right.  The Plan View Labeler is the last one in that tool 
pallet, as outlined below. 

  
 

9.3.2 Profile View Labeler 
The Profile View Labeler can be accessed from the menu path Applications > GEOPAK Road 
> Plans Preparation > Profile View Labeling or by selecting the icon shown to the right.  
As shown below, it is the seventh (or fifth from the right) icon in the Plans Preparation 
tool pallet. 
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9.3.3 Cross Section Labeler 
The Cross Section labeler can be accessed from the menu path Applications > GEOPAK Road 

> Cross Sections > Cross Section Labeling or by selecting the icon shown 
to the right.  It is the sixth icon in the Cross Sections tool pallet shown below.  
The Cross Sections tool pallet is located in the lower left hand corner of the Road 
toolbox as shown to the left. 

 

 

9.4 Basic Dialog 

When you enter one of the labelers, a dialog similar to the one shown below appears.  The dialog 
has four different parts. 

 

 

9.4.1 Banner 
The window banner (shown below) displays which labeler is active, the name of the labeler style 
file (LSF), and the name of the style selected.  If a predefined style from the active LSF is not 
selected, the banner displays “Unnamed Style.”  In the following figure the Plan View Labeler is 
active, the name of the LSF is “…\plan\modot_eng.lsf”, and a predefined style is not selected. 

 

 

9.4.2 Menu Area 
Immediately under the window banner are the pull-down menus shown below.  The menu 
options are discussed below in Section 9.11 Menus. 
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9.4.3 Label Content 
The label to be placed is displayed in the box on the right side of the 
dialog, shown in the figure to the right.  Clicking in the box activates 
a text curser, which indicates where information will be placed in the 
label.  With this cursor active, the user may use the keyboard to type 
text for the label. 
 
Under the box are several buttons.  The Space button puts a space in 
the label at the cursor position.  The Return button starts a new line.  
The Clear button clears the box to start a new label.  The Delimit 
button places a line above or below a line of text.  The Place Label 
button starts the place label process.  Note: Follow the Status Bar 
prompts located in the lower left hand corner of the MicroStation window when placing a label. 

9.4.4 Option Tabs 
The final area (shown below) contains tabs, which allow the user to define various options for 
the label.  Each of these tabs are discussed next 

 
 

9.5 Text Options 

The Text tab allows the user to add either Computed Inserts or User Inserts to the label.  If the 
User Inserts is selected, the right side of the text tab changes to the one shown below.  This 
allows the user to view and insert predefined text into the label from a User Insert File (INS).  
The contents of the file are displayed in scrollable window below the icons.  Double click on one 

of the predefined pieces of text to add it to the label. 
 
The icons serve the following functions: 

 Edit the Insert File. 
 Open an Insert File. 
 Save the Insert File. 
 Save the Insert File As… 
 Sort the contents in ascending alphabetical order. 
 Sort the contents in descending alphabetical order. 

 
Often it is easier to type directly into the label content box unless the user is unsure of spelling or 
acceptable abbreviation.  The predefined user insert files are those that come with GEOPAK.  
The user is able to edit these files or create one.  If you do have a personal inserts file, it is a 
good idea to save it to some location other than the GEOPAK …\bin\ folder to keep in from 
being overwritten during program upgrades. 
 
The Computed Inserts section and the contest of the rest of the text options tab changes 
depending on which labeler is active.  Each of these is presented in the following subsections. 
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9.5.1 Plan View Labeler Computed Text Options 
The text options tab for the Plan View Labeler using Computed Inserts is shown below. 

 

 
 

To use the station and offset computed inserts, the job number and the chain need to be selected.  
If elevations are to be calculated, a .tin file must be chosen.  The Job No: may be typed in or the 
GPK may be selected from a list of available files in the working directory by clicking on the 
magnifying glass icon  to the right of the Job No: field. 
 
The Computed Inserts are items that Geopak has the ability to calculate for the chosen item.  
The list of Computed Inserts changes with the type of element that is chosen.  If a line is 
chosen, the list of Computed Inserts will show inserts of bearing, and length.  If a curve is 
chosen the list of Computed Inserts will change to show inserts of radius, curvature, chord 
length, etc. 
 
The user can select different elements by using the icons in the Label Feature section. 

 Allows the user to select a graphical element such as a point, line, or curve. 
 

 Allows the user to data point a location on the screen. 
 

 Allows the user to choose two visualized COGO points to represent a line. 
 

 Allows the user to select the curve start point, ending point, and either the curve center or 
a point on curve using visualized name COGO points.  Only elements listed as Points in the 
COGO navigator may be used for this option. 
 
To use the computed inserts, select the Label Feature icon for the type feature you want to label.  
Next, follow the prompts in the lower left corner of the MicroStation window to select the 
feature.  Once the feature is selected, the list of Computed Text will reflect those values that the 
labeler can calculate for that type of element.  To view the computed value, select one of the 
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items from the list.  The computed value will appear in the bottom center of the dialog, as shown 
in the following figure on the left.  To change the decimal accuracy of the value, click on the pull 
down to the right of the value and select the desired accuracy as shown below in the figure on the 
right. 

 

  
 

Once the accuracy is set, double click on the highlighted item in the Computed Text list to add 
the value to the label being created. 

9.5.2 Profile View Computed Text Options 
When the Profile Labeler first opens there are no Label Feature icons, 
as shown to the right.  This is because the profile location is unknown.  
To proceed with the tool, click on the Profile Settings button.  This 
brings up the dialog shown below on the left.  The information may be 
entered manually or, if a profile cell has been utilized, the user may 

click on the Identify Cell button 
and data point / accept on the cell.  
Click OK to save the settings, 
which causes the two icons to appear. 

 

 
 

he user can select different elements by using the following icons: T

 Allows the user to data point a location on the screen.  The available computer inserts are 
station, elevation, grade, chain, and profile information. 
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 Allows the user to select a GEOPAK profile element on the screen.  If a tangent element 
is selected grade and change in elevation information is available.  If a vertical curve is selected, 
station and elevation information are available for VPC, VPI, VPT, and High-Low Point as well 
as the usual curve data (length, K value, stopping sight distance, etc.) and profile & chain names. 
 
The rest of the Profile Labeler compute text options works the same as the Plan View Labeler. 

9.5.3 Cross-Section View Computed Text Options 
Launching the Cross Section Labeler also opens the Cross Section Navigator, which is used to 
navigate from cross section to cross section.  This is because the active cross section for the 
labeler is the same as that for the navigator, as shown in the following dialogs. 

 

 
 

 
 
The user can select different elements by using the following icons: 

 Allows the user to data point a location on the screen.  The available computer inserts are 
plan view coordinates, elevation, station, offset distance, offset direction, and chain information. 
 

 Allows the user to select a cross section element.  Slope in differing formats and delta 
elevation information is available. 
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9.6 Parameters Tab 

The Parameters Tab controls the text settings for a label.  It is exactly the same for all three 
labelers.  The tab lets the user set the text Height, Width, Line Spacing, Justification, Font, 
and placement symbology, as shown in the following figure. 

 

 
 
The buttons at the bottom of tab allow the user to quickly set all of the symbology as follows: 
 

 Sets the symbology to the current MicroStation settings. 
 

 Allows the user to set the symbology by choosing a MicroStation element. 
 

 Sets the symbology using D&C Manager symbology 
 

 Sets the symbology for all of the other label element tabs (Shape and Leader) to match 
the settings in the current tab. 
 
The Sample Output section of this and the remaining tabs gives a preview of the label.  The 
sample output of a coordinate label is shown below. 
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9.7 Shape Tab 

The Shape tab allows the user to place a shape around the label and set the symbology for the 
shape.  The user can select the shape to be placed around the text.  The shape Offset is used to 
determine the distance between the shape and the text.  The symbology icons are the same as 
those described under the Parameters tab.  An example with a balloon shape and an offset equal 
to half of the text height and width is shown below. 

 

 
 
The Shape Preferences are: 
 

 None  Rectangular  
 

 Balloon  Circle 
 

 Ellipse  Hexagon 
 

 Octagon  Triangle 
 

 Single Square Bracket  Square Bracket 
 

 Round Bracket  Double Square Bracket 
 

 Double Round Bracket 
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9.8 Leader Tab 

The Leader tab allows the user to attach a leader from the label to the label.  Different leader 
types and terminators are available.  The active terminator, as defined in MicroStation pull down 
menu Element> Cell can also be used.  The symbology icons are the same as those described 
under the Parameters tab. 

 

 
 

The Leader Types are: 
 

 No Leader 
 

 One Point Leader with no bends in the leader 
 

 Two Point Leader with a single bend in the leader 
 

 Three Point Leader with two bends in the leader 
 

 Arc Leader. 
 
The Terminators are: 
 

 No Terminator 
 

 Open Terminator 
 

 Closed Terminator (filled or unfilled) 
 

 Active Terminator 
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9.9 Rotate Tab 

The Rotate tab allows the label to be rotated. 
 

   
 

 Plan View Labeler Rotate Tab Profile and Cross Section Labeler Rotate Tab 
 
The following Text Angle icons may be used to set the rotation of the label: 
 

 Rotates the label text to the current angle, which is displayed and may be set i
the field to the right  

n 

 

 Rotates the label text to the angle of the element being labeled.  The Plan View text 
maybe plotted: 
 

 Straight or 
 

 Curved  
 
 Profile and Cross Section Labels must be plotted as straight text. 
 

 The alignment angle rotated by +/- 0°, 90°, 180°, or 270° using the pull 
down shown to right. 

 
 
 
The user may also rotate the label by using the follow Set Angle By options: 
 

  Set the text angle by two data points 
 

  Set the text angle by any MicroStation element 
 

  Set the text angle by the MicroStation active angle 
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9.10 Styles Tab 

The Styles tab allows the user to choose label formats from a library of pre-defined styles.  When 
the user chooses a style, all of the parameter, shape, leader, and rotate options are set.  Both the 
Plan View Labeler and the Profile Labeler have MoDOT default files.  The styles are grouped in 
folders 
 
The Plan View Labeler Style File contains the five folders shown in the following figure.  Most 
of the items in the plan LSF file are regular text.  Computed text labels have been created in the 
ROW folder for existing and proposed right of way and easement points.  They plot the partial 
station and offset.  The Roadway folder contains to labels with computed text for the station and 
offset of pavement and shoulder points. 

 

 
 

The Profile Labeler Style File has three folders, as shown below on the left.  All of the labels in 
this LSF contain computed text. 

 

  
 

When an individual label style is selected, a preview of the label is given in the Style Preview 
window, as shown above on the left.  (Note: The Scale value in that figure list the scale used to 
create the label, not the current scale.)  The style can be transferred to the box in the upper right 
hand corner of the labeler dialog by clicking on it. 
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9.11 Menus 

9.11.1 Style Files 
The Style Files menu allows the user to manage style library files.  While the default MoDOT 
style files will load automatically, the user may create a personalized file by saving a file to a 
location with write permission.  Recently opened style files appear at the bottom of the menu.  
This allows for quickly switching between files, 

 

 
 

9.11.2 Options 
The Options menu offers several ways to customize the way the labeler works. 

 

 
 

Minimize Dialog only works with the Plan View Labeler.  If it is 
checked, the labeler dialog box minimizes when Place Label is 
chosen and the Label Viewer (shown to the right) and the Plan View 
Label Control (shown below) boxes open.  This allows the user to see 
more of the screen while placing a label..  You may notice that the 
second icon from the right in the Label Control tool pallet is active.  
This indicates that the labeler is in Place Label mode.  The last icon 
on the right is the Restore Label Dialog button.  Clicking on it closes 
the Plan View Label Control box and restores the full labeler dialog.  
The rest of the icons in the Plan View Label Control are discussed 
below in the section dealing with Label Tools.  Many of the icons on 
the left side of the pallet are available in the different tabs of the 
labeler itself. 
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Use Reference File Coordinates is available only in the Plan View Labeler.  It is intended to 
allow the user to use the coordinates of a reference file instead of the active MicroStation file.  
Since MoDOT uses the same coordinates for all of its files and attaches files using Coincident – 
World, the coordinates in the reference file should be the same as the active file and this option is 
not needed. 
 
Use DP Element Association is also available only in the Plan View Labeler.  Labels that are 
placed when it is checked are associated to MicroStation element.  (See Associating Elements in 
the MicroStation Help for more information on element association.)  This works with both the 
graphic Element and Data Point (DP) label feature icons if the DP is snapped to a graphic 
element.  If the element is modified, the label will update automatically when the Label Update 
feature is used as long as the element is in the active file.  The association cannot be applied to 
referenced geometry.  See Section 9.11.4 Tools for information about the Label Updater. 
 
Label Tools brings up one of the tool pallets shown below.  Each of the pallets corresponds to 
the labeler that launches it, as is indicated in the pallet banners below. 

 

 
 

 
 

 
 
The first group of icons, shown to the right, is the label rotate icons.  
They provide the following options: 
 

 Rotate Label To Active Angle 
 

 Rotate Label By Element Angle 
 

 Rotate Label By Two Data Points 
 

 Rotate Label By 180 Degrees 
 

 Rotate Label By Alignment Angle 
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The second group icons may be used to increment the label t
size by the increment value defined in the Inc. / Dec. Text Size 
dialog shown to the right.  Each time the user clicks on one o
the two icons in the group,  the text size is incremented.  The 
icons are: 

ext 

f 

 

 Increase Text Size 
 

 Decrease Text Size 
 
The third group of icons contains the Feature Label options.  Not all options are available for all 
labelers.  The icons are: 
 

 Data Point 
 

 Plan View Graphic Element 
 

 2 COGO Points 
 

 Arc Defined by 2 COGO Points 
 

 Profile or Cross Section Element 
 
The fourth group of icons is for label modification.  The individual icons are: 
 

 Edit Label, which allows the user to edit an already placed label.  It loads the label in the 
labeler dialog for editing.  The label must be placed again after it is edited. 
 

 Move Label, which allows the user to move an already placed label. 
 

 Extract Label, which allows the user to extract the format of an 
already placed label and load it into the labeler so a label of the format 
may be placed at another location. 
 
Label Viewer brings up the dialog shown to the right.  It allows the 
user to view and place a label.  Automatic Label copies a label with 
computed inserts to a new location and the newly computed values.  
To use this option, identify a label you want to copy by extracting or 
placing a label.  Use a Label Feature icon to indicate another item to 
be labeled and click on Automatic Label.  This will place a label at the 
new location using the placement settings as the previous label. 
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9.11.3 Scale 
The Label Scale menu, shown to the right, allows the user to choose a plan 
scale.  All labels are adjusted according to the new scale.  After selecting the 
menu option, the following dialog appears.  The user simply keys in a scale, 
and clicks OK.  All size parameters are adjusted by the difference in the Current and New Scale 
values.  Note:  This scale should not be confused with the scale shown in the Styles tab, which 
gives the scale used to create the style and not the current scale.  The only way to find the current 
scale is by the relative text size or by going to Scale > Change Scale. 

 

  

9.11.4 Tools 
The Tools menu, shown to the right, provides the user with some 
specialized tools.   
 
The Label Updater allows the user to update a label’s computed inserts if 
any of the following is changed: the alignment, the TIN, a labels position, 
etc.  Several Select By options are available, as shown in the figure below and on the right: 
Single Select, Selection Set, Fence, All Labels, and Find and Replace. 
 
Clicking on the Start button starts the update process. 
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In addition, the Highlight Labels section of the dialog (shown below on the left) may be used to 
scan the labels and highlights those that meet the selected option.  The four options are shown 
below and on the right. 

 

   
 
Selection Set Labeling allows the user to update multiple labels to a selected style using a 
MicroStation selection set.  See the GEOPAK help for more information on using this tool. 
 

 
 
Plan Label Preferences allows the user control the label preferences.  To use the tool toggle on 
Use Label Preferences and activate the options you wish to use.  See the GEOPAK help for 
more information on using this tool. 
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10.1 Objectives 

• Learn to calculate original ground profiles based on a DTM. 

10.2 Definitions 

GEOPAK will generate an existing ground profile based on a stored chain from either a 3D 
graphic file or from a triangulation file (TIN). The profile information is stored in the .gpk file 
with the option to create an input (.inp) file. 

10.3 Accessing 

Existing ground profiles may be generated in either a 2D or 3D graphics file, 
both methods are similar except that an additional option is available with a 
3D file.  To access the Existing Ground Profile utility, click on Project 
Manager >> Existing Ground Profile. Once the run is chosen, the following dialog box will 
open.  
 

 

10.4 Dialog 

Profile Name - Name of the profile to be stored. 
 
Job Number and Operator - .gpk job number and user’s initials. 
 
Chain - Name of stored chain used for profile stationing. 
 
Offset - Produces a profile at a user specified offset to the selected chain. 
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Beg Station and End Station - By clearing each field and hitting the Enter key the stationing 
will default to the beginning and ending station limits of the selected chain.  The user may also 
key-in a station range within the limits of the chain. 
 
There are four options that control the frequency of elevation calculations along the base chain. 
 
Increment - based on the beginning station of the alignment, incremented by a user specified 
value. 
 
Intersect - an elevation is calculated at every intersection of the alignment with a triangle side. 
 
Even - will compute elevations at even stations rather than an incremented distance along the 
alignment.  This is best used for alignments with station equations. 
 
POT - calculates an elevation at each POT along the alignment 
 
When in the Increment, EVEN or POT mode, an additional option box will provide two modes 
of operation for extracting data; graphic or TIN.  (Only available in 3D file) 
 
When using the Intersect or POT option with the graphic option, you will have an additional 
option for a circle to be drawn into the 3D file at the location of the intersection. 
 
**Note: It is recommended to use the Intersect option, as this will provide the most accurate 
existing ground profile. 

10.5 Reviewing Profiles 

Once a profile has been created, it may be reviewed in two ways: 
 
1) Output viewed from the COGO dialog box: Element >> Profile >> Print/List 
 
2) Profile drawn from the D&C Manager: By selecting the appropriate categories, for example: 
 

Drafting Standards >> Profile >> Existing Ground Profile >> Profile Scale 
 
Note: Always set an origin point for the profile display by drawing the Profile Cell. 
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10.6 Plotting Profiles 

1) Draw a diagonal line to serve as a reference point. 
 
2) Start D&C Manager. 
 
3) From D&C Manager, choose the appropriate scale from the category Drafting 

Standards>>Profile>>Existing Ground Profiles or Drafting 
Standards>>Profiles>>Proposed Ground Profiles. 

4) Choose the Draw Plan & Profile button. 
 
5) Set the options to be shown on the plotted profile.  
 

  
 

6) Choose the profile from the list. 
 
7) Set the horizontal and vertical scales and the station range to be plotted. 
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8) Determine the station and elevation of the origin point.  (Usually the station will be the 

beginning of the chain, and the elevation will be a rounded value below the minimum 
elevation of the profile. 

 
9) Select the By DP button and snap to the end of the diagonal line plotted in step 1 and 

accept the location.  The coordinates for that location will be filled out. 
 

 
10)  If a profile cell has not been previously plotted, and is desired, set the PGL Chain and 

choose Draw Cell at XY.  If a cell has been previously drawn, selecting the Identify 
Cell button and choosing the appropriate cell will fill in the scale, station and DP 
information. 

 
11) Select the OK button. 
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Exercise 10-1 This is a group exercise 

1. Open MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn.   
 
If the line indicating the location of the valley section is not visible, use Level Manager to 
turn on Level 22. 

 

2. Open the project j2p0300.prj as user userc. 
 

Copy the J2P0300 working alignment to Valley and enter that working alignment. 
 

 
 

Go to the Plan View screen in the working alignment definition and select VALLEY as the 
default chain.  
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3. Choose Existing Ground Profile from the Project Manager dialog. 
 
Copy the MoDOT run, name the new run Valley and enter the new run. 

 
4. Create an original ground profile for the valley section. 
 

Profile Name: Valley. 
Job Number: 300. 
Operator: cu. 
Chain: VALLEY. 
Offset: 0. 
Beg. Station: Will be filled in when the chain is chosen. 
End Station: Will be filled in when the chain is chosen. 
Mode: Intersect TIN. 
TIN File: j2p0300.tin. 

 

        
 

Click OK to create the ground profile input file, Yes to store the profile, and Yes to delete 
the 3D profile string. 

 

        
 

Close the Ground Profile dialog, saving the settings. 
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5. Open MicroStation file t:\br-proj\a_geopak_\d2\j2p0300\data\profile_j2p0300.dgn and 
attach t:\br-proj\a_geopak_\d2\j2p0300\data\plan_j2p0300.dgn as reference files 

 

6. Plot the existing ground profile above the plan view geometry using D&C Manager item 
Drafting Standards \ Profile \ Existing Ground Profiles \ 1”=100’ Existing Ground 
Profile and clicking on Draw Plan & Profile in the operations box. 

 

Set the Labeling Scale to 100 and turn on the following options as depicted below in the 
figure on the left: 
 Horizontal Axis Labels 
 Vertical Axis Labels 

 

Choose the profile Valley, to bring up the dialog shown below in the figure on the right. 
 

Set the following parameters: 
 Horizontal Scale: 100 
 Vertical Scale: 10 
 DP Station: 0+00.00 
 DP Elevation: 700 
 DP X and Y: Press DP and data point on the screen in an open area  
  above the plan view data or enter the values shown. 
 PGL Chain: VALLEY 

 

        
 

Press Draw Cell At XY and OK buttons to draw the profile cell and existing ground. 
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7. Complete the Profile View and Location sections of the Valley Working Alignment. 
 

Existing Profile: VALLEY 
Proposed Profile: VALLEY 

 

 
 

For the Location section, use the Identify Cell button to choose the profile cell. 
 

 
 

Accept the changes by clicking on the OK button. 
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Chapter 11 Vertical Alignment Generator 

11.1 Objectives 

• Create and store vertical alignments using the Vertical Alignment Generator. 

11.2 Definitions 

The Vertical Alignment Generator is a GEOPAK tool that can graphically create and modify 
proposed design profiles or modify an existing ground profile.  These operations may be 
accomplished through a dialog box and/or by dynamic manipulation of graphic elements. 
 
A profile may also be created with Coordinate Geometry (COGO) input. 

11.3 Accessing 

Vertical Alignment Generator may be invoked by Project Manager >> Vertical 
Alignment or by the Vertical Alignment Generator icon.  
 

 
 
The first dialog box that appears is labeled Settings.  The entries in this box set the parameters 
and define the location within the design file where the profile is to be displayed.  All fields must 
be completed before the design process can begin.  As the OK button is clicked, the Vertical 
Profile Generator dialog box will appear.   
 
Choosing the Identify Cell button and selecting a profile cell can also fill in the information.  If 
a profile cell does not exist, the Draw Cell at X, Y can be used to place a profile cell using the 
location and scale information provided in the dialog. 
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11.4 Dialog 

This tool allows a user to load a previously stored profile or create a new profile.  You will 
notice changes in the configuration of this dialog box as you design a vertical alignment. 
 

 
Various design parameters must be defined prior to designing a new profile; we will discuss 
those as we look at the options provided under the three headers, File, Tools, and User. 

11.4.1  File 
Clear - clears the profile display from Microstation graphics and removes all VPI’s 
from the dialog box. 
 
Draw - write the graphic elements of the profile to the Microstation file. 
 
Load - retrieves a previously stored profile from the coordinate geometry database 
(.gpk) 
 
Save - stores a new profile or updates (redefines) a previously stored profile under 
the same name. 
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Save As - is used to store the profile or to save a modified profile under a different name. 
 
Exit - ends the process. 

11.4.2 Tools 

sue Data Point - Permits the user to type in stations and elevations, 

11.4.3 User 
ets the rounding parameters for each of the items listed 

K Values - is a table of stopping sight distance K-values for crest and 

Settings - recalls the Settings dialog box that first appeared upon initializing Vertical Layout. 

11.5 Creating A New Profile 

Step 1  Place the first VPI (Note: The enter key must be used to ensure values are accepted.) 

ype station and elevation of the VPI into dialog box 
 Elevation is defined 

iii.  is defined through dynamic 

iv. be established dynamically on screen 
Step 2  Define ad

nd length parameters may be defined via precision 

Step 3 Define
 Step 2 with an option to insert VPI’s between 

Step 4 Define
 design speed from the Speed option button and GEOPAK will 

Critical Points - Vertical curves may also be defined by one or two 
critical points.  If mathematically solvable, the vertical curve will be 
drawn and the design speed display adjusted to fit the current parameters. 
 
Is

issue a data point that can be part of a Microstation place line, place a cell or perform another 
generic operations.  This is useful in displaying visual references within the profile that need to 
be considered in design of the vertical profile. 

Preferences - s
in the dialog box. 

 

sag conditions for various design speeds.  These values are based on 
the AASHTO Green Book. 

 

Four options:  
i. T
ii. Enter station of VPI as precision input (type in value)

through dynamic cursor placement on screen 
Elevation is defined via precision input Station
cursor placement on screen 
Both values for the VPI can 

 ahe  (or back tangent) 
Station, elevation, grade a
input, dynamic manipulation or a combination of both. 
 remaining VPI’s and Grades 
A repetition of the process from
two existing VPI’ s 
 Vertical Curves 
Simply define the
reference the K-value table and draw the vertical curve.  If a curve overlap occurs, 
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an overlap message will be displayed in the dialog box along with the overlap 
length. 

Step 5 Adjusting Curve Lengths 
The vertical curve can be modified by directly keying in either the K-value, curve 
length or design speed in the dialog box.  You will see the displays in the dialog 
box automatically adjust to reflect the results of any modifications. 

Step 6 Save the Profile 

11.6 Precision Placement Options 

Options available for creating or modifying vertical curves, VPI’s and grade lines:  
 
Off - Values change. 
 
Inc (Increment) - Ensures that the designated profile parameter will be adjusted as defined in the 
Preferences dialog box. 
 
Lock (Locked) - Forces all operations to maintain the designated profile parameters. 
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Exercise 11-1 

This is a group exercise to learn one way to store a roadway profile.  A profile may also be 
stored using COGO commands. 
 

1. Open the MicroStation file t:\br-proj\a_geopak_\d2\j2p0300\data\profile_j2p0300.dgn.  
The plan view DGN for Rte 6 is attached and the existing ground profile is already plotted. 

 

2. Use the VPI Based Vertical Alignment Design tool to store the Rte 6 profile.   
The tool is the third one from the right in the Horizontal & Vertical Geometry  
tool pallet shown below.  The pallet is accessed from the upper right corner of the  
Road tools shown to the right. 

 

 
 

Fill in the top portion of the Settings dialog using the following information: 
 Job Number: 300 
 Operator Code: cu 

 
To fill in the rest of the information, click on the Identify Cell button and choose the profile 
cell already plotted in the drawing.  It is the red sideways “T” at the bottom of the drawing.   

 

 
 

Once the Settings dialog is completed as shown above, click on OK to open the Profile 
Generator dialog shown on the following page. 
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3. Use the information below the dialog to store the profile.  Follow the steps used by the 
instructor.  Because an elevation is not given for VPI 1, the information for VPI 2 will be 
used to start the process.  It is important to add all of the VPIs first before trying to store any 
of the vertical curves. 

 

 
 

VPI 1 Sta.: 1281+77.20 Fd Grade: –6.40 
VPI 2 Sta.: 1285+35.00 Elevation: 799.50 Vertical Curve L: 600 
VPI 3 Sta.: 1298+40.00 Elevation: 799.50 Vertical Curve L: 300 
VPI 4 Sta.: 1306+80.00 Bk Grade: –0.01 Vertical Curve L: 660 
VPI 5 Sta.: 1311+70.00 Bk Grade: 6.80 

 

 
 

The completed profile at VPI 4 is shown above.   
Once all of the information has been added, save the 
 profile as RTE6PR by going to File > Save As in  
the generator dialog.  This will bring up the dialog  
shown to the right.  Since this is a new profile you  
will need to type in the name in the Profile field,  
which is highlighted. 

 
Exist the Profile Generator.  If asked, do not save the profile since it was just stored. 
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4. Plot the existing ground profile using Design and Computation Manager item Drafting 
Standards \ Profile \ Proposed Ground Profiles \ 100 Scale Proposed Ground Profile 
1”=100’ H & 1”=10’ V as shown in the following figure. 

 

 
 

Select the Draw Plan & Profile in the D&C Manager Operations box entitled 100 Scale 
Proposed Ground Pr… 

 

 
 

In the Open Job dialog that appears, select Job 300 and click OK. 
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5. This will bring up the Plan & Profile Draw dialog shown below and on the left. 
 

Make sure that the following options are toggled on in the dialog. 
 

VPI Labels 
Horizontal Axis Labels 
Vertical Axis Labels 
V.C. Parameters 
Grade Labels 
K Value 
VPC/VPT Label 
Stopping Sight Distance. 

 
Choose the profile RTE6PR,to bring up the dialog shown below in the figure on the right. 

 

     
 

Use the Identify Cell button in the dialog to select the same profile cell used before. 
 
Plot the profile RTE6PR by selecting the OK button.  Close D&C Manager and save the 
changes to the drawing. 
 
Compare the profile data to that given in Step 3 to make sure it agrees.  If it does not you 
need to correct the profile. 
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Exercise 11-2 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn. 

 

2. Enter Coordinate Geometry by selecting the first icon  
in the tool pallet upper right corner of the Road tools. 
 
Enter Coordinate Geometry with the following settings: 

 
 Project Name: J2P0300 
 Job Number: 300 
 Operator Code: cu 
 Subject: A6059-1 Deck 

 

3. Use Bridge deck commands to find the quarter point elevations for the first span for Bridge 
A6059. 

 Bridge Name: A6059. 
Profile: RTE6PR. 
Tie: 0. 
Cross Slope -2% (Normal Crown) 
Alignment: RTE6. 
Pier Direction Rt. to Lt.: N 13 56 34 W. 
Back Sta. CL Bearing: 1288+26.4434. 
Ahead Sta. CL Bearing: 1288+70.9850. 
Roadway Width: 36’. 
Beam Spacing: 8’-2”. 

 
The needed COGO commands are given below: 
 

BRIDGE A6059 
PROFILE RTE6PR 
TIE 0 
SE 1288+00 LT -2 12 -2 RT -2 12 -2 
ALI RTE6 
PIER BK N 13 56 34 W AH N 13 56 34 W 
SPAN 1 128826.4434 128870.9850 4 + P 
FC -19.333333 19.333333 
GU -18 18 
BEAM OFF -16.333333 -8.166667 0 8.166667 16.333333 
END SPAN 
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4. Save the COGO commands (File > File Utility) as an input file.  Name it 59-1 and give it the 
description: A6059-1 Deck as shown in the following screen capture of the File Utility 
dialog. 

 
 

Click Apply to create the file. 

 

5. Use Ultra-Edit to view the file: 
 
 t:\br-proj\a_geopak\d2\j2p0300\data\a6059-1.txt. 

 
Your results should be identical to those shown below.  If not, use the COGO Editor (Edit > 
Editor) to correct your input file.  Once it is corrected, do a Restore/Read.  Save the 
corrected input file. 
 

Bridge Deck Elevation. 
---------------------- 
Bridge A6059 
Span A6059-1  1288+26.44 R 1 to 1288+70.99 R 1 
  
           000      001      002      003      004 
---------------------------------------------------- 
LFC    799.1341 799.1173 799.1133 799.1133 799.1133  
LGT    799.1591 799.1433 799.1400 799.1400 799.1400  
BM   1 799.1906 799.1758 799.1733 799.1733 799.1733  
BM   2 799.3461 799.3369 799.3367 799.3367 799.3367  
BM   3 799.5039 799.5000 799.5000 799.5000 799.5000  
BM   4 799.3375 799.3367 799.3367 799.3367 799.3367  
BM   5 799.1733 799.1733 799.1733 799.1733 799.1733  
RGT    799.1400 799.1400 799.1400 799.1400 799.1400  
RFC    799.1133 799.1133 799.1133 799.1133 799.1133  
PGL    799.5039 799.5000 799.5000 799.5000 799.5000 
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The following steps store COGO points at the deck elevations locations.  These are created from 
the XYZ file, which is created when the deck elevations are calculated. 
 

6. Launch the Store ASCII XYZ DAT File to COGO 3PC application from the Design and 
Computation Manager by double clicking on the following path: 
 
 3PC\Store ASCII XYZ DAT File to COGO. 
 
It is the entry highlighted in the following dialog: 

 

 
 

7. Enter the GPK Job Number 300 for (job300.gpk) and click OK.  The points are added to this 
GPK file. 

 

 
 

8. Set Redefine to Off and click OK.  This prevents the points stored from overwriting any 
previously stored COGO points. 
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9. Specify the file containing the XYZ data by clicking on File button in the following prompt. 
 

 
 

Select the file 1.xyz, which is highlighted in the dialog below, and click OK for both dialogs. 
 

 
 

10. Enter 1000 as the name for the first COGO point stored and click OK. 
 

 
 

11. To identify the points stored as being deck elevation points enter “Deck Elevations” as the 
point description and click OK.  View the points stored using the COGO Navigator. 
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12.1 Objectives 

• Understand and be able to use the GEOPAK Plan & Profile Sheet Generator 

12.2 Definitions 

Based on user-defined parameters and sheet size, sheet borders will be placed into a design file 
relative to a specific alignment.  Modifications may be made to sheet size and location.  Once the 
sheet boundaries are in the proper location, the designer may then place the sheet(s) into a design 
file(s) with the appropriate reference files and sheet cell. 
 
The CADD Support Center has set up a plan sheet library as a basis for generating typical plan 
and profile sheets.  These plan sheet library includes all of the settings, which include General 
Settings, Plan Drawing Area, Profile Drawing Area, Grid Settings, Tabular Data, etc. 

12.3 Accessing 

The Plan and Profile Sheets Generator must be invoked via the Road Project 
flow chart button Plan & Profile Sheets shown to the right. 
 
When the button is pushed the Plan & Profile Sheets Run Picker dialog appears.  
 

 
 
The user will copy the run that represents the scale in which he/she is interested.  Each run is 
configured to minimize user input. 
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RUN NAME  DESCRIPTION
I100   English Sheet for a 1”=100’ scale 
I200   English Sheet for a 1”=200’ scale 
I50   English Sheet for a 1”=50’ scale 
I20   English Sheet for a 1”=20’ scale 
M1000   Metric Sheet for a 1:1000 scale 
M2000   Metric Sheet for a 1:2000 scale 
M500   Metric Sheet for a 1:500 scale 
M200   Metric Sheet for a 1:200 scale 
 
Upon entering a run, the Sheet Layout dialog appears.  The sheet scale part of the dialog is 
automatically set for each default run. 
 

 

12.4 Sheet Library 

A sheet library must be attached to the current session.  CADD Support has set up the tool so the 
MoDOT sheet library (modot.psl) is automatically attached. 
 
The sheet library contains all the parameters required to layout and to clip the sheets.  Only 
CADD Support is authorized to edit the MoDOT sheet library.  Any other sheet libraries will not 
be supported.  

12.5 Sheet Types 

The sheet library contains four types of sheets both for English and Metric projects.  They are: 
 

• Double Plan 
• Full Plan 
• Plan/Profile 
• Full Profile 

 
To select a sheet type, click in the list box area 
of the dialog, causing it to expand as shown to 
the right; move the cursor to the type of sheet 
desired; and click again. 
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12.6 Sheet Layout 

Once the type of sheet has been selected, the user is ready to layout the sheets.  To access the 
layout process, select the layout icon from the dialog box or by selecting Tools>>Sheet Layout. 
 

 
 
The Layout Sheets dialog appears. 
 

 
 

12.6.1 Job Number 
The job number is populated based on the .gpk file selected through Project Manager.  With the 
job number selected, the user is ready to set up each port. 

12.6.2 Ports 
Depending on what type of sheet is selected, the user may have one or two ports.  A port is 
typically a rectangular area that shows a particular section in a sheet, for instance, a standard plan 
and profile sheet contains two ports, one plan port and one profile port. 
 
The job specific data for each port must be set.  If there are two ports, it is important to enter the 
data for Port 1 first.  Double click on a port to enter the data for the port. 
 
If it is a plan type port the next dialog box appears.  Select the chain via the pull down list box.  
Once the chain is selected, click the OK button. 
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If it is a profile port, the following dialog appears.  The profile must be selected from the Profile 
list box. 
 

 
 
The rest of the fields in the Profile Data area of the dialog can be filled in two ways.  One way is 
to manual fill each of the field with the proper information.  However, if a profile cell has been 
plotted for the alignment, the user can automatically populate the fields by clicking on the 
Identify Cell button and data pointing on the plotted cell.  If a profile cell does not exist, the 
Draw Cell at X, Y can be used to place a profile cell once the information has been manually 
entered into the dialog. 
 
The Profile Data fields contain the following information: 
 Station: station value of the data point used to define the location of the profile; 
 Elevation: elevation value of the data point used to define the location of the profile; 
 Horizontal Scale: horizontal scale of the plotted profile; 
 Vertical Scale: vertical scale of the plotted profile; 
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 DP X: the X coordinate of the profile location; and 
 DP Y: the Y coordinate of the profile location. 
 
The X and Y coordinates can be typed in or set by choosing the By DP button and data pointing 
in the MicroStation drawing to set the origin point.  If the profile has a station equation, the 
profile can be plotted with gaps or with no gaps. 
 
Once the profile information populated, click on the OK button. 

12.6.3 Station Range 
The Beginning Station and Ending Station fields are automatically filled in with the station 
limits of the chain identified in the upper portion of this dialog box.  Should the user want to 
begin or end at a different location the user has the option to type in the station limits for sheet 
processing or click the DP button and data point a location on the screen along the center line. 
 
In addition, the user has the option to start the sheet layout before or after the beginning or end of 
the alignment by setting the appropriate values in the Extend field.  A positive number moves in 
the direction of increased stationing, while a negative number moves in the direction of 
decreased stationing.  For example, the values for the Begin Station shown below will cause the 
first sheet to start at station 445+00, 30.94 feet before the beginning of the chain. 
 

 
 
Based upon the begin and end station information the dialog will indicate how many sheets will 
be laid out as shown above.  The user then selects the Layout Sheets button to layout the sheets. 

12.7 Modify 

Once the above process is complete, the user should review the location of all the sheets to see if 
any modifications are needed. 
 
To access the Modify mode, select the Modify Sheets icon or the menu path Tools>>Sheet 
Modify. 
 

 
 
Two major modifications are supported and are selected via icon in the upper left corner of the 
dialog box shown below.  The user has the options of Slide Sheets or Modify Drawing Area.  
As the modification type is selected, the dialog changes to reflect the selection. 
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Slide Sheets - slides previously placed sheets along the alignment; adjacent sheets can remain in 
their original location or be moved along. 
 
First, the user needs to identify the port to be modified by either selecting it from the list of all 
shapes in the current set or by pressing the Id button and graphically selecting the clipping shape 
for the port, which will automatically fill the Shape. 
 

 
 
Next, determine whether only one sheet is to be modified or if the modification should be carried 
over to adjoining sheets.  If the sheets preceding the current sheet are also to be moved, then 
activate the Slide Preceding Sheets toggle.  If the sheets after the current sheet are to be moved 
a corresponding amount as the original shape, activate the Slide Following Sheets.  If all sheets 
should be adjusted the same as the original sheet, activate both the Slide Preceding Sheets and 
Slide Following Sheets. 
 
The sheets can be moved dynamically or by value.  The station of the sheet is populated when 
the sheet was selected.  To move the sheet along the alignment, enter the value (in terms of 
master units) in the Extend field or just enter the new station value.  If entering a value in the 
Extend field, a positive number moves in the direction of increased stationing, while a negative 
number moves in the direction of decreased stationing. 
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To move dynamically, press the Dynamic button to the right of Extend, which attaches the sheet 
to the cursor.  Then place a data point to initiate moving the cursor, noting the station and Extend 
values changing as you move.  To stop the dynamics, place a final data point to identify the 
location and commence sliding. 
 
To move the sheet further away (or closer to the alignment) without changing the stationing, use 
the Sheet Chord Offset using a value or dynamically 
 
The Rotation can be entered as an angle or dynamically.  Rotation always pivots about the left 
edge of the clipping shape.  Rotation alone does not cause Preceding or Following sheets to slide. 
 
Modify Drawing Area - modifies the Clip borders. 
 

 
 
The sheet must be identified using the same procedure as the Slide Sheets tool.  The Slide 
Preceding and Following Sheets is also supported. 
 
When the sheet is identified, the fields in the Lateral Dimensions are automatically populated.  
The user has the option to hold the Left Station, the Right Station or the Center Station.  Only 
one station can be held while the other two are adjusted to the revised drawing parameters.  Set 
the desired values and press the Apply button to commence redrawing. 
 
Note:  There are no dynamic options when changing the drawing area. 
 

12.8 Sheet Number Manager 

Once the clipping shapes have been placed in the MicroStation drawing, the user can adjust the 
sequence of the sheets by using the Sheet Number Manager. 
 
The Sheet Number Manager can be accessed via pull down Tools >> Sheet Number Manager 
or by selecting the icon on the dialog box. 
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Once the tool is selected the dialog below appears. 
 

 
 
The dialog lists all the sheets in the order they will be drawn.  By default the sequence of the 
sheets matches the sheet number.  If the sequence of the sheets needs to be adjusted, the user can 
highlight the sheet and use the up and down arrows on the right hand side of the dialog. 
 
The id icon allows the user to select a clip shape from the MicroStation file.  The associated line 
in the list box is highlighted. 
 
The Edit Sequence tool  may be used in the case that there are too many sheets to move 
with the arrows.  Highlight the sheet to be moved and press the icon.  The Edit Sequence 
Number dialog opens. 
 

 
 

If for any reason the user needs to change the sheet numbers, the Edit Sheet Numbers  
tool can be used.  The user needs to highlight the sheets to be changed and press the Edit Sheet 
Number icon, which opens the dialog shown below.  
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The user has the option to add a prefix, append an alpha suffix, or do both.  The sheet numbers 
can be edited by the options shown below:  
 

To Sequence Number Add – It renumbers the sheet by adding a 
value to the original sheet number.  For example, if the original 
sheet number was 1 and sequence add number is 100; the new 
sheet number becomes 101. 
 

Starting at Sheet Number – The user specifies a given number from where to start. 
 
Fixed Alphanumeric - This field is used in combination with the bottom entries in the dialog.  
The user specifies to hold a fixed alphanumeric value and toggles the Append Alpha Suffix. 

12.9 Clip Sheets 

The Clip Sheets process can be accessed via pull down Tools>> Sheet Clip or by selecting the 
icon on the dialog box. 
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The following dialog appears. 
 

 

12.9.1 Output File 
Directory – Path to folder where the design file containing the sheet(s) will be placed. 
 
Sheet Name Prefix – Name of the design file containing the sheet (s).  GEOPAK will add a 1, 2, 
etc. to the end of each file name. 
 
Orientation - The tool supports two types of orientation, Rotate View and Rotate Reference. 
Rotate View - will attach all reference files and rotate the view to conform to the orientation of 
the sheet.  This option allows true coordinates for the file.  (Note: If Rotate View is used, tools 
such as Plan View Labeler, and DP Station and Offset can still be used).  Rotate Reference - 
Will rotate each reference file to orient itself with the sheet.  (Note: It is suggested to use the 
Rotate View mode.) 
 
Sheets per File - Indicates how many sheets are drawn per design file.  (Note: for Rotate 
Reference only) 
 
Model – The Clip Sheet Tool supports the use of models.  User can select the Active model or By 
Sheet Name. 
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Sheet Range – Allows the user to choose which sheets to clip by selecting a Begin and End 
range. 

12.9.2 Labels & Annotations 
Sheet Title- CADD Support has set this field to be the name of the project county for a standard 
MoDOT sheet title block. 
 
Match Lines – Will place a match line station. 
 
Auxiliary Sheet Annotations – Will allow the user to add any other notes not already set in the 
default settings.  Once the Auxiliary Sheet Annotations toggle is turned on, the Sample 
graphics button will become available, and the user can define the plot parameters accordingly. 
These Auxiliary Sheet Annotation will provide an additional label with the name of the chain, 
the rotation angle and the sheet number. 
 

 

 
 
Process Sheets - Once all the fields in the dialog box are entered, selecting the Process Sheets, 
initiates the sheet(s) creation. 

12.10 File Pulldown Menu  

Sheet Library – This menu option has options for creating, attaching, or editing a library.  
CADD Support maintains the MoDOT plan sheet library.  Other sheet libraries will not be 
supported. 
 
Exit – Exits the Plan/Profile Sheets application. 
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12.11 View Pulldown Menu  

When different types or scales of plan sheet shapes are placed within one plan view drawing, the 
view menu options allow the user to filter sheets by names or by scale to display the shapes 
accordingly. 

12.12 Settings Pulldown Menu 

Only one option is available in this pulldown menu.  The Sheet Layout settings option allows the 
user to set a Sheet Layout Progression, Profile Stair Stepping, and Sheet View Attributes. 
 

 

12.13 Tools Pulldown Menu 

Identify Sheet – 
 
Sheet Composition - Opens the sheet composition dialog box.  It allows the user to define the 
drawing area.  CADD Support has set up default settings for MoDOT users. 
 
Sheet Layout – Opens the layout sheet dialog. 
 
Sheet Clip – Opens the clip sheet dialog. 
 
Sheet Modify – Opens the modify sheet dialog 
 
Sheet Number Manager – Opens the sheet number manager. 
 
Draw Tabular Annotation (Sheet Clip Mode) – When the ports are set up in a tabular manner, 
this tool allows the user to define the tabular data to be included within the plan/profile sheets. 
 
Process Classic Plan & Profile Runs – This will import certain information from the Classic 
Plan & Profile runs to create a sheet library.  MoDOT has developed the modot.psl as the library 
to be used with the MoDOT default runs. 
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Exercise 12-1 

This is a group exercise to show how to use the GEOPAK Plan and Profile Sheets tool to create a 
single plan sheet rotated to the alignment in the area of a stream crossing. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn.  
Attach t:\br-proj\a_geopak_\d2\j2p0300\data\topo_j2p0300.dgn as a reference file. 

 

2. Open the project j2p0300.prj and enter Road as user userc.  Use the Rte6 working 
alignment. 

 

3. Choose Plan & Profile Sheets from the Road Project flow chart.  
 
Copy the I20 run, name the new run Rte6 and enter the new run. 

 

4. Select the I_FULLPLAN from the pull down outlined blow. 
 

 
 

5. Click on the Layout Sheets icon, which is outlined below. 
 

  
 

6. This brings up the Layout Settings dialog shown below.  Switch to the Single Sheet option 
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7. To edit the information for sheet Port 1, double click on the entry for that port, which is the 
highlighted line in the following figure. 

 

 
 

Select RTE6 as the Chain for the Plan Port, as shown below. 
 

 
 

Click OK to save the Plan Port Data settings.  This will update the settings for the plan port.  
Change the Begin Station value to 1285+00, as shown below.  The End Station will 
automatically be adjusted for the size of the sheet. 

 

 
 

To place the sheet, click on Layout 1 Sheet, which is outlined above.  This will place the 
clip boundary for the sheet. 
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8. As can be noted in the following screen capture, the sheet is not centered on the stream 
crossing. 

 

 
 

To adjust the location of the sheet, select the Modify Sheet tool, which is outlined in the 
following figure. 

 

 
 

This brings up the following dialog.  The position of the sheet can be adjusted either 
dynamically (by using the Dynamic button and sliding the sheet) or by entering a station 
value, which can be used to set the Left, Center, or Right Station for the clip boundary.  
Adjust the Left Station to 1286+00 and click Apply. 
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9. Save the changes to the MicroStation file.  Return to the Plan Sheet Layout dialog and click 
on Clip Sheets icon, which outlined below. 

 

 
 

This will bring up the following Clip Sheets dialog.   
 

 
 

If the Directory field is left blank, the sheet file is placed in the current working directory, 
which is where we want it. 
 
The Sheet Name Prefix field lets the user specify the first part of the DGN to be created.  
Enter A6059- or another suitable name in the filed and hit the Tab key to update the file 
name preview to the right of the field. 
 
Click on Process Sheets to generate the sheet file.  Several MicroStation files need to be 
opened as part of the process.  Click OK to save the changes to each of the files that are 
opened.  An alternative to this is to toggle on Automatically Save Design Changes in the 
Operation tab of the Workspace > Preferences dialog.  If you do toggle it on prior to 
clipping the sheets, be sure to toggle if off when the process is complete. 
 
Exit the Plan Sheet Layout tool and save the changes to the run. 
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13.1 Objectives 

To generate original ground cross-sections based on a DTM, and to use the Cross-section 
Navigator tools. 

13.2 Definitions 

Geopak uses topographic elements to generate original cross sections.  These include breaklines 
and spot elevations. GEOPAK can access and read this data from several basic data formats: 

• Field Notes 
• RDS cross sections 
• DTMs based on Photogrammetric Mapping 
• DTMs based on survey information 

 
Of these basic formats, MoDOT primarily uses data from DTM's for generating existing ground 
cross sections. 

13.3 Accessing 

To access the Draw Pattern Lines dialog box, go to Project Manager >> Draw Pattern or 
choose the Draw Pattern icon.  
 
To access the Existing Ground Cross Sections dialog box, go to Project Manager >> Existing 
Ground Cross Sections, or choose the Existing Ground Cross Sections icon. 

13.4 Pattern Lines 

Pattern Lines identify the location of the cross sections.  Pattern lines are either a line or a line 
string drawn into a Microstation drawing.  The lines are most commonly drawn using the 
Microstation Place Line or Place Smartline tools, or by the Geopak Draw Pattern Line dialog.  
The Draw Pattern Line dialog allows the user to easily place pattern lines at even intervals, and 
key alignment locations.  The Microstation tools are generally used for specialty sections, such 
as an existing culvert location, or kinked sections. 
 
From the Project Manager select Draw Pattern, and choose the run.  The following dialog box 
will appear.  
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The user selects the Job Number and the Chain along which to draw the pattern lines.  The Left 
Offset (+) and Right Offset (+) determine how far from the chain the pattern line is to be drawn, 
and the Beginning and Ending Stations determine the station range for which to plot the pattern 
lines. 
 
Six methods are allowed for drawing the pattern lines. 
 
Increment – starts at the beginning station, and draws a pattern line at the given increment (i.e. 
for a 100 foot increment on a chain starting at 10+17, pattern lines will be drawn at 10+17, 
11+17, 12+17, …) 
 
Even – draws pattern lines at stations divisible by the given value (i.e. for a 100 foot even 
interval on a chain starting at 10+17, pattern lines will be drawn at 11+00, 12+00, 13+00, …) 
 
Once – draws a pattern line at a given station. (Only the beginning station is active.) 
 
Critical Points - Horizontal – draws a pattern line at each of the critical points (i.e. POT, PC, 
PT, etc.) within a chain. 
 
Critical Points - Vertical – draws a pattern line at each of the critical points (i.e. VPC, VPT, and 
high or low point) within a profile. 
 
Superelevation Transitions – draws pattern lines at the beginning and ending of each 
superelevation shape drawn in the current Microstation file, and any attached reference files.  
(Locations that are coincident with the horizontal control points are not drawn.) 
 
The cross section skew can be set using the skew toggle.  The pattern line is skewed by the 
specified angle from the standard pattern line (perpendicular to the baseline).  A positive skew 
angle will rotate the pattern line clockwise, and a negative skew angle will rotate the pattern line 
counter-clockwise. 
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The Level Symbology can be read from the working alignment definition.  The user can change 
the level symbology by double clicking on the Level Symbology element. 
 

   
 
Once all the key-in fields have been completed and the Draw Pattern Lines button is selected 
the pattern lines are drawn along the chain into the open Microstation design file (on the 
specified level, color and style).  This is a visual representation of the location of the cross 
sections to be generated. 
 
The user can use the Microstation Place Smartline, or Place Line command to draw additional 
pattern lines as needed. 
 

13.5 Processing the Existing Ground Sections 

Once the pattern lines have been drawn the cross-sections can be processed.  To process the 
cross-sections, go to Project Manager >> Existing Ground Cross Sections, or choose the 
Existing Ground Cross Sections icon.  After the run is chosen, the dialog box below will 
appear. 
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13.5.1  File Menu 
The File menu allows the user to save the dialog settings for each chain.  The user sets 
the parameters for each chain, and then selects File>>Save.  The next time the user 
accesses this dialog, the current information is completed from the resource files.  The 
user can select File>>Load to access the previously saved settings.  As the user 
switches between chains, the dialog settings will change according to how the user 
saved them.  The Project Manager run also performs the same functionality. 

13.5.2  Edit Menu 
The Edit menu allows the user to Cut, Copy, and Paste rows from the 
Surfaces tab.  Save Dialog Settings will save the information in the 
dialog box to the resource file.  Restore Saved Settings will restore the 
dialog settings from the resource file.  (If the resource file is deleted, these 
settings will be lost and cannot be restored.)  The Clear Surface List 
option will clear all surface options from the current list. 
 
 

13.5.3  Update Options Menu 
The Update Options dialog determines how previously 
cut original ground section elements will be handled 
when drawing new original ground section elements on 
the same cross section cells. 
 
 

Delete Existing Elements and Redraw – any existing ground lines previously drawn with this 
tool are deleted and new ground lines are drawn. 
 
Delete Non-Modified Elements and Redraw – only the existing ground lines previously drawn 
with this tool that have not been modified are deleted and new ground lines are redrawn.  Lines 
that have been modified are left intact. 
 
Draw on Top of Existing – the previously drawn existing ground lines are ignored, and new 
lines are drawn.  This will result in two sets of lines. 
 
Query – brings up the following dialog when the Draw button is pressed.  The user can choose 
which option to use. 
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13.5.4  Job Number 
The user must specify the job number that contains the chain on 
which to base the cross sections.  The drop-down arrow will display 
the .gpk files available in the working directory. 
 

13.5.5  Chain 
The user must specify the baseline to be used for the cross sections.  The 
drop-down chain will display the chains available in the specified job 
number. 
 
 
 
 
 

13.5.6  XS Cells 
The XS Cells tab allows the user to determine where each cross section is to be drawn.   
 

 
 
Three options are available in the Pattern section to determine the location 
of the cross sections. 
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By Station – allows the user to specify the Beginning and Ending Stations, the Left and Right 
Offsets and whether the stations should be cut at specified Even stations or at a specified 
Increment along the baseline. 

 
By DGN File – uses the pattern lines drawn as discussed in section 13.4.  The user needs to 

specify the Microstation design file in which the pattern lines are drawn, and the 
symbology of the pattern lines.  The Match button can be used to select a pattern line 
with the desired symbology.  When accepted, the symbology of the selected element will 
populate the fields that are turned on.  The Display button will display all of the elements 
that match the specified symbology.  The Reset button will clear all of the symbology 
fields. 

 
In Existing Only – this option uses the only the cross section cells drawn in the current 

Microstation Design File. 
 
The Scale section can be used to adjust the scale of the cross sections.  For MoDOT, the 
Horizontal and Vertical scale should always be set to 1.0.  MoDOT controls the scaling of the 
cross sections when the cross section sheets are plotted. 
 
The distance between the cross sections and the maximum number of cross sections in each 
column can be set using the Horizontal, Vertical, and Number of XS by Column option in the 
Spacing section.  It is suggested to leave the Vertical and Number of XS by Column settings at 
the default values.  The Horizontal setting may need to be changed depending on the width of 
the cross sections.  The Horizontal setting should be set to a value greater than the total width of 
the cross section.  This will prevent the cross sections from overlapping each other. 

13.5.7  Surfaces 
The Surfaces tab allows the user to specify the surfaces from which to cut the original ground 
cross sections. 
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The top portion of the dialog lists the surfaces to be cut, and the symbology to be used when 
drawing the cross sections for the given surface.  The icons on the right allow surfaces to be 
added , modified , or deleted . 
 
The Details portion of the dialog allows the user to specify the TIN file to be used as the cutting 
surface, select the Method of interpolation, and select the Type of element to be drawn.  When 
Breaklines is selected as the Method, the cross section is interpolated between the breaklines, 
and the triangles are ignored.  This is mainly used in a site design application.  The method 
should always be set to Triangles, which will include the triangles in the interpolation of the 
cross section surface.  The Type allows the cross section to be drawn a Line, or a Line String. 
 

The Display Settings section allows the 
user to determine how the cross section 
surface will be drawn.  The user can choose 
By Level Symbology or By Feature.  
When using By Level Symbology, the user 
can choose the level, weight, color, and line 
style for the cross section elements by 
 Level Symbology / By Feature toggle.  By 

Feature allows the user to choose an item from the current D&C Manager database.  Selecting 
the paintbrush 

double clicking on the symbology box next to the By

 icon will open the current D&C Manager.  The user can select the item to use, 
which will then be displayed in the Feature field.  Previously selected items can be viewed by 
using the pull down in the Feature field.  Currently, MoDOT does not have any D&C Manager 
items set up for the cross section view.  Therefore, it is suggested to us the By Level Symbology 
option.   

The Void symbology can be set using the Void toggle.  This will draw 
any areas that cross a void, or the tin hull using the specified symbology.  
The following table shows the level symbology currently used in 
MoDOT. 

 
Surface Name Level Color Weight Line 

Style 
Existing 
Ground 

XS-Existing surface-ground 90 3 2 

Void Areas XS-Existing surface-ground 40 3 2 
Top of Rock XS-Existing subsurface-rock 8 3 2 
Bottom of 
Rock 
(for rock seam) 

XS-Existing subsurface-rock bottom 9 3 2 

 
The Filter Tolerances section allows for the elimination of short 
segments that may be created but are less than the tolerance distance in 
length.  The default values are good values to be used for these options. 
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The existing ground elevation at the baseline can be plotted using the Text Settings portion of 
the dialog.  To use the text settings option, turn on the Elevation toggle.  Choosing the 
symbology box located next to the elevation toggle can set the text symbology. 
 

13.5.8  Draw 
Once the cross section location is set up, and the surface and surface symbology is 
determined, the Draw button can be used to draw the cross sections into the active 

Microstation design file.   

13.6 Cross Section 

The cross sections consist of mostly Microstation elements.  These elements can be modified 
using Microstation tools.  New elements can also be added using Microstation or Geopak 
drawing tools.   
 

 
 
The intelligence of the cross section is built into the cross section cell.  This cell is located on 
level 63.  The cell consists of the baseline name, the station and region, the end coordinates for 
the cross section location, and the coordinates for the location at which the cross section 
intersects the baseline. 
 
Warning:  Do not delete or modify the cross section cells.  If the cell is deleted or modified, the 
intelligence for this cross section will be lost. 

13.7 Cross Section Navigator 

The Cross Section Navigator is a tool used to view and move between cross-sections.  It can 
also be used to draw cross-section information. 
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The user can access Cross Section Navigator by the Cross Section Navigator icon.  When the 
icon is chosen, the following dialog appears.  
 

 

 
The user can move through the cross-sections by either choosing the 
station from the pull-down list, by typing the station value into the 
Station Key-in dialog, or by using the First Section, Previous Section, 
Next Section, or Last Section icons.  The Reset Navigator icon will 

center the first station to the view, and reset the navigator to the first station value.  Cross-section 
elements can be added or modified using Microstation tools, and/or the cross-section drawing 
tools. 
 
DP Offset Elevation – data points at 
a given offset/elevation, or find the 
offset/elevation of the cursor 
location.  
 
 
DP Delta Distance Slope – draws a line at a 
given horizontal distance and slope.  
 
 
XS Active Angle Tool – sets the active 
angle to the given value.  If a 
Microstation tool is used with the active 
angle option, this value will be used.  
 
 
Draw XS Line – draws a cross-section line.  An 
offset or a slope can be specified.  

12/22/04 Missouri Department of Transportation 13-9 



Chapter 13 Original Ground Cross Sections 

 
Profile Elevation – issues a data point at the 
elevation of a specified profile.  An alternate 
chain location can also be specified.  
 

 
 
 
 
Open View Control Dialog – allows the user to open and navigate through 
several windows to view different portions of the cross-section at the same 
time.  (I.e. The user can view the whole cross-section in view 1, the left side 
in view 2, and the right side in view 3.)  
 
 

13.8 Summary 

Basic Steps to Creating Original Ground Cross Sections from a DTM 
 

1. Have an existing triangle file (.tin). 
2. Open a 2D Microstation design file for the pattern lines. 
3. Draw the pattern lines. 
4. Open a 2D Microstation design file for the cross sections. 
5. Draw cross sections through GEOPAK. 
6. Review and modify (if necessary). 

 

13-10 Missouri Department of Transportation 12/22/04 



GEOPAK Road for Bridge Ex. 13-1 Original Ground Cross Sections 

Exercise 13-1 

This is a group exercise to demonstrate the process for specifying the location of cross sections 
using pattern lines and creating existing ground at those locations. 
 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 
Attach the following files as references: 
t:\br-proj\a_geopak\d5\j5p0100\data\plan_50_j5p0100.dgn and 
t:\br-proj\a_geopak\d5\j5p0100\data\plan_bh_j5p0100.dgn. 
 
Save changes to the MicroStation file pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj.  Select user userc. 
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3. Select the Route50 working alignment. 
 

 
 

4. Choose Draw Pattern from the Road Project dialog. 
 

  
 

Copy the MoDOT run and name the new run Route50. 
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5. Create the pattern lines for the Route50 alignment in the vicinity of Big Horn Dr. but away 
from the proposed bridge ends by using the following settings. 

 

 Job: 100  Chain: Route50 
  Beginning   Ending 
   Left Offset (+): 200  Left Offset (+): 200 
   Station: 465+00  Station: 465+40 
   Right Offset (+): 200  Right Offset (+): 200 
 Even: 10 

 
 

Make sure the Level Symbology is set to that shown below. 
 

 
 

After enter this information in the Draw Pattern Lines dialog, plot the pattern lines by 
clicking on Apply. 

 

Repeat the process with a beginning station of 465+90 and ending station of 466+50. 
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6. Add pattern lines at 1’ increments in the vicinity of the proposed bridge ends.  To do this, 
change the Even value to 1 and add the following two ranges of pattern lines as follows.  
Make sure you do not add pattern lines on top of any already plotted lines. 

 
Beginning Station  465+50 Ending Station:  465+80 
Beginning Station  466+60 Ending Station:  467+00 

 

 
 

7. Exit Draw Pattern and save the changes to the MicroStation file. 

 

8. In the Pattern section of the Route 50 Working Alignment Definition note that the Design 
file is pattern_shape_j5p0100.dgn and the symbology for the pattern lines. 

 

 
 

9. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_j5p0100.dgn. 
 

Save the file as xs_50_j5p0100.dgn so xs_j5p0100.dgn remains a blank file. 
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10. Choose Existing Ground Cross Sections from the Road Project dialog. 
 

 
 

Copy the MoDOT run to Route50 and enter that run. 

 

11. Cut the existing ground cross sections with the following parameters in the top portion of the 
dialog: 

 Job Number: 100 
Chain: Route50 

 
In the XS Cells tab, set the following: 

 
Pattern: By DGN File 
Design File: pattern_shape_50_j5p0100.dgn 
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11. Continued 
In the Surfaces tab, set the TIN File to j5p0100.tin. 

 

 
 

Click on Draw to cut the cross sections. 

 

12. Exist Draw Cross Sections and save the changes to the run and the MicroStation drawing 
xs_50_j5p0100.dgn. 

 

13. In the Cross Section View section of the Route50 Working Alignment Definition set 
the XS DGN File to xs_50_j5p0100.dgn. 
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Exercise 13-2 

This is a group exercise to demonstrate how stream cross sections can be plotted from both a 
digital terrain model (DTM) and the field surveyed survey chains.  A previous exercise 
demonstrated how survey points are used to create a chain and a profile.  This exercise plots the 
chains to indicate the location of the cross sections, creates cross sections at those locations from 
the DTM, and adds the surveyed profiles so a comparison can be made between the DTM and 
the field-surveyed data.  A later exercise demonstrates how a report can be generated from this 
geometric information for import into HEC-RAS. 
 

1. Open the MicroStation file:  
 t:\br-proj\a_geopak\d2\j2p0300\data\pattern_shape_j2p0300.dgn. 
 
If it has not already been done, attach the following files as references:  
 t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn. 
 t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj and enter it as 
userc. 

 

3. Copy the J2P0300 working alignment to Stream and enter that working alignment. 

 

4. Enter Coordinate Geometry (COGO).  Set Visualization  
to and use the Permanent and use the COGO Navigator to  
visualize the following chains, which are highlighted in  
the figure to the right.  To do this, set Element to Chain,  
highlight the desire elements, and click on the paintbrush  
(Visualize Element) icon. 
 
 DCS_98F (Typical Channel Section 98’ Downstream) 
 DVS_1400 (Narrow Valley Section 1400’ Downstream) 
 STREAM (The Streambed) 
 UCS_223 (Typical Channel Section 233’ Upstream) 
 USV_423F (Narrow Valley Section 423’ Upstream) 
 
Close the navigator and COGO. 
 
The section of the RTE6 chain that corresponds to the Existing Channel section will be 
plotted later. 

 

5. To make it easier to complete the rest of this exercise, turn off the display for the reference 
files. 
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6. A close inspection of the plots of the chains shows that lines are not straight, which means 
that locations surveyed weave back and forth.  In fact, the upstream channel section actually 
doubles back in two placed near where it crosses the stream.  Engineering judgment is 
needed to determine whether the chains and profiles should be used as submitted or recreated 
by eliminated some of the points.  To do this, the chain and profile need to be restored using 
only the desired points.  Exercise 5-4 gives information on how to store a chain and a profile 
from a set of points. 
 
For this exercise we will use the chains and profiles used as submitted with the Bridge 
Survey Report for the project.  Great care must be used before modifying the survey 
information provided.  If you question the data, the best option is to direct them to the 
District Contact, who can verify the information with the surveyor. 

 

7. The pattern lines that are used to indicate the location of cross-sections need to be  
a single line or a line string running from the left to the right side of the alignment  
that connects the cross-sections together.  For this case, the alignment chain is  
STREAM, which is the streambed as surveyed. 

 
Set the active MicroStation symbology to the following: 
 
 Lv Names Geopak-Pattern line 2 
 Color 0 
 Line Style 0 
 Weight 1 
 
The lines visualized using COGO are just a series of lines.  Use the MicroStation  
Create Complex Chain to covert the lines in to line strings.  It is the highlighted  
tool in the Main MicroStation toolbox shown to the right. 

 
In the Create Complex Chain tool, set the Method to Automatic and toggle on Simplify 
geometry, as shown below. 
 

  
 

With this tool active click on the left end of each of the section chain lines and data point 
twice to accept. 
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8.  Since only a portion of the RTE6 chain needs to be plotted, use Draw Transition 
to plot the portion needed.  It  
is the third icon in the raised  
tool pallet in the Road tool- 
box shown to the left.  The  
expanded tool pallet is shown above an to  
the right: 

 
The existing channel section is plotted from RTE6  
Station 1291+75.00 to 12+98.25.  Use the same range  
when drawing the chain with a beginning and ending  
offset of zero, which indicates the location of the  
existing channel section in the drawing.   
 
Set up the Draw Transition tool as shown to the right  
and click Draw. 

 

9. Enter the Working Alignment Definition for Stream and change the following: 
 

Section Item Value 
Plan View Chain: STREAM 
Pattern Design File: pattern_shape_j2p0300.dgn 
 Lv Names Geopak-Pattern line 2 
 Weights 1 
 Colors 0 

 
The easiest way to set Pattern search symbology is to use the Match feature.  To use it, click 
on the Reset button to clear the symbology settings, click on the Match button, data point 
on one of the pattern lines (the line is highlighted), and data point again to accept the line.  
The completed dialog of the Pattern section is shown below. 

 

 
 

Make sure you get line types 3-4.  Click OK to accept the changes. 
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10. Save changes to the current MicroStation file and open the following drawing:  
 t:\br-proj\a_geopak\d2\j2p0300\data\xs_stream_j2p0300.dgn. 

 

11. Choose Existing Ground Cross Sections from the Project Manager dialog. 
 

  
 

Copy the MoDOT run to Stream and enter that run.  Set the XS Cells tab as shown below 
and have the J2P0300.TIN as the only one listed under the Surfaces tab. 

 

 
 

 
  

Select Draw to generate the sections.  Save the MicroStation file.  Exit the run and save 
settings 
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12. When you click on Draw you should have gotten the following dialog: 
 

 
 

This dialog appears because the downstream narrow valley section is outside of the TIN 
model.  Before plotting this profile, a cell needs to be drawn to for that pattern line. 
 
Open the Draw Cross Section Cells tool.  It is fifth (5th) icon from the right in the Cross 
Section tool pallet, which is shown below.  The Cross Section tool are located in the lower 
left hand corner of the Road tools. 

 

 
 

Enter the following settings in the Draw XS Cell  
tool, as shown to the right: 
 

Top Section 
 Method Semi_Auto 
 Job Number 300 
 Chain STREAM 
 Horizontal Scale 1.00 LT 1283.362 
 Vertical Scale 1.00 RT 1185.859 
 

Station Section 
 Station 0+00.00 
 Auto Off 
 

Offset Section 
 Offset Horizontal -1283.362 
 Offset Vertical 500 
 

Elevation Section (DP is left end of top cell) 
 DP X 0.00 
 DP Y 1500 
 Auto Off 
 Elevation 771 
 
Click Apply to draw the cell. 

 

8/4/05 Missouri Department of Transportation 13-2-5 



Exercise 13-2 Stream Sections GEOPAK Road for Bridge 

13. Set xs_stream_j2p0300.dgn as the XS DGN in the Cross Section View section of the Water 
Working Alignment Definition as shown below. 

 

 
 

14. The final step is to draw the survey profiles for each of the sections. 
 
Open D & C Manager and navigate to the following item: 
 
Drafting Standard \ Profile \ 1”=10’ Existing Ground Profile as shown below. 
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(Step 14 continued) 
 
Click on Draw Plan & Profile in the operations box shown below. 
 

  
 
This will bring up the following dialog.  Since only the line and no text is being plotted the 
setting of the label scale does not matter. 
 
Since the sections will be plotted from top to bottom, select the profile DVS_1400.  Set up 
the Profile dialog as shown below. 
 

  
 
The DP point is the left edge of the top most cross section cell (Station 0+00).   
 
Click on Draw Cell At XY to place a profile cell. 
 
Click on OK to draw the profile. 
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(Step 14 continued) 
 
To make the placement of the rest of the profiles easier, open the Working Alignment 
Definition dialog and go to the Profile View / Location section.  Set it up as shown below 
 

  
 
Click OK to save the changes. 
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(Step 14 continued) 
 
The second from the top XS cell (Station 18+88.54) is for the upstream narrow valley 
section. 
 
Select the profile USV_423F.  Set up the Profile dialog as shown below on the left. 
 

   
 
Click on Draw Cell At XY to place a profile cell. 
 
Click on OK to draw the profile. 
 
Repeat the process for the third XS cell (Station 16+68.42), which is for the upstream 
channel section. 
 
Select the profile UCS_233.  Set up the Profile dialog as shown above and on the right. 
 
Click on Draw Cell At XY to place a profile cell. 
 
Click on OK to draw the profile. 
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(Step 14 continued) 
 
The forth XS cell (Station 14+36.88) is for the existing channel section. 
 
Select the profile CL-EX.  Since the pattern line was not created for the whole profile, limit 
the plot of profile to Stations 1291+75 to 1298+25 set the rest of the Profile dialog as shown 
below on the left. 
 

   
 
Click on Draw Cell At XY to place a profile cell. 
 
Click on OK to draw the profile. 
 
Repeat the process for the bottom XS cell (Station 13+41.50), which is for the downstream 
channel section. 
 
Select the profile DCS_98F.  Set up the Profile dialog as shown above and on the right. 
 
Click on Draw Cell At XY to place a profile cell. 
 
Click on OK to draw the profile. 
 
Close D&C Manager and save the changes to the MicroStation drawing. 
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14.1 Objectives 

• Learn how GEOPAK defines a roadway slope. 
• Learn to use GEOPAK Auto Shape Maker and Graphics Shape Maker to apply 

superelevation to a roadway. 

14.2 Definitions 

GEOPAK uses two tools to calculate superelevation transition locations for any chain stored in 
the coordinate geometry database.  One tool results in an ASCII file that lists the stations and 
slopes for each superelevation transition break.  Microstation shapes represent the roadway 
crown and depict the superelevation transition breaks.  GEOPAK Superelevation uses the 
following tools for shape creation. 

• Auto Shape Maker - is a tool used to create an input file for applying superelevation 
transition locations along a specified alignment.  Using this tool will result in an 
ASCII file that lists the stations and slopes for each superelevation transition break.  
This file is then processed to draw the shapes into the Microstation drawing. 

• Graphics Shape Maker permits interactive creation of superelevation shapes defined 
by graphic elements drawn in a Microstation file. 

14.2.1  Shapes 
Shapes are Microstation complex shapes that are placed into a design file to represent an area of 
pavement slope.  Non-transitional shapes have a constant slope for the entire length of the 
shape.  Transitional shapes have a different slope at each end of the shape, and will either 
linearly or parabolically interpolate between the slopes. 
 

Non-transitional Slopes

0%0%
Transitional Slopes

-1%2%

3%3%
2%
2%2%

2%
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14.2.2 Shape Clusters 
Four attributes are associated with each shape depending on the definition of the profile grade 
line.   
 
Baseline – roadway baseline 
 
Profile – roadway profile 
 
Tie – distance between the roadway baseline and roadway profile 
 

 

 
 
PGL-Chain – (optional) defines the location of the profile if the distance between the baseline 
and profile is not constant.  (If the distance is constant the tie distance can be used.) 
 
A group of shapes with the same shape attributes is called a “Shape Cluster”. 
 

tie = 30.0 

tie = -30.0 

baseline = Route50 
profile = Route50pr 

baseline = Route50 
profile = Route50pr

Shape Cluster with Tie = -30 

Shape Cluster with Tie = 30 
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14.2.3 Shape Class 
There are two classifications of shapes, Dependent and Independent, which determine how the 
pavement elevations are computed.  Dependent shape pavement elevations are determined 
directly from the profile.  Independent shape pavement elevations are determined from adjacent 
shapes. 
 
The figure below shows the dependent shape adjacent to the profile grade line (PGL).  Therefore, 
the elevation of the shape at point A will be the elevation of the profile at point A.  The elevation 
of the shape at point B will be calculated based on the width and slope of the dependent shape.  
This will be the starting elevation for the independent shape.  The elevation of point C will be 
calculated based on the width and slope of the independent shape. 

 
The figure below shows the independent and dependent shape reversed from the figure above.  In 
this case, the independent shape is located next to the PGL.  The starting elevation of the 
dependent shape, point B, is calculated based on the slope of the dependent shape and the 
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distance between the dependent shape and the profile.  The end of the dependent shape, point C, 
is calculated based on the width and slope of the dependent shape.  The end point of the 
independent shape, point B, is at the same elevation as the dependent shape at that point, and the 
beginning of the independent shape, point A, is calculated based on the width and the slope of 
the independent shape. 
 
It is good practice to use one dependent shape for each shape cluster. 

14.2.4 Shape Elements 
Shapes consist of a series of connected Microstation elements that form a closed surface.  The 
types of elements can be classified into two types, longitudinal edges, and filler lines. 
 
Longitudinal Edges - Typically, these consist of the roadway edges of pavement or lane lines. 
These lines do not represent slopes. 
 
Filler Lines - These lines represent the beginning and ending slopes of a pavement shape. Each 
of these lines always represents a slope value. 

14.3 Accessing 

The superelevation tools can be accessed from the cross section toolbox by choosing the 
Superelevation Shape Manager tool.  When selected, the superelevation toolbox will be 
displayed.  

 
The Automated Superelevation can also be accessed from Project Manager 
>> Calculate Superelevation, and the Shape Maker can also be accessed 
from Project Manager >> Superelevation Shapes.  

14.4 Dialog 

The superelevation toolbox is shown below. 

 

 
 

Shape 
Analyst 

Shape 
Properties

Shape 
Editor 

Automated 
Superelevation 

Autoshape 
Builder 

Shape 
Maker 

Shape 
Selector Shape 

Profiler 
Shape to 
DTM 
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14.4.1  Automated Superelevation 
The Automated Superelevation dialog is the dialog most commonly used to create 
superelevation.  It allows the user to specify the parameters needed for superelevation, and then 
creates an input file the user can modify according to the specific design for the project.  When 
the Automated Superelevation icon is chosen, the following dialog will appear. 
 

 
 
If project manager is used, the Job Number, Chain, and Begin and End stations will be filled in 
using the current Working Alignment.  The user can specify the design information as follows. 
 
Job – Job number of the .gpk file for the project. 
 
Chain – Baseline chain name for the project.  This may be the centerline of roadway for an 
undivided roadway, the centerline of median for a divided roadway, or the edge of pavement for 
a ramp. 
 
Begin – station to begin the shapes. 
 
End – station to end shapes. 
 
Design Speed - the design speed for the project that determines the rate of superelevation for 
curves. 

12/22/04 Missouri Department of Transportation 14-5 



Chapter 14 Superelevation 

 
Preference File – the file to use in calculating the superelevation 
rates and transition stations.  The user should choose the 
preference file according to the standard plan being used for 
superelevation calculations.  
 

i_divided_1side – imperial, divided roadway, using 
standard 203.21G, when calculating only 1 side of the 
median. 
 
i_undivided – imperial, undivided roadway, using standard 203.20E 
 
m_divided_1side – metric, divided roadway, using standard M203.21G, when 
calculating only 1 side of the median 
 
m_undivided – metric, undivided roadway, using standard M203.20E 
 

e Selection – the maximum superelevation value to be used for the 
alignment.  Select 8% max for rural projects and 4% max for urban 
projects. 
 
Facilitiy – set according to if the roadway is Undivided or Divided 
 
L Selection – this should be set to All Cases for all situations.  
 
Profile – choose the profile for the left and right sides.  For undivided roadways, the left and 
right profiles should be the same.  For divided roadways, the left and right profiles may or may 
not be the same. 
 
Tie/PGL Chain – set to either Tie or PGL Chain.  The tie distance is the 
distance between the baseline and the profile.   If this distance is variable, a 
PGL chain can be used to define the location of the profile.   
 
The % Slope, Offset, and Dependency field define the shape characteristics. 
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Shapes can be added by selecting the Add New Lane button .  Once the add button has been 
selected the following dialog appears 
 

 

Add New Lane 

Delete Lane 
Quick Entry 

Rectify Lanes 

 
To specify the % Slope, offsets, and dependency, double click in the % Slope, Offset and 
Dependent cells for each row and type in the desired value. Once listed, the shapes can be 
deleted , or modified by re-entering the values in the cells.  
 
% Slope – define as the normal slope for this section of roadway. 
 
Offset – define one Offset as the distance between the baseline and the inside edge of the shape, 
and the other as the distance between the baseline and the outside edge of the shape. 
 
Dependency – defines whether the shapes elevation is determined by the profile, or by the 
adjacent shapes.  Dependent shapes obtain the elevation from the profile and the slope of the 
shape as discussed in section 14.2.  Independent shapes obtain the elevation from adjacent 
shapes.  Check the toggle to set a Dependent shape or leave unchecked for an Independent 
shape. 
 
Create Input File – specifies the name 
o the shape input file to be created that 
creates the shape information.  This file needs to be run to plot the shapes into the Microstation 
drawing.   
 

 
The Quick Entry button  will bring up the Quick 
Entry dialog.  This dialog can be used to create 
shapes without calculating the required offsets for 
multiple lanes.  The user chooses the type of Facility 
as divided or undivided.  If divided is chosen, the 
Median Width can be specified.  The Lane Widths, 
Total Number of Lanes, and the Nominal Percent 
Slope are specified.  When the dialog has been 
completed, the OK button is pressed, and the number 

of lanes and their corresponding offsets are automatically entered into the shape cluster list 
boxes.  
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When the Automated Superelevation 
dialog has been completed, the user 
presses the Generate Superelevation 
Transitions button.  This will create the 
input file specified in the Create Input 
Field dialog.   

14.4.2  Superelevation Input File 
A Superelevation Input File with an .inp extension is created and placed in the project 
directory.  This input file shows where the location superelevation critical points by indicating 
the station and slope along the roadway.  This is an ASCII file that may be reviewed and/or 
edited.  A sample input file is provided below. 
 
/* Superelevation Settings and Parameters: 
Project Name:  T:\de-proj\Cole\j5p0100\project\j5p0100.prj 
User:          T:\de-proj\Cole\j5p0100\project\projdbs\ClsUser 
Run Name:      BigHorn 
Unit System is english. 
Created input file "shape_BigHorn.inp". 
Created activity log file "shape_BigHorn.log". 
Created on Tue, Oct 05, 2004 at 15:19. 
Using Preference File "i_undivided" 
Using e Selection of "8% max". 
Using Length Selection of "all cases" 
Using Design Speed of 30.000000. 
*/ 
 
auto shape 
job number = 100 
  
   auto shape set 
      shape cluster baseline   = BIGHORN 
      shape cluster profile    = BIGHORNPR 
      shape cluster tie        = 0.0000 
      dependent shape 
      chain  /  offset 
         BIGHORN    -12.0000 
         BIGHORN    0.0000 
      filler line station / slope 
             0+97.770000   -3.1250 
            21+52.700000   -3.1250 
  
   auto shape set 
      shape cluster baseline   = BIGHORN 
      shape cluster profile    = BIGHORNPR 
      shape cluster tie        = 0.0000 
      independent shape 
      chain  /  offset 
         BIGHORN    0.0000 
         BIGHORN    12.0000 
      filler line station / slope 
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             0+97.770000   -3.1250 
            21+52.700000   -3.1250 
   Plot Parameters 
      Dependent Shape 
         lvname = Geopak-Shapes 2 
         co = 2 
         lc = 0 
         wt = 2 
      Dependent Text 
      lvname = Geopak-Shapes 2 
      co = 2 
   Independent Shape 
      lvname = Geopak-Shapes 2 
      co = 7 
      lc = 0 
      wt = 2 
   Independent Text 
      lvname = Geopak-Shapes 2 
      co = 7 
  
Write shapes into dgn = T:\de-proj\Cole\j5p0100\data\BH_pattern_shape_j5p0100.dgn 
 
The input file is also opened into the Geopak text editor.  The input file can be edited in the text 
editor.  Once any changes have been made, and the input file has been saved, the text e
be used to process the input file by clicking on the Create Superelevation Shapes but
 

ditor can 
ton.   
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14.4.3   Superelevation Log File 
s created, the Superelevation Log File is also created.  
nformation pertaining to the creation of the input file.  A 

ROUTE50 in job 100. 

 3.8000. 

 initial calculation. 

. 

e. 

vation rate computed for each curve, the transition length for 
ach curve, and any transition conflicts between curves. 

r to the processing of the input file to 
heck for errors, and verify any transition conflict resolutions. 

 and edited, it needs to be processed to plot the shapes into 
The input file can be processed by using the Create 

When the Superelevation Input File i
The Superelevation Log File contains i
sample log file is shown below. 
 
Beginning calculation of superelevation for chain 
 
Computing superelevation rates . . . 

urve ROUTE50-1, radius 2864.7890:  Superelevation rate computes to beC
 
Computing transition lengths . . . 

ote: Because the roadway width consists of 4 lanes, N
      lengths are to be adjusted after
Curve ROUTE50-1:  Super rate of 3.8000 yields 
      unadjusted runoff length of 150.0000. 
      Transition Length adjusted to 150.0000 for 4 lanes
 
Checking for transition conflicts . . . 

o transition conflicts were found. N
 
Superelevation Calculation Complet

    Output written to file "shape.inp"   
 
The log file indicates the superele
e
 
The Superelevation Log File should be reviewed prio
c

14.4.4   Autoshape Builder 
After the input file has been created
the Microstation design file.  
Superelevation Shapes button in the text editor, or by using the Autoshape Builder.  The 
Autoshape Builder can be accessed from the Superelevation toolbox. The following 
dialog will appear.   
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ent of Transportation 14-11 

The user selects the Autoshape Input File to process and then press the Draw Superelevation 
Shapes button to process.  The shapes will be placed with the level symbology that was specified 
in the input file.  However, if the user desires to place the shapes with different level symbology, 
then the Override Input File Level Symbology to set the desired parameters.   The Display 
Only toggle can be turned on to temporarily plot the shapes into the Microstation design file.  
When the view is updated, the temporary graphics will be deleted. 
 

14.5 Shape Maker 

Not all superelevation transitions can be defin  GEOPAK provides the 
raphical Shape Maker for situations that involve left turn lanes, merging roadways and in 

Access Shape Maker from the GEOPAK Project Manager by selecting Superelevation 
Maker icon in the Superelevation toolbox.  The following 

arameters 

chain corresponding to the shape. 
 
Profile - profile controlling shape. 

ie - distance between the profile and the baseline. 

chain to define the profile location if the tie distance varies. 

ed by station and offset. 
G
some cases, widening. 
 
The user uses simple Microstation elements to depict the area to which superelevation is applied.  
Once the area is drawn, the Graphical Shape Maker dialog box allows the designer to define 
the roadway information to apply superelevation.  The Microstation elements are then identified 
and a complex shape representing the superelevation is created. 
 

Shapes or from the Shape 
dialog is displayed. 
    
 
 
 
 
 
 
 
 

 
 
 
 

P
 
Baseline - 

 
T
 
PGL Chain - 
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Class - dependent or independent, as previously discussed 

 determines linear or parabolic transition.  Use 0 for linear transition. 

sed for placing the shape. 

 to be used for plotting slope labels. 

ected shape utilizing the sequence of 

a data point cursor button. 
with the 
rs. 

Filler Lines 

entify filler line by issuing a data point (DP) on each end of the line 
 

 
ransition ID -T

 
ymbology - Microstation level symbology uS

 
lope Label – Sets level symbologyS

Identify Shape – Displays the parameters of the sel
operations listed below: 

1. Click Identify Shape. 
2. Identify and accept a previously defined shape with 
3. The Baseline, Profile, PGL Chain, Trans ID, and Tie parameters associated 

shape are displayed on the Shape Maker Window and become active paramete
 
 
 

 
Method: By DP - id

 
 

By Line - identify filler line by selecting a  Microstation line 
 

 
 

By Station - identify filler line by keying in station limits 
 

 
 

Transition: This option determines whether GEOPAK creates the shapes as a transitional or 
non-transitional shapes.  When the toggle is turned off, a non-transitional shape is 
drawn. When toggled on, a transitional shape is drawn using the slope specified in 
the Slope field. 

14-12 Missouri Department of Transportation 12/22/04 



Chapter 14 Superelevation 

 
ransitional - shape is in a superelevation transition 

Non-Transition - shape is not in a superelevation transition (full super or normal 
crown). 

 
Slope: Cross slope for the filler line at the beginning and end of the shape 

a

ic - GEOPAK uses all contiguous elements to create the shape. 

Tolerance:  U
m

na
The Shape Analyst is used to determine the slope of a shape at a particular point.  The elevation, 
profile elevation and d 

isplayed.  The elevation can be computed off the shape by using an Extrapolated Slope from 

elevation at the edge of each shape. 

T

 
Complete Sh pe: Manual - user identifies each element that makes up the shape. 

Semi-Automatic - user accepts or rejects elements that make up the 
shape. 
Automat

 
ser specified acceptable maximum gap between the MicroStation elements that 
ake up the shape. 

 

14.6 Additional Superelevation Tools 

14.6.1   Shape A lyst 

slope, cross slope, longitudinal slope, and flow slow are computed an
d
the edge of the shape.  The Cross Section option will display the slope of each shape, and the 

 

 
 

14.6.2 Shape Profiler 
The Shape Profiler is used to graphically draw the 
elevations and/or slope arrows into the design file for a 
specified element or shape.  COGO points can also be 
stored at the given locations. 
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14.6.3 Shape Editor 
The user can edit the plotted shapes by using the Shape Editor.  The Shape Editor allows the 
user to adjust the slope of the filler lines, or change the location of the filler lines.  The filler lines 
of the adjacent shapes are also adjusted as needed. 
 

 
 

14.6.4 Shape Selector 
The Shape Selector allows the user to select or 
highlight shapes based on various attributes of the 
shape.  The attributes include baseline, profile, tie, 
transition type, class, slope, etc.  
 

14.6.5 Shape Properties 
The properties of a shape can be edited using the Shape Properties tool.  With Shape 
Properties, a user can change the baseline, profile, tie, etc. of a shape. 
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14.6.6 Shape to DTM Surface 
The Shape to DTM Surface tool allows the user to 

e user 
as the option to calculate the Digital Terrrain Model 

(DTM) data file for the entire chain or for a specific 
station range. 
 
 
 
 
 
 
 

create a data file from the plotted shapes.  This data file 
can then be used to create a TIN model based on the 
elevations calculated from the plotted shapes.  Th
h
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Exercise 14-1 

This is a group exercise to create superelevation shapes to be used to determine the layout length 
of a superelevated curved bridge.  These shapes represent 3D surfaces. Sets of shapes are created 
to model (1) the bridge deck surface; (2) the surface of the road under the bridge; (3) the bridge 
fill slopes; and (4) a plan below the bridge to define the top limit of the fill slopes. 
 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj as user userc. 
 

    
 

3. Select the Route50 working alignment. 

 

4. Choose Calculate Superelevation from the Road Project dialog to calculate the pavement 
cross slopes. 

  
 

Copy the MoDOT run to Route50 and enter the run. 
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5. Create the Route50 shapes as  
follows and as depicted in the  
dialog to the right: 
 
Job: 100 
Design Speed: 60 
Chain: Route50 
Begin Station: 464+00 
Ending Station: 468+00 
Reference File: i_dvided 
Facility: Divided 
e Selection: 8% max 
L Selection: all cases 
Profile: ROUTE50PR 
Tie: Offset 
 
Click on the Quick Entry icon  
outlined in the dialog box to 
the right.  This will bring up the 
dialog shown below.  Fill it in as 
shown with the following: 
 
Facility: Divided 
Median Width: 60.00 
Lane Widths: 12.00 
Total Lanes: 4 
Normal % Slope: 2.00 
 

 
 
Click OK. 
 
Modify the % Slope to –2.0000 for offsets 42-54 on the Left (negative) and Right (positive) 
sides. 
 
Change the Input File to: shape_50.inp 
 
Click on Generate Superelevation Transitions. 
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6. Clicking on the Generate Superelevation Transitions button will generate the INP file, 
which is displayed in the following dialog box. 
 

 
 

7. Use UltraEdit or another text editor to view the log file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\j5p0100\data\shape_50.log. 

 

8. Run the input file shape_50.inp by clicking on the Create Superelevation Shapes icon  
in the GEOPAK Text Editor: shape_50.inp.  It is the icon shown to the right and it the 
last icon in the tool bar at the top of the dialog.  Save the MicroStation drawing after creating 
the shapes and close the GEOPAK Automated Superelevation dialog.  Click on Yes to 
Save Superelevation Settings? in the Alert dialog. 

 

9. Select the BigHorn working alignment. 
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10. Click on the Define button to review the BigHorn working alignment definitions.  Under the 
Shapes section, change the following symbology settings: 
 
Lv Names: Geopak-Shapes 2 
Colors: 2,7 
 
Using different symbology lets the user distinguish between the shapes for the two 
alignments. 
 
Close the working alignment definition box by clicking on OK. 

 
 

11. Select the Calculate Superelevation button from the Project Manager dialog.  Copy the 
MoDOT run to BigHorn, and enter the run.   
 
In the upper left corner of the Automated Superelevation  
dialog select File > Level Symbology, as shown to the right.   
This brings up the following dialog, which allows the user to 
set the symbology for the shapes to be drawn by the tool. 

 

 
 

The shape symbology needs to be changed to reflect the adjustments made to the Working 
Alignment Definition in the previous step.  To change the symbology of the Dependent 
Shapes, double click on the symbology preview area outlined in the above.  This brings up 
the GEOPAK Set Feature dialog. 
 
Change the Dependent Shape symbology to that shown below on the left.  Click OK to save 
the changes.  Change the Independent Shape symbology to that shown below on the right. 

 

   
 

 Dependent Shape Symbology Independent Shape Symbology 
 

Close the Superelevation Shape Level Symbology dialog by clicking on the  in the upper 
right corner. 
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12. Create the Big Horn shapes as  
follows:  
 

Job: 100  
Chain: BIGHORN 
Begin Station: 8+00 
Ending Station: 12+00 
Design Speed: 40 
Reference File: i_undvided 
Facility: Undivided 
e Selection: 8% max 
L Selection: all cases 
Profile: BIGHORNPR 
Tie: Offset 
 
Use the Quick Entry dialog to set the lane  
information to the following: 
 

Facility: Undivided 
Lane Widths: 16.00 
Total Lanes: 2 
Normal % Slope: -3.125 
 
Click OK to fill the Left and Right tabs of the  
main dialog.  The Left tab should now look like  
that shown below: 
 

  
 
Switch to the Right tab and turn off the Dependent option, which is outlined in the following 
dialog. 

  
 
Change the Input File to:  
shape_bh.inp, as shown to the  
right. 
 
Click on Generate Superelevation Transitions to create the input file. 
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13. Edit the filler lines for both auto shape sets so there is a constant cross slope of –3.125% for 
the full station range and make sure the second set to an independent shape, as depicted 
below.  Note: Because the profile grade line is at the center of the roadway, both shapes can 
get their elevations from the profile (the dependent condition).  Changing one of the shapes 
to independent, however, enables the user distinguish between the two shapes. 
 

  
 
After editing the input file, save the changes by clicking on the floppy disk icon.  
 

Create the shapes by clicking on the Create Superelevation Shapes icon.   
 
Exit the text editor. 
 
Exit the superelevation run and save the changes to it and the MicroStation file. 
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14. The fill slopes will also be shaped to determine the bridge length.  Since these shapes need to 
be associated with a profile, a location for the profile needs to be determined.  The toe of the 
slope is the most logical location.  From the cross section below, it can be determined that the 
toe of the slope is 0.15’ above the roadway profile with a constant offset of 24’ left and right. 

 
Go into Coordinate Geometry.  Select  
Element > Profile > Offset.  This  
will bring up the dialog box shown  
to the right. 
 
Enter the following information as  
shown in the top figure to the right: 
 
Source Profile: BIGHORNPR 
Target Profile: BH-ToeSlp 
Begin Station: 1+93.64 
End Station: 20+60.66 
Vertical Offset: 0.15 
 
Once this information is entered,  
click on the Add icon , which is 
the top icon on the right side of the  
dialog box.  This will add the station  
range and the offset to the list box as  
depicted in the bottom figure to the  
right.  To delete an item from the list  
box, highlight the line and click on  
the Delete icon , which is the  
middle icon on the right side of the  
dialog.  If changes need to be made  
to an item in the list box, highlight  
that line, edit information in the  
fields at the bottom of the dialog  
and click on the Edit icon . 
 
When the list box is complete, click on the Create Profile button.  This stores the target 
profile, as indicated by the following message in the MicroStation Status Bar in the lower left 
hand corner of the MicroStation window: “Profile BH_ToeSlp saved.  Store Profile 
commands saved in BH_ToeSlp100.icu.”  This file is stored in the working directory and may 
be viewed using UltraEdit or any other text editor. 
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15. Click on the Select button in Project Manager.  Copy the BigHorn working alignment to 
BH-Slope and enter the new working alignment. 
 
Click on the Define button and adjust the following definitions: 
In the Shapes section, change the Colors to 3. 
Under Profile View, change the Proposed Profile to BH-TOESLP.  Click OK. 
 
To facilitate the creation of the shapes using Shape Maker, set Scratch-1 as the active level, 
use Level Display to turn off levels GEOPAK-Pattern line 1 and GEOPAK-Shapes 1, 
and turn off the display for any referenced files.  All that should be visible after doing this 
are the shapes for Big Horn Dr. 
 
Choose Plan View Design from Project Manager.  This will bring up  
the toolbox shown to the right.  Select Draw Transition, which is the  
third tool in the toolbox. 
 
Use Draw Transition to draw the following lines  
to serve as longitudinal lines for shapes: 
 
 Beginning Beginning Ending Ending 
 Station Offset Station Offset 
 7+90 24 12+10 24 
 7+90 -24 12+10 -24 
 7+90 -70 12+10 -70 
 7+90 70 12+10 70 
 
Close the Draw Transition and the Plan View Design dialog boxes after the four lines are 
drawn. 

 

16. Click on Superelevation  
Shapes in Project Manager.   
 
Fill in the dialog so it is like  
the one to the right.  Once this is  
completed, click on the Create  
button.  This will draw a filler line  
at station 8+00. 
 
Change the Station to 12+00 and  
click the Create button a second  
time to draw the other filler line at  
Station 12+00.   
  
Click on the Draw button and data  
point inside the closed in area on  
the right side of Big Horn Drive.   
Note: On the screen it is actually to the left of the existing shapes. 
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17. Repeat the process on the left side  
of Big Horn, which is to the right  
of the existing shapes on the screen.  
 
Change the Tie to –24.00, set the  
Station to 8+00 and click on the  
Create button to draw the first  
filler line. 
 
Change the Station to 12+00 as  
shown to the right and click on the  
Create button to draw the second  
filler line. 
 
Click on the Draw button and data  
point inside the closed in area on  
the left side of Big Horn Drive.   
Note: On the screen it is actually to the right of the existing shapes.  Exit Shape Maker. 
 
Refresh the view.  Turn on GEOPAK-Shapes 1 and save the changes to the DGN file.   

 

18. A profile for Route 50 is needed to define the maximum height of the fill slopes.  This profile 
is based upon the minimum clearance of 1’ from the top of the end bent beam to the top of 
the fill slope (LRFD 3.77.3.3-1, Effective Jan. 2005).  Since Big Horn Dr is 39’ wide, Type 
30 P/S Concrete Double Tee Girders will be used (based on BM 3.56.1.6-1, Effective Nov. 
2000, as shown on the following page).  From the figure below (LRFD 3.56.2.1-1, Effective 
Jan. 2005), the web depth is 30”.  Allowing ¼” for the bearing pads, ¼” for camber, and 8 
½” for the deck, gives a total depth of 39” (30 + ¼ + ¼ + 8 ½) = 3.25’.  Adding the 1’ 
clearance results in the maximum height of the fill slope at 4.25’ below the top of the deck. 

   
Using Offset Profile, create profile 50-PR-SLP 4.25’ below Route50PR. 
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Big Horn Dr. 
Width = 39’
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19. The profile 50-PR-SLP will be used for shapes that represent the maximum height surface 
for the bridge fill slope.  These will be added to pattern_shape_j5p0100.dgn by editing and 
running an existing INP file. 

 
Open shape_50.inp in 
UltraEdit.  Highlight the shape 
cluster profile ROUTE50PR.  
Go to the UltraEdit pull down 
menu Search > Replace, to 
bring up the dialog to the left. 
 
Enter 50-PR-SLP in the 
Replace With: field as shown.  
Click on the Replace All button 
to change the name of the 
profile in the file.   

 
Go to the 2nd and 4th auto shape sets and change the offset range to the values shown below 
(the value to be changed is shown in bold): 

 
  Changes to 2nd auto shape set  Change to 4th auto shape set 
    chain  /  offset    chain  /  offset 
       ROUTE50    -42.0000       ROUTE50     42.0000 
       ROUTE50    -64.0000       ROUTE50     64.0000 

 
Scroll down to the Plot Parameters section of the input file and change level (lv) and color 
(co) symbology to the values shown below in bold. 

 
    Plot Parameters 
       Dependent Shape 
          lvname = Geopak-Shapes 3 
          co = 8 
          lc = 0 
          wt = 2 
       Dependent Text 
          lvname = Geopak-Shapes 3 
          co = 8 
       Independent Shape 
          lvname = Geopak-Shapes 3 
          co = 4 
          lc = 0 
          wt = 2 
       Independent Text 
          lvname = Geopak-Shapes 3 
          co = 4 
 
Save the file as shape_50_slp.inp.  This input file will be run later. 
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Exercise 14-2 

This is a group exercise to demonstrate the use of the GEOPAK superelevation tools to help 
determine end locations.  Specifically, the tools will be used to find elevations from two shapes 
to locate where they intersect. 
 
This exercise is based on the following design information:  End of wing to end of wing length is 
controlled by the intersection of the spill slopes with the outside edges of the bridge deck.  End 
bent locations are controlled by the requirement to maintain a minimum clearance of 1’ from the 
top of the end bent beam to the top of the spill slope.  This clearance needs to be checked at the 
outside face of the exterior girders unless the crest of a vertical curve for the lower roadway is 
located directly beneath the bridge.  The location of the checks for this exercise was obtained 
from the cross section of the slab from Bridge Manual page 3.56.2.5-1 shown on the following 
page. 
 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj as user userc and 
enter Road. 

 

    
 

3. Select the Route50 working alignment.  
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4. Determine Critical Offsets:  Away from the bridge, the roadbed width is 40’ (6’ left 
shoulder, + two 12’ lanes + 10’ right shoulder).  Centering the structure on the roadbed 
places the centerline of structure two feet to the right of the centerline of the two driving 
lanes, which is 42’ to the right of the highway’s horizontal alignment.  Consequently the 
centerline of structure is 44’ (42’ + 2’) to the right of the alignment.  Offsets for the bridge 
gutterlines are 24’-7” (44’ - 19’-5”) and 63’-5” (44’ + 19’-5”).  Adding the 16” barrier, the 
offsets for the bridge deck edges are 23.25’ & 64.75’.  These are the offset values that will 
be use to locate the intersect point of the spill slope with the bridge deck. 
 
The figure from the Bridge Manual on the previous page show the horizontal width of the 
flanges on the interior double-tees as 6’-11 ¼”.  Because the bridge is curved, this value will 
be increased to 6’-11 3/8” to reduce the maximum exterior overhang on the outside edge of 
the curve. 
 
Also, because the deck is curved to the left, its edge will come in towards the girders at 
center span by about 1 ½” on the left side and move away from the girder on the right side by 
about the same amount.  To account for that, the deck will be shifted to the right by 1 ½”.  
The following figure from BM page 3.56.1.6-10 shows that for a 38’-10” roadway and Type 
30 girder, the normal overhang from the centerline of the exterior girder is 13”.  This will be 
increased to 14 ½” (13” + 1 ½”) on the left and reduced to 11 ½” (13” - 1 ½”) on the right 
side at the end of each span.  With the 3” full depth cast in place slab overhang on the outside 
of the girder flange and with the 6” wide web, the exterior faces of the girders at the end bent 
will also be about 14 ½” from the edge of the slab on the left and 11 ½” from the edge of the 
slab on the right side of the deck at the end bents.   
 

 
 

Because the four interior girders have been widened by 1/8”, the overhangs will be reduced 
by ¼” (2 girders per half section x 1/8”).  Consequently, the horizontal offsets from the 
alignment for the exterior girder faces are 23.25’ + 14 ¼” (1.1875’) = 24.4375’ on the left 
side and 64.75’ – 11 ¼” (0.9375’) = 63.8125’ on the right side.  These will be plotted to 
locate the top of the spill slopes at the ends of the bridge. 
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5. The location of the critical offsets are shown on the follow cross section of the bridge away 
from a bent.  Because the slope of the roadway under the bridge is less than that of the 
bridges super elevation, exterior face of the right most girder will control the location of the 
end bents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The first set is to determine the change in elevation along the bridge deck from the profile 
grade line to the critical offset.  This change in elevation is based on the 5% superelevation 
on the bridge plus the offset distance from the profile grade line to the critical point.  Based 
on the above figure this change in elevation is: 
 
  0.05 * (63.8125’ - 30’) = 0.05 * (33.8125’) = 1.690625. 
 
The 4.25’ distance from the top of deck to the top of the fill slope must be subtracted from 
this value.  Thus the total vertical offset from the Route 50 proposed profile to profile for the 
top of the fill slope at the exterior face of the right most girder is: 
 

    1.690625 – 4.25 = -2.559375. 
 
Based on this information, create the needed profile.  To do this, go into Coordinate 
Geometry for Job 100 with Operator Code cu.  Use the Element > Profile > Offset tool with 
the following settings: 
 
Source Profile = Route50PR  
 
Target Profile = EB-RT-SLP 
 
Begin Station = Route50PR 
  beginning 
  station 
 
End Station =  Route50PR  
  ending station 
 
Vertical Offset = -2.559375 

 

5.00 %

Right Edge of 
Bridge Deck 
64.75’ 

Exterior Face of 
Left Most Girder 
24.4375’ 

Exterior Face of
Right Most Girder

63.8125’

Profile Grade 
Line 30.00’ 

Left Edge of 
Bridge Deck 
23.25’ 

Centerline
East Bound
Lane 42.00’

Centerline  
of Structure 
44.00’
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6.  Several tools from the Superelevation Shape Manager will be used to  
  obtain elevation information from the shapes.  The icon for the manager  
(shown above) is the forth icon from the right in the Cross Sections toolbox,  
which is located in the lower left hand corner of the Road Tools as shown in the  
figure to the right.  The expanded Cross Sections toolbox is shown below. 
 

  
 
Bring up the Superelevation Shape Manager Tools shown below. 
 

  
 

 
The tools in this pallet are: 

 Automated Superelevation,   Autoshape Builder,  Shape Maker, 

 Shape Analyst,   Shape Profiler,  Shape Editor, 

 Shape Selector, and  Shape Properties.  Shape to DTM 
 
Open the Autoshape Builder, shown below.  Click on the Magnify Glass icon and select 
shape_50_slp.inp.  Press the Draw Superelevation Shapes button to run the input file. 

 

  
 
Turn off level GEOPAK-Shapes 1. 
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7. In order to find the needed elevations,  
plot the outside face of the right exterior  
girder.  Elevations from the shapes will  
be obtained at set intervals along this  
line. 
 
To do this, open Design and  
Computation Manager. 
 
Expand the Design Standards folder. 
 
Open Safety and Structures subfolder  
as well. 
 
Select Bridge from the list of items  
in that folder, as shown in the figure to  
the right. 
 
Since a Design Standard is being plotted,  
make sure Place Influence is checked  
in the Operations box as shown in the  
following figure. 
 

 
 

8. Use the Draw Transition tool (the third icon in the Plan View Design tool box) to draw the  
following line relative to the Route 50 chain: 
 
  Beginning   Ending  
 Station  Offset Station  Offset 
 464+00  63.8125 468+00  63.8125 
 
The values for drawing the line are shown in the  
figure to the right.  
 
After drawing the drawing the line, close the  
D & C Manager and Draw Transition dialogs. 
 
Save the changes to the MicroStation Drawing. 
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9. Open the Shape Profiler tool.  This will bring  
up the top dialog to the right.   
 
Go to User > Preferences in Shape Profiler  
to customize the profilers output as shown in  
the bottom figure on the right.  Double click  
on the Elevation Symbology preview.  This  
brings up the GEOPAK Set Feature dialog  
shown below.  Set the Symbology, Text, and  
Justification to those options shown.  Click  
OK to accept the Set Feature settings. 
 

 
 
Click OK in the User Preferences Dialog. 
 
In Shape Profiler, click on Identify Shape and data  
point on the shape for the driving lane of eastbound  
Route 50 where it crosses Bighorn Dr.  This will fill  
in the Chain and Station fields for the shape.  Change  
the From Station to 465+50.00 and the To Station  
to 467+05.00.  Click on the Identify Element button,  
data point on the line defining the outside edge of  
the right exterior girder, and data point to accept.   
The end result is depicted in the figure below, which  
gives the elevations along the girder edge one foot below the top of the end bent beam. 
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10. To determine the elevations on the fill slopes, use Level Manager to turn off levels 
GEOPAK-Shapes 3 so only the shapes for Big Horn Dr. are visible.  

Select the Shape Analyst tool by clicking on the following icon in the Shape Manager .  
This will bring up the dialog on the  
right.  Select the BIGHORN chain. 
 
Go to User > Preferences. Change  
the Elevation Symbology settings to  
those shown below.   
 

 
 
Click OK in both Set Feature and  
User Preferences. 
 
Set the tentative snap to key point.   
 
Click on the DP button in Shape Analyst.  Tentative snap on the text giving the elevation at 
Station 465+70 (773.9478) and accept the snap, this will plot the fill slope elevation at that 
location.  Repeat the process for the next three values plotted by the profiler.  The end result 
is shown above.  Note: To snap to the text more easily turn off the Fill View Attribute. 

 

11. Move to other end of the bridge and plot the slope elevations at that end of the bridge, as 
shown in the following figure. 

 

 
 

Turn on the display for level GEOPAK-Shapes 3. 
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12. Window in on the SW corner between Station 465+70 and 465+80, as was  
done to create the figure on the right.  The plotted elevations indicate that  
the projection of the fill slope goes above its maximum allowable height  
under the bridge deck in this station range.  While linear interpolation could  
be used to establish a crossing point, greater accuracy can be accomplished  
by using the shapes.  To do this, elevation information will be obtained from  
the shapes at 1’ increments. 

 
Switch to Shape Profiler and adjust the User > 
Preferences Elevation Symbology settings to those 
shown to the left.  The change in text size is being done 
to distinguish the foot from the 10’ increment values. 

 
 
 
 
 
 
 
 
 
 
 
Based on the elevations given, the crossing  
point is between Route 50 Sta. 465+70 and  
465+80; therefore, use Shape Profiler to plot  
elevations relative to Route 50 at Sta. 465+71  
to 465+78 at 1’ increments.  Use the following  
settings as shown in the top figure to the right: 
 
 Chain: ROUTE50 
 From Station: 465+70.50 
 To Station: 465+78.50 
 Increment: Even 1 
 
Do the same thing at the other end of the  
bridge between Route 50 Sta. 466+80 and  
466+90.  Use the following settings: 
 
 Chain: ROUTE50 
 From Station: 466+80.50 
 To Station: 466+87.50 
 Increment: Even 1 
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13. To obtain the elevations on the fill slopes, use Level Manager to turn off level GEOPAK-
Shapes 3 so only the shapes for Big Horn Dr. are visible.  

Select Shape Analyst by clicking on its icon in the Shape Manager tools .  Select the 
BIGHORN chain.  

 
Go to User > Preferences and change the Elevation  
Symbology settings to those shown to the right.  Click  
OK in both the Set Feature and User Preferences  
dialogs to accept the changes. 
 
Make sure your snap is set to key point.  Click on the  
DP button in Shape Analyst.  Tentative snap on the text  
plotted in the previous step.  This will plot the fill slope  
elevation at that location.  Note: It may help to turn of the  
Fill View Attribute (MicroStation menu Settings > View  
Attributes) to make it easier to snap to the text. 
 
Screen captures from each corner of the bridge are shown  
below.   

 

   
 SW Corner of Bridge SE Corner of the Bridge 

 
Compare your elevations to those given below. 
   Deck Elev. 
 Location Station Minus 4.25’ Slope Elevation 
 SW Corner 465+76 773.9913 774.3402 
 SW Corner 465+77 773.9984 773.8438 
 

 SE Corner 466+85 774.4242 774.0255 
 SE Corner 466+86 774.4250 774.5334 
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Exercise 14-3 

This group exercise uses the GEOPAK profile tools to plot proposed fill slopes under the bridge 
as they pass under the right exterior girder.  Data from Exercise 14-2 provides the information 
needed to accomplish this task.  Once the fill slopes have been plotted, they can be used to 
determine the minimum from front face to front face of the end bents.  These will be the 
horizontal lengths as measured along the alignment for Route 50. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\profile_j5p0100.dgn.  
 
Do a MicroStation fit-view.  At the top of the drawing are three diagonal lines.  Adjust the 
MicroStation window so you are zoomed in on the right most diagonal line and the text 
above it and to the right.  This area will be used to plot the right edge of the bridge.   

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 

 

3. To keep track of the information for the left edge of the bridge, copy the Route50 working 
alignment to EB-BR-RT and enter that working alignment. 

 
Make the following changes in the Profile View section of the Working Alignment 
Definition: 
 
 Proposed Profile: EB-RT- SLP 
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 Adjust the values in the Location section of the Working Alignment Definition to those 
shown in the following figure: 

 
Horizontal Scale: 10 
Vertical Scale: 10 
DP Station: 465+00 
DP Elevation: 700 

 

 
 

Click on the By DP button and snap to the upper end of the diagonal line and accept.  This 
will set the DP X and DP Y values to those shown above. 
 
Place the profile cell by clicking on the Draw Cell at X,Y button.  The active MicroStation 
text setting controls size of the text in the cell. 
 
Save the changes to the working alignment definition by selecting the OK button. 

 

4.   Open Design and Computation Manager (D&C) from Road Tools using the icon  
 shown to the left.  It will be used to plot the profiles for the left edge of the bridge.  The 
first one to be plotted is EB-RT-SPL, which defines the maximum height of the fill slope. 

 
Navigate to: 
Drafting Standards\Profile\Existing Ground Profiles\1”=10’ Existing Ground Profile. 

 
Click on Draw Plan & Profile in the Operations box shown below. 
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 Change the label scale to 10 as depicted 
to the right and click on R OUTE50EX in  
the Select Profile list.  This will bring up  
the dialog shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the following values: 
  Begin Station: 465+00 

Ending Station: 468+00 
 

Click on the Identify Cell button, data point on profile cell plotted in the previous step, and 
data point to accept. 
 
Select OK to plot the profile.  
 

  In D&C Manager, double-click on:  
  Proposed Ground Profiles\10 Scale Proposed Ground Profile 1”=10’’ H & 1”=10’ V. 
This will update GEOPAK Plan & Profile Draw to the defaults for proposed profiles. 
 
Select EB-RT-SLP from the Select Profile list. 
 
The settings should be the same as shown above in the figure on the left except for the name 
of the profile at the top of the dialog and the profile information.  Select the OK button to 
plot the EB-RT-SLP profile as the propose profile. 
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5. In the main D & C dialog, switch to: 
 Design Standards \ Cross Sections \ Proposed Surfaces \ Ground (Proposed). 
 
Make sure Place Influence is turned checked.  This will set the MicroStation symbology to 
those for fill slope under the bridge.  Keep D & C open. 
 
Go into Vertical Alignment from the Road Project Dialog, which will bring up the Settings 
dialog box shown below. 
 

  
 
Everything should be set from the Working Alignment Definition.  If your settings do not 
match those shown above, click on the Identify Cell button in the dialog, data point on the 
profile cell for the EB-LT profiles.  Click the OK button.  This will bring up the Profile 
Generator dialog box: 
 

 
 
Go to Tools >> Issue Data Point as shown above. 
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6. Use the Issue Data Point to plot the fill slopes.  To do this, active the MicroStation Place 
Line tool.  Enter the following values into the Issue Data Point dialog as shown below: 
  Station: 465+76 Elevation: 774.3402. 

 

 
 

Click the Issue DP button to begin a fill slope line. 
 

Issue data points for the following values to draw the rest of the line: 
 

 Station Elevation 
 465+77.00 773.8438 
 465+80.00 772.3540 
 465+90.00 767.3560 
 466+00.00 762.4142 
 466+07.44 758.7149 
 
Do a MicroStation reset to end the line.  Draw a second line for the other fill slope using the 
following values: 
 

 Station Elevation 
 466+55.20 758.9035 
 466+60.00 761.3367 
 466+70.00 766.4102 
 466+80.00 771.4865 
 466+85.00 774.0253 
 466+86.00 774.5334 

 
Close D & C Manager and Profile Generator. 

 

7. The lines plotted in the previous step are shown below.  The point of interest is where the 
solid fill slope line crosses the line parallel to the proposed alignment. 

 
 Beginning of Bridge End of Bridge 
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8. Use the Profile Labeler to find the station and elevation where the fill lines and EB-RT- SLP  
cross.  Profile Labeler is the fifth tool in the Plans Preparation toolbox shown below. 
 

   
 
Go to the Styles tab in Profile Labeler.  Open the Points folder and double click on the 
Sta/Elev .18 style in the Item Selector as shown in the following figure. 
 

 
Go to the Scale >> Change Scale pull down menu and make sure the Scale Style is set to 10. 
 
Switch to the Text tab and select the Data Point Location button indicated in the dialog box 
depicted below.  If the Data Point Location icon is not there, click on Profile Settings and 
click OK in the dialog box that appears.  Snap to the intersection of the fill-slope line with 
the plotted profile and accept the snap. 
 

 
Click on the Place Label button and place the label. 
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9. Compare your intersection points to the values given below. 
 
 Location Station Elevation 
 Bent 1 465+76.69 774.00 
 Bent 4 466+85.79 774.42 
 
These station values can be used to determine the minimum distance from front face of end 
bent to front face of end bent along the right exterior girder.  Remember, however, that the 
stationing is measured along the chain, which is at the centerline of median.  This needs to be 
kept in mind when determining the actual bridge length. 
 
Save changes to the MicroStation drawing. 
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Exercise 14-4 

With the information from the previous two exercises, it is possible to layout the eastbound 
bridge.  This group exercise will use COGO to store and plot needed locations. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_50_j5p0100.dgn.  
Attach as a reference t:\br-proj\a_geopak_\d5\j5p0100\data\plan_bh_j5p0100.dgn.  
Window in on the intersection of the two alignments so Route 50 stations 465+00 to 468+00 
are visible. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
 
 
Switch the Working Alignment to Route50. 

 

3. Enter Coordinate Geometry. 
 
Go to Tools > Locate > On Element to bring up the  
dialog shown to the right.  It is used to store a point on  
a curve, a spiral, or a chain.  Choose the On Chain  
option.  The Station option will be used to store points  
on chain ROUTE50. 
 
Store the points listed in the table below.  They are  
based on information obtained in Exercise 14-2 and  
locate where the fill slope intersects the profile  
EB-RT-SLP, which determines the minimum distance  
from the front face one end bent to the front face of the  
other end bent.  The stationing is for Route 50.  The  
dialog box for storing the first point is shown to the  
right. 

 
Location Pt. Name Station Offset 
Bent 1 Front Face EBRT1 465+76.69 63.8125 
Bent 4 Front Face EBRT4 466+85.79 63.8125 
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4. The location of the bents is based on layout lengths along the centerline of the eastbound 
lane.  Storing a chain at this location will ease the calculation of lengths along this line.  
Since this line is located 42’ to the right of chain ROUTE50, the store chain from offset 
chain command will be used.  The dialog for this command is located in the COGO menu 
Element > Chain > Store > Offset Chain and is depicted below. 

 

 
 

Fill out the top of the dialog box as shown, select ROUTE50 as the Reference Chain, and 
press Store Chain.   

 

5. The skew of the bents is based on a radial line to Route 50 running through the intersection 
of the Route50 and BigHorn alignments so that the bents are roughly parallel to Big Horn Dr.  
Determine the angle between this radial line and Big Horn Dr. where it crosses Route 50 
chain by using the angle command: 
 
  ANGLE pa pb pi-pk, 
 
where the point numbers are used as defined in the figure  
and referenced to the job as follows: 
 
 pa  = PT BIGHORN-1  
 pb  = 10 (Point at alignment intersection) 
 pi  = CC ROUTE50-1 
 
Key in the COGO command: ANGLE PT BIGHORN-1 10 CC ROUTE50-1 
 
The returned value is rounded to a right advance skew of 10° 49’. 
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6. Store two points (SK1 and SK2) to define the direction of the bents from left to right. 
 
Locate point SK2 at the intersection of the BIGHORN and EBL chains (Tools > 
Intersect). 
 
Locate point SK1 200’ from SK2 on a direction 10° 49’ to the left of a line from SK2 to 
the center of curve Route50-1 (Tools > Locate > Traverse).  The dialog box is shown 
below: 

  
 
The circled field in the dialog to show all of the text for the field.  Use the value in the text 
box to the right of the dialog for that filed.  After filling in the information click on Locate to 
store the point. 

 

CC ROUTE50-1

7. Determine the minimum distance between centerlines of bearing at the end bents and point 
SK2 as measured along the centerline of the eastbound lane. 
 
To locate the points, use the intersect tool (Tools > Intersect) to project points EBRT1 and 
EBRT4 onto chain EBL using the direction from SK2 to SK1 with an offset of 15” (1.25’), 
which is one half of the with of the end bent beams.  Call the new points BT1 and BT4.  The 
COGO Key-in commands are: 
 
 LOCATE BT1 INTERSECT LINE EBRT1 SK2 TO SK1 OFF -1.2500 CHA EBL 
 
 LOCATE BT4 INTERSECT LINE EBRT4 SK2 TO SK1 OFF 1.2500 CHA EBL 
 
The dialogs for storing these points are shown on the following page. 
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7. (Continued) 
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7. (Continued) 
To measure the distance along the EBL chain for the points BT1, SK2, and BT4, us the 
inverse command (Tools > Inverse), as shown in the following dialog.  Be sure to toggle on 
Distance Along Chain and enter chain EBL. 

 

 
 

The COGO output is: 
 

Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT1    1,700,122.1665   999,252.1784    465+71.97  1   0.0000 
                                                               57.2216 
SK2    1,700,179.1964   999,247.5093    466+29.19  1   0.0000 
                                                               56.8846 
BT4    1,700,235.9706   999,243.9813    466+89.07  1   0.0000 
 
Consequently, the distance as measure along the centerline of the east bound lane between 
the centerline of Bent 1 and SK2 must be at least 57.23’, 56.89’ between SK2 and the 
centerline of the last bent, and 114.1’ for the whole bridge. 

 

8. Calculate the overall Design Layout Length for the bridge.   
 
Based on BM 3.55.3.1-3 (shown below), overall layout length for the bridge is: 

Σ (CL Bent to CL Bent) + 2 * (Be + 3 ½”). 
 

 
 

For this bridge Be = 5 ½” and Be + 3 ½” = 9” = 0.75’.  Thus, the minimum layout length: 
 

 for the whole bridge = 114.1’ + 2 (0.75’ = 114.1’ + 1.5’ = 115.6’ Use 116’ 
 from Bent 1 to SK2 = 57.23’ + (5 ½ + 3 ½)” = 57.23’ + (0.75’) = 57.98’ Use 58.0 
 from SK2 to Bent 4 = 56.89’ + (9)” = 56.89’ + 0.75’ = 57.64’ Use 58.0 
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9. Determine the layout length for each span. 
 
According LRFD 2.4.1.2-1, the minimum clearance between the front of the curb (offset of 
18.5’) and Bents 2 and 3 needs to be 2.0’.  Assuming a maximum bent width of 3.5’, the 
offset for the centerlines of Bents 2 and 3 from the BigHorn chain needs to be at least 18.5’ + 
2.0’ + 3.5’/2 = 22.25’.  Use the intersect tool to store point BT2 at the intersection of chain 
EBL & chain BigHorn offset 22.25’ to the right and store point BT3 at the intersection 
of chain EBL & chain BigHorn offset 22.25’ to the left.  The dialog settings for storing the 
two points are shown below. 
 

      
 
Use the Inverse command to find the distance along chain EBL for points BT2, SK2, 
and BT3.  The results are: 
 
Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT2    1,700,156.6040   999,249.2238    466+06.53  1   0.0000 
                                                               22.6575 
SK2    1,700,179.1964   999,247.5093    466+29.19  1   0.0000 
                                                               22.6243 
BT3    1,700,201.7685   999,245.9731    466+51.81  1   0.0000 
 
Rounding these values up to the nearest 0.5’, use the following layout lengths: Span 1-2 = 
35.0’ (58.0 – 23.0’), Span 2-3 = 46.0’ (23.0’ + 23.0’), and Span 3-4 = 35.0’ (58.0’ – 23.0’). 
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10. Determine the bridge’s tie station, which will be at Bent 2. 
 
Use Tools > Locate > Point on Curve to relocate point  
BT2 at the centerline of Bent 2 where it crosses chain  
EBL using one half of the length of span 2-3 from SK2.   
The dialog is shown to the right. 
 
Use the Inverse tool to find the station and offset of  
point BT2 relative to chain Route50.  Since the inverse  
tool requires more than one point, some dummy points are  
included in the following dialog:  

  
Base on the COGO 
output information 
shown below and 
rounding to the 
nearest tenth, the tie 
station is 466+04.6. 

 
Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT2    1,700,156.2625   999,249.2511    466+04.65  1   42.0000 
 
Use Tools > Location > On Element to restore point BT2 at chain Route50 station 
466+04.6 and a 42’ offset.  The dialog with the proper settings is:  
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11. The intersection of the centerlines of the other bents with the centerline of the EBL can be 
located based on point BT2 and the span layout lengths.   
 
Use Tools > Locate > Point on Curve to relocate points,  
BT1, BT3, and BT4 where the centerline for each bent  
crosses curve EBL1.  The distances along the curve are  
given in the following table.  The dialog for storing point  
BT1 is shown to the right. 

 
Point Dist. along EBL1 from tie Direction 
BT1 35’ - 0.75’ = 34.25’  + (clockwise) 
BT3 46.0’  - (counterclockwise) 
BT4 46’ + 35’ - 0.75’ = 80.25’  - (counterclockwise) 

 

12.  Check the location of Bents 1 and 4.  To do this, store two points where the front face of 
each end bent crosses the outside 
face of the right exterior girders 
(Route 50 offset 63.8125’, as 
determined in exercise 14-2) and 
compare the points to EBRT1 
and EBRT4.  Call the new points 
FACEBT1 and FACEBT4. 
 
Use Tools > Intersect to store 
the two points.  The dialog for 
storing FACEBT1 is shown to 
the left.  (Note:  The 1.25’ offset 
accounts for ½ of the beam 
width.) 
 
Use Tools > Inverse to measure 
the distance along chain Route50 
for the following list of points:  
FACEBT1 EBRT1 EBRT4 
FACEBT4.  If the station values 
relative to Route 50 are all 
increasing, the location of the 
end bents is okay. 
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15.1 Objectives 

• Use Project Manager to create proposed cross-sections using the Typical Section 
Generator Tool. 

• Understand what criteria files are and how Geopak Typical Section Generator uses 
them to define side slope conditions for proposed cross-sections 

• Become familiar with MoDOT’s Typical Section Generator. 
 

15.2 Accessing 

Proposed cross-sections can be accessed from Project Manager >> Proposed Cross Sections.  
IMPORTANT NOTE: If the default MoDOT run is older than 06/08/2004 it needs to be replaced  

15.3 Dialog 

When the Proposed Cross Sections button in the Road Project Manager is pressed, the Select 
Run dialog is displayed.  An existing run may be selected or new run may be started.  When 
complete, press the OK button, which will close the Select Run dialog and open the proposed 
cross sections dialog as depicted below.  
 

 
 
The left side of the dialog contains the list of parameters required to process proposed cross 
sections.  When each parameter is selected, the dialog changes to reflect the requirement of each 
parameter.  For example, when Plot Parameters is selected, the dialog changes to reflect the 
various plot parameters and text as depicted on the next page.  
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15.3.1   XS DGN File 
XS DGN File controls the Microstation file in which the original ground cross-sections are 
located.  The proposed cross section elements will be placed into this file. 
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15.3.2 Pattern 
When Pattern is selected, the dialog changes to the illustration below.  This section contains 
information on how to find the pattern lines used to create the original ground cross-sections. 
 

 
 
Three dialogs (Pattern, Existing Ground, and Shapes) support a toggle to Use Working 
Alignment Definition.  For example, in the Pattern dialog above, the toggle is not active; 
therefore the user must supply all pattern information.  However, if the toggle is active when one 
of these three dialogs is invoked, the data information part of the dialog is ghosted and the 
required information is utilized from the current working alignment.  If the toggle is activated, 
and the required information is not stored within the current working alignment, an Alert 
message is displayed.  It is recommended to use the working alignment definition when this 
toggle is available. 
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15.3.3 Existing Ground 
Existing Ground section contains information to identify the symbology of the existing ground 
cross-sections.  The user toggles on the Search Criteria options needed to identify the existing 
ground, then selects the values for those options.  The Use Working Alignment Definition 
toggle is also available. 

 
 

15.3.4 Shapes 
When the Shapes parameter is selected, the dialog is displayed as depicted below. 
 

 
 
Three options are supported as depicted in the exploded view: 

• All in DGN - All shapes within the specified file are utilized. 
• By Search Criteria - Only those shapes that match the specified search parameters 

are utilized. 
• Shapeless - No shapes are utilized. In this option, there is no field for a shapes file 

name or files button. 
 
The Use Working Alignment toggle is also available. 
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15.3.5 Shape Clusters 
When the Shape Clusters parameter is selected, the dialog dynamically changes as depicted 
below. 
 

 
 
The user may Add, Delete, or Modify any specified shape clusters.  When the Scan button is 
pressed, Geopak scans the design file and uses the search criteria specified in the Shapes dialog 
to lists all matching shape clusters.  In the case of shapeless criteria, the user must define the 
cluster by typing in the Chain, Tie/PGL and Prof, then pressing the Add button. 

15.3.5.1 SIDE SLOPE CONDITIONS 
The Side Slope Conditions define what happens for each side of the shape cluster, and/or within 
a specified station range on the specified side of the shape cluster.  The side slope conditions can 
be defined either by Conventional Side Slope Definition or by using the Typical Section 
Generator tool.  

15.3.5.2 CONVENTIONAL SIDE SLOPE DEFINITION 
To set up the side slopes conditions by conventional methods, the user needs to choose the 
Define button from the shape clusters dialog box.  The define button is available once a shape 
cluster is added. 
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When choosing the Define button the following dialog box is displayed 
 

 
 
The user can choose Side Slope LT, Side Slope RT, or Offset Minus/Plus Side Slope LT/RT. 
 
Certain conditions such as Station > 5+000, or Median Width <= 7.2 can be set up to apply the 
side slope information if those conditions are met.  For example, the side slope condition Side 
Slope LT where Station >= 15+00 and Station <= 23+00 would apply the specified criteria files 
(criteria files are discussed later) to the left side of the shape cluster only between and including 
stations 15+00 and 23+00. 
 
It is important to remember that the side slope conditions pertain to the left or right side of the 
shape cluster, not the left or right side of the baseline. 
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15.3.5.3 CRITERIA FILE 
For each Side Slope Condition criteria files are added based upon the type of features to be 
drawn in the cross-sections.  Criteria files will be covered in Section 15.4. 
 

15.3.5.4 TYPICAL SECTION GENERATOR 
 
The Typical Section Generator (TSG) tool allows the user to select a picture representing the 
project typical section to set up the side slope conditions and appropriate criteria files.  This tool 
is designed for accommodating 90% of project cases.   
 
The TSG is a powerful and versatile tool.  It can be used for both rural sections, urban sections or 
a combination of the two.  Similarly, this tool can be used for both bituminous and rigid 
pavement as well as a combination of the two within the same project.  The tool allows the user 
to select a particular typical section for one or multiple station ranges.   
 
The TSG works by searching for plan view elements and then it draws the proposed cross section 
elements based on the typical section selected and the plan view elements found.  Therefore, it is 
required placing ALL plan view elements using the Design and Computation Manager (D&C 
Manager).  Each typical section has a Help File, which specifies the D&C Manager path to all 
available plan view elements.  These help files can be accessed through the CADD Support 
internal web page. 
 
To access the Typical Section Generator, select the Typical button in the dialog box below. 
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The Typical Section dialog box opens and it is displayed below 
 

 
 
The user has a list of ten (10) different typical sections from which to choose.  Each typical 
section has a picture and a description, which can be accessed by clicking on the Description 
button.  The description shows in great detail what plan view elements are required in order for 
the typical section generator to work.  In addition, it explains all the define and redefinable 
variables.  Define Variables and Redefinable Variables are explained in Section 15.3.7 & 
Section 15.3.8 respectively. 
 
The dialog offers information such as the job number and how many shape clusters are required 
for using the individual template.  When the template requires two (2) shape clusters, the user 
will be required to apply the typical section to both sides of the roadway.  It is imperative that the 
roadway template is applied to the left of the roadway first. 
 
In addition, the user has the option to apply the selected typical section to either the whole chain 
or a particular station range.  The user will also have the option to choose a particular chain.  
Note that if using working alignment definition, choosing a chain will not be necessary. 
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When the apply button is selected in the TSG, the side slope conditions are automatically 
populated with the appropriate criteria files. 
 

 
 

15.3.6 Define DGN Variables 
The Define DGN Variables option allows the user to define how to locate Microstation 
elements used by the criteria files.  Define DGN Variables can be determined from the element 
symbology, or from the symbology and attributes assigned in the D&C Manager database.  
MoDOT users do not need to define the DGN Variables.  These are defined within the criteria 
files. 

15.3.7 Define Variables 
Define Variables are variables that allow the user to enter certain information regarding plan 
view elements, special chains and profiles, and Microstation files to be used as well as the 
appropriate scale used for text and symbol size. The user can select the variable from the list, 
then enter the value and select the Modify button.  
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15.3.8 Redefinable Variables 
Redefinable Variables are variables that allow the user to enter job specific values for certain 
items to be drawn with the typical section generator.  Some of these items include, but are not 
limited to type of pavement, pavement thickness, type and thickness of shoulders, ditch width, 
side slopes, etc.  These variables can be “redefined” for various station ranges.  The variable 
displayed will depend on the typical section selected.   
 

 
 
Each redefinable variable is set to a default value.  The user selects the variable from the list and 
click on the Edit button to input the appropriate value for the specific project.  The editor opens 
and the user can edit the value. 
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15.3.9 Plot Parameters 
Plot Parameters allow the user to determine how the data from the superelevation shapes are 
going to appear.  XS Lines determine the symbology of the pavement surface.  Text plots 
various pieces of text relating to the cross-section.  Plot allows the user to control different 
aspects relating to the cross-sections and criteria files.  The Plot Parameters dialog box is 
displayed below. 
 

 
 
Pavement Thickness will plot a depth of pavement below the pavement surface.  MoDOT users 
should leave this value at 0.0.  The pvmt_layers.x criteria file should be used to draw the depth 
of pavement. 
 
Fill Gaps Between Clusters will draw a line between two shape clusters if the criteria does not 
fill between them. 
 
Transition Definition defines the use of superelevation parabolic transitions.  MoDOT users 
should use the ALL option. 
 
Intersect Between Clusters will extend or trim elements in a median to create a finished, clean 
appearance. 
 
Process Clusters as Indicated will force the criteria to process the clusters as they are listed in 
the Shape Clusters dialog.  If this option is turned off, the clusters will be processed left to right. 
 
Remove Skew Effect will force Geopak to correct itself back to the pattern line if a skewed 
element is encountered in the processing of the criteria files. 
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Process Only Sections With Existing Ground will process the proposed cross sections for only 
those cross section cells that have existing ground drawn. 

15.3.10  Drainage 
The Drainage section allows the user to draw the drainage components into the cross sections.  
The drainage .dgn file, and the drainage project database must be specified. 
 

15.3.11  File Menu 
Under Files, the options are Run, Save Settings, Export... and Exit.  To process 
the cross-sections, press the Run button, which invokes the Process Cross 
Section dialog.  Save Settings simply saves the current settings to the run, and 
can be recalled at a later time.  When the File > Export option is selected, the 
user may save the dialog information in an ASCII input file for subsequent 
processing.  The File > Exit option enables the user to exit the Proposed Cross 
Sections dialog box.  The software also prompts the user with an Alert box if the 

settings should be saved before exiting.  Pressing the Yes button will save the current dialog 
settings, No will not save the settings, but both buttons will exit to the Project Manager. 

15.3.12  Process Cross Sections 
When File >> Run is chosen, the dialog to the 
right appears.  
 
The output can be displayed on the screen only, or 
written to a log file and displayed to the screen.  
The Pause On Each Section option allows the 
user to view each section as it is drawn.  Criteria 
View displays each step in the criteria file.  This is 
primarily for debugging purposes. 
 

15.4 Criteria Files 

One of the most powerful and flexible features of GEOPAK is the use of criteria in generating 
proposed cross-sections.  Within criteria, design conditions can be evaluated and complicated 
design decisions executed in response to these design conditions.  The flexibility of criteria 
allows the designer to make the design as basic or as complex as the project requires.  Numerous 
baselines can interrelate as ditches and medians are drawn between roadways and ramps. 
Sophisticated drainage details can also be drawn with criteria.  The list is endless. 
  
Cross-section criteria are used to draw cross-section features outside of the mosaic of 
superelevation shapes typically representing pavement.  Operationally, the software constructs 
the cross-section features derived from the mosaic of shapes first.  Then, the software constructs 
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the remaining portions of the cross-section through the application of criteria emanating out from 
the outer edges of the mosaic of shapes.   
 
MoDOT users do not need to know how to write criteria.  A criteria library has been established.  
As users encounter situations that require a new criteria file, they should contact the CADD 
Support Center to have that criteria file written. 
 
Note: Criteria files written or modified outside of the CADD Support Center, and criteria writing 
WILL NOT BE SUPPORTED. 

15.4.1 MoDOT’s Traditional Criteria Library 
MoDOT’s criteria library is located in the directory t:\gpk_std\criteria.  Within the Shape 
Clusters section of the Proposed Cross Section dialog, the user can choose the Add button in 
the Criteria File portion of the dialog box.  The following dialog will appear. 
 

 
 
The user simply selects the criteria file to be included, and then clicks the To Criteria button.  
The criteria files must be listed in the order they are to be processed.  Once they are selected, 
they can be re-arranged within the Proposed Cross Sections dialog box. 
 
With each run, the Setup.x criteria file must be chosen as the first criteria file in each side slope 
condition.  This file allows the user to choose the plotting scale and the files that are being used 
for the plan, shape, and cross-section information.  This data is required for other criteria files. 
 
The criteria files will have a short description to help identify what they will do.  The criteria file 
name will also give a basic idea of what the criteria file is.  For example, cg_b_c.x will draw a 
type B curb and gutter and cap the edge of pavement as concrete (vertical line).  The file 
cg_b_a.x will draw a type B curb and gutter and cap the edge of pavement as asphalt.  Help 
documents are available on the intranet for further information on the criteria library.   

15.4.2 MoDOT’s TSG Criteria Library 
MoDOT’s typical section criteria library is located in the directory t:\gpk_std\typicals. 
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Exercise 15-1 

This begins a series of exercises that will demonstrate another method for determining bridge 
length, which will by using cross-sections.  The proposed cross sections for Route50 are drawN 
in this group exercise.  Later exercises will use these and other cross sections to create a 
proposed TIN and determine the bridge length from this surface model. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_50_j5p0100.dgn.  

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 

 

3. Select the Route50 working alignment. 

 

4. Choose Proposed Cross Sections from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to Route50, and open the Route50 run. 
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5. Be sure the following items are set in the given sections of the dialog: 
 
XS DGN File: xs_50_j5p0100.dgn 
Pattern: Use Working Alignment Definition 
Existing Ground: Use Working Alignment Definition 
Shapes: Use Working Alignment Definition 

 

6. In the Shape Clusters section of the dialog, choose the Scan button.  Add the two shape 
clusters in the following order: 
 
 Chain Tie Profile 
 ROUTE50 -30 ROUTE50PR 
 ROUTE50 30 ROUTE50PR 
 
The clusters are added by highlighting a cluster in the top dialog shown below and clicking 
on Add in the Proposed Cross Sections dialog, which is depicted in the bottom figure.  When 
you are finished adding the Shape Clusters, close the List of Cluster dialog by clicking on 
Close at the bottom of the dialog.  Leave the Proposed Cross Sections – Route50 dialog 
open.  Information will be added to it in the next step. 
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7. Highlight the left cluster and click on the Typical button.  
 

 
 

 
This displays the Typical Sections dialog shown below. Select the Divided New Pavement 
template, which is highlighted in the list box in the lower left hand corner, as shown in the 
figure.  In the Template section of the dialog, select: Apply to the Left Roadway.  Clicking 
on the Description button will launch the help file for this typical section.   
 
Once the dialog is set as shown below, click on the Apply button to add the required criteria 
files to the side slope condition. 

 

 
 

Select Yes To All if you are asked if you wish to overwrite any of the criteria files 
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8. Highlight the right cluster and click on the Typical button. 
 

 
 

Select the Divided New Pavement template again.  Chose Apply to the Right Roadway 
this time and click on Apply to add the required criteria files to the side slope condition. 

 

 
 

Select Yes to All when the following Alert appears. 
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9. Switch to the Define Variables section and change the following variable vales: 
 

CROSS SECTION DGN .......................................................xs_50_j5p0100.dgn 
PROPOSED PLAN DGN......................................................plan_50_j5p0100.dgn 
GEOPAK LINES DGN .........................................................pattern_shape_J5P0100.dgn 
XS SCALE.............................................................................10 
 
Leave the remaining variables set to the defaults. 

 

10. In the Redefinable Variables set the following values for the given variables. 
  

_s_PavementType STA >=0+00 R1 ^C^ 
_d_PavementLayer1Thick STA >=0+00 R1 10/12 
_d_NormalOutsideShoulderSlope STA >=0+00 R1 -2 
_d_ShoulderLayer1Thick STA >=0+00 R1 10/12 
_s_MedianType STA >=0+00 R1 2 
_d_DitchBackSlope_Left STA >=0+00 R1 2:1 
_d_DitchBackSlope_Right STA >=0+00 R1 2:1 
_d_FillSlope2_Left STA >=0+00 R1 2:-1 
_d_FillSlope2_Right STA >=0+00 R1 2:-1 
 
Leave all other variables with their default values. 

 
 

11. Save the Proposed Cross Sections run settings (Files > Save Settings). 
 
In the Proposed Cross Sections dialog, go to Files > Run.  This will bring up the following 
dialog: 

 
 

Set Log File to Screen Only and toggle on Pause on Each Section as shown above.  Press 
the Apply button to start drawing the cross sections.  After the first cross section is plotted, 
zoom in to see if the proposed surfaces are correct.  Toggle on Maintain Relative Window 
in the Process Cross Sections Display, as shown below if you wish the same zoom for the 
rest of the sections.  If the section plotted correctly, press the Continue button to draw the 
next section.  After you are satisfied the cross sections are OK, toggle off Pause on Each 
Section and press Continue to process the rest of the sections.  If the sections are not OK, 
click on Abort Run to stop the run in order to fix the problem. 
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16.1 Objectives 

• Learn how to use GEOPAK’s Port Viewer utility. 
 

16.2 Definitions 

The Port Viewer is a tool that enables the user to view and manipulate all three major aspects of 
a road design simultaneously, even though they are located in different files.  These include: 
 

• Plan  
• Profile 
• Cross-sections 

 
 

4/18/05 Missouri Department of Transportation 16-1 



Chapter 16 Port Viewer 

16.3 Accessing 

Prior to starting the Port Viewer the working alignment must be set up to include the plan view 
drawing file, centerline chain, profile view file, profile name and location, and cross-section 
view file. 
 
To access the Port Viewer, choose the Port Viewer button from the Road Project dialog. 

16.4 Dialog 

The Port Viewer dialog box allows the user to manipulate the views several different ways.  

16.4.1 Station, Offset, and Elevation Controls 
The user is able to key-in the Station they want to view.  The cross hairs 
in the plan and profile move to the keyed-in station, and the section view 
displays the cross-section nearest that station. 
 
The navigation buttons allow the user to navigate station by station (< or 
>), or to the beginning (<<) or ending (>>) station. 
 
The Offset option controls the location of the circle in the plan view and 
the vertical cross hair in the cross-section view. 
 
The Elevation option controls the location of the horizontal cross hairs in 
the profile and cross-section views. 
 

If the Portview TIN is defined in the Working Alignment definition, the DTM 
view can be substituted for the cross-section view.  The DTM view cuts a section 
at the location of the cross hairs in the plan view.  

16.4.2 Active View Control 
The Active View chooses the view to be used as the current file.  Any 
MicroStation drawing commands are executed in that file.  For instance, if 
you want to draw something in the cross sections, switch the Active View 
to XS View. 

 
Selecting the Set button allows the user to move the cursor to a view and move the cross hairs in 
that view.  As the user moves the cursor along the view, the other two views are updated 
according to the placement of the cursor in the current view. 
 
The DP button allows the user to issue a data point for a MicroStation command.  For example, 
if you wanted to draw a line at the given station and offset listed in the Port Viewer dialog, 
select the line tool, and press the DP button.  This begins a line at the given station and offset. 
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16.4.3 Menus 
The View menu at the top of the dialog box allows the user to fit one or all of the views, or to 
select the Active View.   
 

   
 
The Options menu has one item, Display.  The Display Options control which cross hairs to 
display (Plan, Profile, & XS), whether to center the Plan and Profile views, the symbology and 
offsets of the DTM section view (XS section of dialog), whether to Show Stations only at XS 
cell, the cross hair symbology (Marker Display), and how close the curser needs to be to the 
cross hairs to gain dynamic control (Dynamic-to-Cursor Sensitivity). 
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17.1 Objectives 

• Learn the procedures for calculating earthwork quantities with GEOPAK 
• Learn how to use Project Manager to set up and process an earthwork run. 

17.2 Definitions 

GEOPAK forms earthwork shapes in a design cross section .dgn file to represent the end areas 
used to calculate volumes.  These shapes are created when the designer processes an earthwork 
run in which the existing ground, finished grade, base, etc. are identified by level, color, weight 
and type, which is covered in this chapter.  For additional information, see the GEOPAK online 
help. 

17.3 Accessing 

To access the necessary dialogs needed to create and process an earthwork run, select Project 
Manager >> Earthwork.   

17.4 Dialog 

Once the Earthwork run is chosen, the following dialog box appears. 
 

 
 

The left side of the dialog contains the list of parameters required to compute earthwork.  When 
each parameter is selected, the dialog changes the keyin fields to reflect the selection.  For 
example, when EW Shapes is selected, the dialog changes as illustrated below. 
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17.4.1 XS DGN File 
In XS DGN File the user can specify the file name in which to find the cross-sections.   
 

 
 

Tolerance specifies the maximum distances between two elements to be considered as 
adjoining.   
 
Vertical Search Distance specifies the distance above and below the cross-section to look for 
elements pertaining to that cross-section.  (DO NOT CHANGE!)   
 
Baseline specifies the Geopak COGO chain the cross-sections are based from.   
 
Begin/End Station specifies the beginning and ending stations to perform the earthwork 
calculations. 

17.4.2 Soil Types 
The Soil Types dialog requires 
the user to define the 
symbology and shrinkage/swell 
factors to be used in defining 
each soil type.   
 
The user must first select the 
Class of the soil type.  The 
classifications are as follows.  
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Existing Ground – identifies the surface of the existing ground.  This classification is required 
to calculate earthwork. 
 
Existing Suitable – identifies material that is to be removed, but can be used for fill material.  
(I.e. rock) 
 
Existing Unsuitable – identifies material that is to be removed, but cannot be used for fill 
material.  (I.e. shale, muck, pavement, etc.) 
 
Proposed Finish Grade – identifies the surface of the proposed roadway.  This classification is 
required to calculate earthwork. 
 
Proposed Undercut – identifies proposed layers that are not part of the finish grade.  This soil 
type is not the material being removed, but what the area will be backfilled with.  (I.e. rock 
blanket) 
 
Excavation Limit –identifies the location to stop removing the existing suitable or unsuitable 
material.  Excavation limits can also be used to separate the areas of earthwork calculations for 
staged construction, multiple roadway cross sections, etc. 
 
Once the Classification is chosen, a Soil Type, the element symbology of the material, and the 
shrinkage/swell factors need to be entered.   
 
Note: Wild cards are supported in this dialog box, so for level name symbology a user can type 
in XS-Proposed* as a valid level name. 
 
A Classification, except Existing Ground, can be listed multiple times.  The Soil Type 
determines how the cut and fill are calculated.  For example, a user creates an earthwork run with 
a classification of Existing Ground with a soil type of Existing, classification of Proposed Finish 
Grade with a soil type of Suitable_Grading, and a classification of Proposed Undercut with a soil 
type of Pavement.  The output from the run would look as follows. 
 
 

Material Name  End Areas  Unadjusted  Adjusted  Mult Mass 
Station       Volumes  Volumes  Factor Ordinate 

(square  (cubic  (cubic                    
feet)  yards)  yards)                  

-------------------------------------------------------------------------------------------------------------------------------------------------------- 
449+00.00  SUITABLE_GRADING 

Excavation       0.00      0      0  1.00 
Fill   132.61  439  439  1.00 2887 

PAVEMENT 
Excavation      0.00      0      0  1.00 
Fill  315.81  960      0  0.00 2887 

EXISTING 
Excavation 278.57  855  855  1.00 
Fill      0.00      0      0  1.00 3541 
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In the same example, if both classifications of Existing Ground and Proposed Finish Grade had 
the soil type of Suitable_Grading, then the output would look as follows. 
 

Material Name  End Areas Unadjusted  Adjusted  Mult Mass 
Station       Volumes  Volumes  Factor Ordinate 

(square  (cubic  (cubic                    
meters)  meters)  meters)                  

---------------------------------------------------------------------------------------------------------------------------------------------------------- 
449+00.00  SUITABLE_GRADING 

Excavation 278.57  855  855  1.00 
Fill  132.61  439  439  1.00 3541 

PAVEMENT 
Excavation       0.00      0      0  1.00 
Fill  315.81  960      0  0.00 3541 

 
As can be seen from the above examples, when the soil types for the Existing Ground and 
Proposed Finish Grade classifications were named differently, both soil types appeared in the 
output.  When the soil types for the Existing Ground and Proposed Finish Grade classifications 
were named the same, the quantities for each classification were combined into one soil type.  By 
paying close attention to the soil types, the user can specify exactly where a specific soil type 
should be placed. 
 
Once the Classification and Soil Type are chosen, the user can select the Element Symbology 
to define that particular Soil Type and the Multiplication Factors for the Soil Type.  The 
Match button can be used to select the Element Symbology.  Once the Match button is 
selected, the user can select the elements in the Microstation view.  The symbology of that 
element will be added to the list of symbologies to be used to define the Soil Type. 
 
After the user selects the soil type symbologies, the Add button needs to be selected to add this 
soil type to the Soil Type Items list.  The items in this list can be modified or deleted by 
selecting the soil type item, making the changes, then selecting the Modify or Delete buttons. 

17.4.3 EW Shapes 
EW Shapes allows the earthwork shapes to be drawn and specifies the symbology to draw them 
with.  The colors of the earthwork shapes can be stratified, so that each soil type is a different 
color. 
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17.4.4 Output Format 
Output Format allows the user to specify which items to show in the earthwork report.  As the 
<> buttons are pressed, the Common Excavation, Subgrade Excavation, and Subsoil Excavation 
are combined into a single quantity. 
 

 
 
Common Excavation volumes are not backfilled with an earthwork material.  This includes the 
excavation required for cut sections as well as for pavement thickness, shoulder thickness, etc. 
 
Subgrade excavation volumes are backfilled with an earthwork material. 
 
Subsoil excavation - excavation required to remove unsuitable material down to the bottom of 
the proposed template. 
 
Accum Adjust Volume Column will add a column to the earthwork quantities report to show 
the accumulated adjusted volume.  This provides a running total for the adjusted volumes. 
 
Accum Unadjust Volume Column will add a column to the earthwork quantities report to show 
the accumulated unadjusted volume.  This provides a running total for the unadjusted volumes. 
 
Calc Only Between Exc Limits will calculate the earthwork only between the excavation limit 
lines as specified in the Soil Types section.  This can be used to calculate earthwork quantities 
for staged construction, individual roadbeds in a multiple roadbed section, etc. 
 
End Area Dec Places sets the number of decimal places to display in the earthwork quantities 
report. 
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17.4.5 Add/Sub Vol 
Add/Sub Volumes allows the user to enter positive or negative add volumes.  The user can 
specify whether to add excavation or fill, the soil type, the station, and the volume to be added. 
 

 
 

17.4.6 Centroid Adj 
Centroid Adjustment allows the user to use the measurement between the centroids of the 
endarea as the distance between sections instead of the centerline distance.  MoDOT does not use 
the Centroid Adjustment method of calculating endarea volumes except in areas where there 
are extremely deep cuts or high fills. 
 

17.4.7 Skip Areas 
Skip Areas allows a user to specify an area (i.e. bridge exception) in which to not calculate 
earthwork volumes.  The user needs to specify the Begin Station and End Station of the Skip 
Area. 
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17.4.8 Sheet Quant. 
Sheet Quantities allows a user to write an earthwork quantity file to be used when plotting the 
cross-section sheets. 
 

 
 
The name of the ASCII file can be chosen or entered.  The user then selects the columns in 
which to place the quantity, the number of decimal places, the total column width, the soil type, 
the earthwork operation, and the type of quantity. 
 
For MoDOT, the cross section sheets are set up to plot the information in the proper location on 
the cross section sheets, the quantities should be set up as follows. 
 

Column Soil Type EW Operation  Quantity Type  +/-
 1  ClassA  Common Exc  Endarea  + 
 1  ClassA  Subgrade Exc  Endarea  + 
 1  ClassA  Subsoil Exc  Endarea  + 
 2  ClassA  Fill   Endarea  + 
 3  ClassA  Common Exc  Unadjusted Volumes + 
 3  ClassA  Subgrade Exc  Unadjusted Volumes + 
 3  ClassA  Subsoil Exc  Unadjusted Volumes + 
 4  ClassA  Fill   Unadjusted Volumes + 
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If Class C quantities are being shown on the cross section sheets, the following columns should 
be added. 
 

Column Soil Type EW Operation  Quantity Type  +/-
 5  ClassC  Common Exc  Endarea  + 
 5  ClassC  Subgrade Exc  Endarea  + 
 5  ClassC  Subsoil Exc  Endarea  + 
 6  ClassC  Common Exc  Unadjusted Volumes + 
 6  ClassC  Subgrade Exc  Unadjusted Volumes + 
 6  ClassC  Subsoil Exc  Unadjusted Volumes + 
 
This information is written to the ASCII file, and can be used to plot the quantities on the cross-
section sheets.  The process of plotting this data on the cross section sheets is covered in more 
detail in Chapter 18. 

17.4.9 File Menu 
From the Files menu, the Run option will process all parameters that have been 
set in the Earthwork dialog box.  The Save Settings option will save all 
information in the Earthwork dialog box.  The Export option will allow the u
to save the parameters in the Earthwork dialog box as an ASCII input file.  The 
Exit option will exit the Earthwork dialog box. 

ser 

 
 

17.4.10 Process Cross Sections 
After all necessary information has been entered the user has two options.  The preferred method 
of running the earthwork is to select the Run option. The following dialog box will appear and 
the user may proceed by entering a log file name, choosing the Pause On Each Section option 
and then selecting the Apply button.  The second method is to export the information as an 
ASCII input file, then use the Process Cross Sections tool.  
 

 
 
When processing the earthwork quantities, a .log file should be created.  This ASCII file will 
contain the earthwork quantities that the user will use to evaluate the earthwork. 
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Exercise 17-1 

This group exercise calculates the Class 1 and Class 2 excavation for Bents 3 & 4 of one of the 
Route 6 bridges.  The bents are spread footings on rock. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\xs_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

Enter the project as user userc and go into Road. 
 

3. Copy the Rte6 working alignment to Bents and enter that working alignment. 
 

 
 

4. Set the XS DGN File in the Working Alignment Definition (Under Cross Section View) to: 
xs_j2p0300.dgn, as shown in the following figure. 
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5. The figure from the Bridge Manual on the previous page shows the Class 1 & 2 excavation 
for footings in a streambed.  As noted there, Class 1 excavation covers all material above the 
excavation datum, and Class 2 is for all excavation below the datum.  Also, since the bents 
have footings on rock, the *** dimension in the figure is 6” (0.5’). 

 
The following figure shows a typical cross section for Bents 3 & 4.  The spacing and size of 
the square footings is the same for both bents, as is the excavation datum.  Only the elevation 
at the bottom of the footings varies from one bent to the next. 

 
 Based on these figures, excavation will extend out from the footings on all sides by 1.5’ (18”) 

and stop 0.5’ above the bottom of the footing in this extended area.  Directly under the 
footings, the excavation goes to the bottom of footing elevation.  Cross sections starting 1.5’ 
before each footing and ending 1.5’ after the end of each one have already been created in the 
MicroStation file.  The sections for Bent 3 go from Sta. 1294+33.375 thru Sta. 1294+45.375, 
while the sections for Bent 4 go from 1295+31.375 thru 1243+43.375. 

 
Cross sections of the footings have been added to each of the cross sections at the correct 
elevation.  Only the bottom of footing line has been added for the sections before and after 
the footing.  The excavation limits have also been added using a line drawn on level 60 using 
color 22.  This limit line stops 6” above the bottom of footing at Stations 1294+33.375, 
1294+34.855, 1294+43.905, & 1294+45.375 for Bent 3 and Stations 1295+31.375, 
1295+32.855, 1295+41.905, & 1295+43.375 for Bent 4.  The limit traces the bottom of the 
footing at all of the other sections.   

 
The excavation datum has been drawn in all cross sections at elevation 771.6 using a line on 
level “XS-Existing subsurface-sub layer 1” and color 10.  The earthwork run will be set up 
using these drawn elements plus the existing ground line on level “XS-Existing surface-
ground” and color 90. 
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6. Choose Earthwork from the Road Project dialog. 
 

 
 

Copy the MoDOT run to Bent3, and enter the run. 
 

 
 

7. In the XS DGN File section of the Earthwork dialog, set the following items: 
 
 Begin Station First Cross Section Station  
 End Station 1295+00 R 1 
 
The XS DGN File and Baseline have already been set by the Working Alignment Definition.   
The rest of the values are defaults, which do not need to be modified. 
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8. In the Soil Types section, created the following Soil Type Items:  
 
Class Soil Type Level Colors 
Existing Ground Class2 XS-Existing surface-ground 90 
Existing Suitable Class1 XS-Existing subsurface-sub layer 1 10 
Proposed Finish Grade Class1 XS-Proposed subsurface-compensating depth 22 
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9. Switch to the Output Format section of Earthwork and set the format to Excavation and 
Fill only, as shown below: 
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10. In the Sheet Quant. Section, toggle on the Write Sheet Quantities File. 
 

ASCII file:   bent3.txt 
 Decimal Places:   0 

Total Quantity Length  15 
 

 Col. Soil Type EW Operation Quantity Type +/- 
 1 Class1 Common Exec End Area + 
 1 Class1 Subgrade Exec End Area + 
 1 Class1 Subsoil Exec End Area + 
 2 Class1 Fill End Area + 
 3 Class1 Common Exec Unadjusted Volumes + 
 3 Class1 Subgrade Exec Unadjusted Volumes + 
 3 Class1 Subsoil Exec Unadjusted Volumes + 
 4 Class1 Fill Unadjusted Volumes + 
 5 Class2 Common Exec End Area + 
 5 Class2 Subgrade Exec End Area + 
 5 Class2 Subsoil Exec End Area + 
 6 Class2 Common Exec Unadjusted Volumes + 
 6 Class2 Subgrade Exec Unadjusted Volumes + 
 6 Class2 Subsoil Exec Unadjusted Volumes + 

 

 
 

11. Save the settings for the run (Files > Save Settings).   
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12. Run the earthwork run (Files > Run).  The following dialog will appear: 
 

 
 

Set the Log File to bent3.log. 

 

13. The end of the output for Bent 3 is shown below. 
 

1294+43.88 CLASS1 
    Excavation     168.52       10         10   1.00 
        Fill         0.00        0          0   1.00      168 
  CLASS2 
    Excavation     263.40       15         15   1.00 
        Fill         0.00        0          0   1.00      183 
 
1294+43.90 CLASS1 
    Excavation     168.37        0          0   1.00 
        Fill         0.00        0          0   1.00      183 
  CLASS2 
    Excavation     254.40        0          0   1.00 
        Fill         0.00        0          0   1.00      183 
 
1294+45.38 CLASS1 
    Excavation     157.00        9          9   1.00 
        Fill         0.00        0          0   1.00      192 
  CLASS2 
    Excavation     254.40       14         14   1.00 
        Fill         0.00        0          0   1.00      206 
 
           G R A N D     S U M M A R Y     T O T A L S 
         Material Name         Unadjusted Adjusted   Mult 
                               Volumes    Volumes    Factor 
                               (cu. yd.)  (cu. yd.) 
  ---------------------------- ---------- ---------- ------ 
  CLASS1 
                  Excavation         88         88   1.00 
                    Fill              0          0   1.00 
  CLASS2 
                  Excavation        118        118   1.00 
                    Fill              0          0   1.00 
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14. Repeat the process for Bent 4, by going back into Earthwork.  This time however, copy the 
Bent3 run and name it Bent4.  Go into the new run.  By copying the Bent3 run, everything is 
already set except for the station range and the name of the Sheet Quantity file. 

 

15. Under XS DGN File, change the station range to the following: 
 
 Begin Station 1295+31.38 R 1  
 End Station Last Cross Section Station 

 

 
 

16. In the Sheet Quant. section, name the file bent4.txt. 
 

 
 

17. Save the settings for the run (Files > Save Settings).   
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18. Run the earthwork run (Files > Run).  The following dialog will appear: 
 

 
 

Set the Log File to bent4.log. 

 

19. The end of the output for Bent 4 is shown below. 
 

1295+41.88 CLASS1 
    Excavation     243.03       13         13   1.00 
        Fill         0.00        0          0   1.00      177 
  CLASS2 
    Excavation     270.60       15         15   1.00 
        Fill         0.00        0          0   1.00      192 
 
1295+41.90 CLASS1 
    Excavation     243.08        0          0   1.00 
        Fill         0.00        0          0   1.00      192 
  CLASS2 
    Excavation     261.60        0          0   1.00 
        Fill         0.00        0          0   1.00      192 
 
1295+43.38 CLASS1 
    Excavation     246.77       13         13   1.00 
        Fill         0.00        0          0   1.00      205 
  CLASS2 
    Excavation     254.40       14         14   1.00 
        Fill         0.00        0          0   1.00      219 
 
           G R A N D     S U M M A R Y     T O T A L S 
         Material Name         Unadjusted Adjusted   Mult 
                               Volumes    Volumes    Factor 
                               (cu. yd.)  (cu. yd.) 
  ---------------------------- ---------- ---------- ------ 
  CLASS1 
                  Excavation        101        101   1.00 
                    Fill              0          0   1.00 
  CLASS2 
                  Excavation        118        118   1.00 
                    Fill              0          0   1.00 
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18.1 Objectives 

• Learn the procedures for laying out cross-section sheets. 

18.2 Accessing 

Prior to beginning the cross-section sheet layout process, the user will need to create a cross-
section sheet file.  There are six seed files the user can choose from when setting up the cross-
section sheet file: i_xs_shts_5.dgn, i_xs_shts_10.dgn, i_xs_shts_20.dgn, m_xs_shts_100.dgn, 
m_xs_shts_200.dgn, and m_xs_shts_50.dgn.  The user should choose the seed file that represents 
the scale the cross-sections will be plotted at. 
 
To access the necessary dialogs needed to process the cross-section sheet layout, select Project 
Manager >> Cross Section Sheets.  There is one MoDOT default run set up that users can 
copy.  The wanted sheet scale will be chosen once entering the run. 
 

 
 

18.3 Sheet Library 

A sheet library must be attached to the current session.  CADD Support has set up the runs so the 
MoDOT sheet library is automatically attached when selecting/copying any MoDOT default 
runs. 
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The sheet library supports the following scales: 
 

• 1”=10’   
• 1”=20’ 
• 1”=5’ 
• 1:100 (Metric) 
• 1:200 (Metric) 
• 1:50   (Metric) 
 

Only CADD Support is authorized to edit the MoDOT sheet library.  Any other sheet libraries 
will not be supported. 
 

18.4 Dialog 

Once entering a run, the dialog below appears. 
 

 
 
The sheet library contains all the parameters required to set up and cut sheets for the common 
sheet scales used for MoDOT projects.  The user will need to select the sheet scale wanted from 
Active Cross Section Sheet the pull down menu.   
 
The left side of the dialog contains the list of parameters required to draw the cross section 
sheets.  When each parameter is selected, the dialog changes the key-in fields to reflect the 
selection. 
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Most of the parameters should be left alone.  They are setup by the CADD Support Center, and 
are correct for the given scales.  Listed below are the items the user will need to change. 

18.4.1   XS DGN 
XS DGN defines the file in which the cross-sections are located, the baseline chain, and the 
station limits. 
 

 
 

18.4.2   Sheet DGN File 
The Sheet DGN File specifies which file the cross-section sheets will be placed in.  (Currently, 
the path to the Sheet DGN File including the file name is limited to 40 characters.  By using the 
working directory, the user can specify only the file name in the Sheet DGN File field to increase 
the length of the file name.)   
 
The Horizontal and Vertical Scales should be left at 1.0 regardless of what scale is being 
plotted.  The Reference Data Point coordinate should be left at 0, 0. 
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18.4.3   Earthwork Quantity Labels 
Earthwork Quantity Labels allows the user define the ASCII file that contains the earthwork 
quantity information, as well as toggle on/off the plotting of the earthwork quantities.  All the 
parameters are set, the user can type in the name of the Earthwork Quantity File in the field or 
browse by selecting the  icon. 
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18.4.4   Sheet Labels 
Sheet Labels allow the user place specific labels in the cross section sheet.  CADD Support has 
set up six labels for placing text in the sheet title block.  The pre-defined labels include: 
 

• Route No. 
• District No. 
• Sheet No. 
• Job No. 
• Contract ID 
• County 

 
The user is responsible for entering the appropriate text for each label.  To enter text for the pre-
defined labels, the user needs to double click in the Label field and do a File >> Save Settings.  
The pre-defined label must contain text in the label field, therefore, design users should leave the 
Contract ID as pre-defined so construction can easily replace the text with the appropriate 
contract number using the MicroStation Find/Replace tool. 
 

 
 
 

18.4.5  Files Menu 
 From the Files menu, the user can attach a Sheet Library.  
CADD Support has set up the runs so the MoDOT default sheet 
library is automatically attached when entering the run.  Only the 
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MoDOT default sheet library will be supported.  The Sheet option is used to create, delete or 
update any sheets to the library.  Any changes to the Sheet Library must be requested through 
CADD Support.  The Save Settings will save all information in the Cross Sections Sheets 
dialog box.  The Layout  Sheets option will process all parameters that have been set in the 
Cross Section Sheets dialog box.  The Exit option will exit the Cross Sections Sheets dialog 
box. 
 

18.4.6   Layout Sheets 
In the Geopak 2004 version of the cross section sheet generator, the Geopak cross sections are 
not longer copied to sheet.  Instead, each cross section is referenced into the sheets, thus 
eliminating the need to layout sheets after making changes to the original cross sections. 
 
The user can layout new sheets either by selecting the Layout Sheets option from the File menu 
or by selecting the Layout Sheet button in the cross section sheet composition dialog box. 
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Exercise 18-1 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\xs_j2p0300.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

Enter the project as user userc and go into Road. 

 

3. Select the Bents working alignment. 

 

4. Choose Cross Section Sheets from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to Bent3. 
 

 
 

Open the Bent3 run. 

 

5. Create a new MicroStation file.  Name the file xs_bent3_sheets.dgn, and put the file in the 
directory t:\ br-proj\a_geopak\d2\j2p0300\data \.  Use the seed file 
t:\standard\wsmod\design\seed-i\i_10_xs_100_sheets.dgn. 
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6. Be sure the following items are set in the XS DGN File section of the dialog: 
 
Active Cross Section Sheet I_10_XS_Sheets 
 XS DGN File xs_j2p0300.dgn 
 Chain RTE6 
 Begin Station First Cross Section Station 
 End Station 1295+00 R 1 

 

 
 

7. Select the Sheet DGN File to be the file xs_bent3_sheets.dgn created in step 5. 
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8. In the Earthwork Quantity Labels section, turn on the Earthwork Quant. Define option, 
and set the ASCII file to bent3.txt. 

 

 
 

9. Select the Sheet Labels section of the dialog and change the Label column for the following 
lines (Do not change the values for Sheet No and Contract ID): 
 
 Route 6 
 District 2 
 Job No. J2P0300 
 County GRUNDY 
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10. Save the settings for the run (File > Save Settings).   
 

 

11. Layout the sheets by either going to File > Layout Sheets or by clicking on the Layout 
Sheets button. 

 

12. Repeat the process for Bent 4, by going back into Cross Section Sheets.  This time however, 
copy the Bent3 run and name it Bent4.  Go into the new run.  By copying the Bent3 run, 
everything is already set except for the station range and the name of the files.  Use names 
relevant to Bent 4.  The earthwork quantities file is bent4.txt, for instance. 
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19.1 Objectives 

• Create various cross section reports: 
- for plan use (design elements and quantities) 
- as input for other programs and/or applications of GEOPAK 
- for construction layouts 

• Create and plot construction limits in the plan view. 

19.2 XS Reports Definitions 

The GEOPAK Cross Section Report Utility can extract up to sixteen different reports from 
original and design cross-sections.  For each report generated, the user must set the parameters of 
the existing and/or design cross sections.  GEOPAK also provides an option to make custom 
headers for each of the reports via the User pull down menu. 

19.3 XS Reports Accessing 

To access the XS Report select Project Manager >> Reports & XS 
Quantities.  

19.4 XS Reports Dialog 

From the XS Report dialog box select User >> 
Preferences; a Report Header dialog box will 
appear with all options ghosted out.  To activate 
the individual fields simply toggle on the box 

next to the desired field.  Once you have completed the dialog box, the 
information will be saved as an .hdr file.  This allows for the creation of 
a separate header for each type of report.  The tolerance field determines 
the maximum gap allowed between cross section elements.   
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19.5 Reports 

19.5.1 Blue and Red Top 
Based on the dialog box settings, GEOPAK determines the offset and elevation of a slope and its 
breakpoints.  Blue refers to the top of pavement and Red is the top of subgrade.  The user must 
determine this by indicating the level, color, weight and style for each surface. 

19.5.2 Clearing 
The Clearing Report is useful for obtaining clearing and grubbing quantities.  For each station, 
GEOPAK will list the clearing distance on each side of the chain and the width of any exception.  
You can obtain the results in meters squared and/or hectares.  Toggle boxes for Cut Slope 
Rounding, Additional Clearing in Cut and Fill, and Minimum Clearing Width are provided for 
increased control over the output. 
 
GEOPAK can also generate quantity sub-totals based on the value specified in Sub Every. 
 
To use the Except Width option, you must have an existing ASCII file that includes the 
Beginning and Ending Station and Exception Width. 
 
Once everything is set, you can output the information to an ASCII file 

19.5.3 Closure 
The Closure Report provides information on the intersection point between the user defined 
proposed finish grade and existing ground.  In addition to the ASCII report, the designer may 
instruct GEOPAK to close any gap either by drawing a vertical line between the endpoint of the 
proposed finish element and the existing ground or extending the slope of the last proposed 
element to intersect existing ground.  The procedure will not extend existing ground.  The 
Closure Report can be accessed within any Microstation cross section file by selecting Closure 
from the main XS Reports dialog 

19.5.4 DTM Input 
This process generates XYZ coordinates from cross section elements and places this information 
into an ASCII file for use in Geopak’s DTM package.  To use this dialog box simply enter the 
.gpk job number, chain name and station range.  GEOPAK will read the cross section elements 
based on level, weight, color and style. 

19.5.5  DTM Proposed 3D 
This report is similar to DTM Input except that you can set both original and proposed cross 
sections at the same time.  This report also differs in that it makes breaklines across the cross 
sections.  This report is mainly useful when making 3-D cross sections for modeling purposes. 
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19.5.6 HEC-2 
This process reads cross section elements and formats the information in an ASCII text file 
suitable for use in the HEC-2 hydraulic program. 

19.5.7  HEC RAS 
This process reads cross section elements and formats the information in an ASCII text file 
suitable for use in the HEC RAS hydraulic program. 

19.5.8 Multi-Line 
This report is useful in creating cross-sections for staged construction.  Begin by entering the job 
number, chain name and station limits.  Primary cross section element parameters must be 
completed before secondary element parameters.  This is important due to the order in which 
GEOPAK reads the information.  Once all the parameters have been entered, the new cross 
sections may be drawn to the design file or you may choose the display only option.  An ASCII 
text file will be generated. 

19.5.9 Profile Grade 
The Profile Grade Report is one of the most versatile reports available.  It prints existing 
ground and design grade elevations and low point elevations for each cross section.  
Additionally, this report has the ability to create horizontal and vertical alignments along the low 
points and store them directly into the .gpk.  Horizontal alignments created from this report will 
start with station 0+000 and have no curves. 

19.5.10 Radial Staking 
The Radial Staking Report is a specialized report created for the U.S. Federal Highway 
Administration (FHWA). 

19.5.11  RT 40 
The RT 40 Report produces RDS based RT40 data.  To use this dialog box simply fill in the job 
chain name, stationing range and the parameters of the cross section elements you wish to use. 

19.5.12 Seeding 
Other than the usual entries, the user must enter the parameters of the elements to be seeded. 
 
This dialog box includes slope and subtotal options as well as a way to limit the number of 
segments read (By-Pass Segments).  The user may also establish additional seeding 
specifications (Additional Distance). 
 
Once all of the settings are complete, the report is written to an ASCII output file for use in plan 
quantities.  
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19.5.13 Slope Stake 
The Slope Stake Report is a special format report developed for the FHWA.  This report 
generates offsets, elevations and superelevation information for each cross section.  To generate 
this report fill in the usual cross section parameters plus Subgrade and Hub Staking information. 
When complete, push Apply and the report is written into an ASCII file. 

19.5.14  Staking Detail 
The Staking Detail Report determines the tie down point between the proposed finished grade 
and the existing ground.  GEOPAK will list the right and left offset, elevation, slope of the finish 
grade and superelevation rate for each cross section.  To create this report, fill in the project 
information and desired cross section elements’ parameters.  Once complete, you have the choice 
between two formats, a FHWA ASCII report or a Montana DOT report (includes ditch 
elevations). 

19.5.15 WSPRO 
This report takes the cross section elements and turns them into an ASCII file in the WSPRO 
format for use as input in the WSPRO hydraulic analysis program. 

19.5.16  XS List 
This report creates a listing of elevations and offsets for each cross section element according to 
user defined parameters.  You have the option of creating either an original cross section list or a 
design cross section list.  These reports are very similar to RDS cross section lists. 
 
Note: For more information on the various reports and the dialogs, see the Geopak online 
help. 

19.6 Accessing Limits of Construction 

To access the Limits of Construction 
dialog, go to Project Manager >> Limits 
of Construction.  After the run is chosen, 
the following dialog opens.  
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19.7 Processing Limits of Construction 

The user can specify the .gpk job number, the centerline, and the file containing the plan view 
information.  The Working 
Alignment should fill the Existing 
Ground and the Proposed Finish 
Grade sections.   
 
The Parameters button opens the 
dialog box below.  The symbology for 
the cut, fill, and transition construction 
limits can be set in this dialog.  
 
The Place Construction Limit toggle 
allows the user to place various text strings along the construction limits.  Selecting the 
Parameters button, and making the desired changes in the dialog box shown below will set the 
symbology for these text strings. 
 
The Radius of Display field is the size of the display 
circle when Geopak is scanning the cross-sections. 
The last option in the main Limits of Construction 
dialog is the Tie Down Option.  There are two Tie 
Down Options.  If the All Tie Down option is set, all 
tie downs within a section are plotted.  (I.e. wide 
medians, outer roadways, ramps, etc. may have tie 
downs in between the limits of the main roadway, and 
the outer roadway or ramp.)  If the Outer Tie Down 
option is selected, then only the outmost tie downs are 
plotted.   
 
Once the Apply button is chosen, the limits of 
construction and the optional text are drawn into the 
plan view file. 
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Exercise 19-1 

This is a group exercise to demonstrate how stream cross sections can be plotted from both a 
digital terrain model (DTM) and the field surveyed survey chains.  Once the cross sections are 
plotted, the HEC-RAS cross-section report is used to create a data file that can be imported in to 
HEC-RAS. 
 
The minimum electronic information that the district contact needs to provide is the DTM stored 
as a TIN file and the survey points stored in a GPK file.  In most cases the district should be able 
to provide chains and profiles created from the survey information along with plots the chains 
and profiles in MicroStation.   
 

1. Open the MicroStation file:  
 t:\br-proj\a_geopak\d2\j2p0300\data\xs_HEC_RAS.dgn. 
Review the cross sections. 

 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj and enter it as 
userc. 

 

3. Copy the J2P0300 working alignment to HEC_RAS and enter that working alignment. 

 

4. Enter the Working Alignment Definition for HEC_RAS and change the following: 
 

Section Item Value 
Plan View Chain: Stream 
Cross Section View XS DGN File: xs_HEC_RAS.dgn 

 

 
 

Click OK to save the changes to the working alignment definition. 
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5. Choose Reports and XS Quantities from the Project Manager dialog. 
 

  
 

This will bring up the XS Report dialog shown to the right.  Select the  
HEC RAS report. 

 
The dialog shown below will appear.  Enter the information as shown: 

 

  
 

Double Click on the button outlined above to bring up the HEC RAS  
Select Element Symbology dialog.   
 
To extract the survey profiles, use the setting shown in the dialog below  
and on the left.  The settings in the dialog below and on the right are for  
the sections created from the TIN file.  Click the X in upper right corner  
of the dialog to close the dialog and accept the settings. 

 

   
 

Select Apply to generate the report. 
 
The report will be written to the working directory.  Open the report in Ultra Edit.  It is: 
 t:\br-proj\a_geopak\d2\j2p0300\data\HEC.geo. 

 
To import the data into HEC RAS, start the HEC RAS project and go to  
Edit > Geometric Data… in HEC RAS.  In the Geometric Data dialog,  
go to File > Import Geometry Data > GIS Format… and load the HEC.geo report. 
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20.1 Objectives 

• Create 3D cross sections from 2D cross sections  
• Interpolate between 3D cross sections to create B-spline surfaces 
• Use Drive Through to view the model 
• Place pavement markings on the 3D model 

20.2 Definitions 

Geopak 3D Modeling is a process of deriving three-dimensional cross sections from two-
dimensional cross sections and interpolating between the three-dimensional cross sections to 
create b-spline surfaces that represent the design. 

20.3 Prerequisites 

Before a 3D model can be extracted from 2D cross sections, there are a few prerequisites that 
must be met.  They are: 
 

• 2D design cross sections 
• Plan view graphics 
• 3D design file 

 
2D Design Cross Sections 
 
The user should have an existing design file where 2D cross sections are stored.  The user will 
need to know which levels contain the existing ground line and the proposed finished grade. 
 
Plan View Graphics 
 
The user must also have another 2D-design file containing plan view graphics.  The plan view 
graphics should include the elements specified in the Run.  For example, it should contain edge 
of pavement, chains, and pavement markings. 
 
3D Design File 
 
A blank 3D-design file must exist to store the 3D cross sections as they are generated.  Enter the 
3D-design file and attach the 2D-plan file as a reference file.  Save the settings of this file with 
only the Top View displayed. 
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20.4 3D Modeling Tools 

From a 3D-design file, access the 3D modeling tools by selecting 3D Models in Road 
Project dialog (shown to the right) or by selecting the 3D Models icon, which is the 
middle icon in the 3D Tools box shown below. 

 

 
 

The dialog box shown to the left will appear requiring a job 
number and chain name.  It contains the following tools: 
 
3D Alignment - draws elements into a 3D file at the correct 
coordinates, using the specified alignment and profile. 
 
3D Cross Sections - references your 2D cross section file and 
creates a 3D complex chain to represent the 3D cross sections. 

 
Interpolate Between Sections - interpolates between the 3D 
cross sections to create B-spline surfaces. 
 

Pavement Markings - adds pavement markings to a 3D model.  The pavement-marking tool 
scans pavement markings in a 2D file and draws the markings in the 3D file based on user 
defined parameters. 

20.5 3D Modeling Process 

1. Plot the 3D alignment in the MicroStation 3D file, and attach the plan view as a reference 
file. 

 
2. To add the 3D Cross Sections, GEOPAK opens the 2D cross section file, scans the cross 

sections and creates a complex line-string in the 3D-design file based on the cross sections in 
the 2D file. 

 
3. B-spline surfaces must be created using Interpolate Between Sections.  For a complete 

rendering, the model needs to be refined by adding additional surfaces to the model. 
 
4. Add the 3D Pavement Markings. 
 
The following subsections looks at each of these steps in more detail. 
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20.5.1 3D Alignment 
The first step is to plot a 3D alignment, which is a representation of the combined chain and 
profile.  To active this tool, click on 3D Alignment in the 3D Modeling Tools dialog.  This 
brings up the following dialog.  An offset from the chain can be specified as well as the 
horizontal and vertical scales and the symbology of the 3D alignment.  If the scales are not 
distorted, the alignment is plotted using true x, y, and z coordinates.  If the Vertical Scale differs 
from the Horizontal Scale, true x and y coordinates are used and the elevations are distorted. 
 

 
 
To complete step 3, the 3D alignment must touch each of the 3D cross sections.  The easiest way 
to make this happen is to plot the string at one of the profile grade alignment ties.  To set the 
symbology, double click in the Symbology preview to bring up the following dialog. 
 

 
 
Change the attributes by picking the desired option from list that appears when you click in one 
of the fields.  Click OK to save the changes and close the dialog or click Cancel to close the 
dialog without saving any changes. 
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20.5.2 3D Cross Sections 
The second step is to generate 3D Cross Sections:  To do this click on the 3D Cross Sections 
button in the 3D Modeling Tools dialog. 
 

• Enter the 2D cross-section file 
containing design cross-s
GEOPAK reads the file to 
determine the beginning and 
ending station of the cross-
sections.  These stations are 
automatically displayed in the 
dialog box; however, the user 
may key in a different range. 

ections; 

 
• Define the attribute information 

for Existing Ground Line and 
Proposed Finished Grade.  You 
can check the Level Symbology 
Search Criteria by holding 
your cursor over the icon for the Existing Ground Line and Proposed Finish Grade.  
Click on the icon to open the following dialogs, which allow you to change the settings. 

 

  
 

• Select Apply 
 
GEOPAK opens the 2D cross-section file and begins creating 3D complex line-strings from each 
cross-section.  Each 2D cross-section is highlighted as the line string is formed.  This gives the 
user a brief opportunity to check for errors.  When the process is complete, Geopak returns to the 
3D file to draw the cross-sections. 
 
A visual inspection of the 3D cross-sections should be performed to verify their integrity.  The 
colors of the 3D-line string should reflect the same colors as shown in the 2D-design cross 
section.  If an error has occurred, the user should return to the 2D-design cross-section file and 
fix the appropriate cross section(s) using GEOPAK and/or MicroStation.  Repeat the 3D cross-
section process for any revised cross-sections and review. 
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20.5.3 Interpolation Between Sections 
The third step is to interpolate between the 3D cross sections.   
 

 
 
The only Method supported for interpolating between cross-sections is Longitudinal.  It uses 
the attached 2D-plan view drawing is used for the longitudinal references. 
 
Beginning Station and Ending Station – These values which cross sections are used to create 
the b-spline surfaces.  The easiest way to set the values is to click on the Station button and data 
point (and accept) any where on the cross section for the desired beginning and ending stations.  
This will automatically fill the station values and the their offsets.  If surfaces are not to be 
created for the whole cross section, the DP buttons may be used to limit the width of the 
interpolation.. 
 
Highlight Applied Breaklines – This will highlight the breaklines used in the interpolation 
when activated. 
 
Select the Draw Surfaces bar at the bottom of the dialog box to begin the interpolation process.  
The user is encouraged to process a small range of cross sections until the entire project has been 
done.  When GEOPAK interpolates 3D cross sections, it projects like color to like color between 
cross-sections.  All MicroStation elements should maintain a consistent color scheme throughout 
the project.  For example, within a 2D file, all ditch slopes should be drawn using the same color, 
paved roadway with another color, etc.  If colors do not correspond, you will get a “Color 
Mismatch” error and the process will terminate.  There are two ways to correct this error: 

• Check the cross sections for an inconsistent color scheme, correct any errors, then 
regenerate the necessary cross sections, or 

• Activate the Force Color toggle; this will allow Geopak to ignore the color of the cross 
section elements and interpolate using only the specified color.  For this to work the DP 
buttons need to be used since each surface type (pavement, shoulder, curb face, foreslope, 
ditch, backslope, existing ground, etc.) needs to build separately. 
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20.5.4 Pavement Markings 
The fourth step is to place pavement markings in the 3D file by extracting graphic information 
from the plan view of a 2D file.  (Pavement markings created by copying parallel a complex 
element must be dropped before they can be included in a 3D model.).  This is an optional step 
and is not required to create the model. 
 

 
 
Enter the name of the 2D graphics file containing pavement markings. 
 
Provide Search Criteria by entering the graphic attributes of the pavement markings. 
 
Stripe Width reflects the actual width of the plan view stripe you want to create. 
 
Surface Elevation Offset is the distance from the B-spline surface the stripe shape is drawn.  
Special attention needs to be applied to this value.  If the distance is too low, the stripe may fade 
into the roadway; if the distance is too high, the stripe may cast a shadow on the road surface 
when the model is moved to a visualization software package.  It is desirable to place the stripe 
just above the surface.  Begin by using a value of 0.10; if adjustments are necessary, use small 
increments. 
 
Pavement Markings may be applied to an entire view or a fenced area by selecting the 
appropriate option.  If view is chosen, be sure to fit the view before processing. 
 

20.6 GEOPAK Drive Through 

GEOPAK Drive Through provides the user realistic visualization of 3D surfaces.  Select 
Applications >> Geopak Road >> 3D Tools >> Drive Through or choose the Drive Through 
icon shown below.  
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This brings up the Drive Through Window. 
 
The user must enter the Job Number and a Chain 
name.  The drive through will follow this chain with 
the applied Plan View Offset. 
 
Two options are available to define the distance the 
driver is from the roadway vertically: 

• Constant Elevation places the driver at a 
fixed elevation, as defined by the user, 
throughout the drive through process. 

• Vertical Offset places the driver at a 
specified distance above the model, meaning 
the elevation of the view changes with the 
elevation of the model. 

 
The Station value automatically displays the beginning station of the selected chain, which may 
be changed by user key-in. 
 
Step Increment defines the distance traveled between each camera view. 
 
Target Offset defines how far down the road the viewer is looking (the focal point). 
 
Pressing the Locate Starting Point button finds the first station on the alignment where a 3D 
graphic element is present.  This is a convenient way to locate the start of a model. 
 
View indicates the MicroStation view to be processed. 
 
Press the Apply bar to update the camera view to any changes in the settings or to apply the step 
increment.  Once the first view is displayed, the user may pan the view by moving the slide bar 
to the desired angle and pressing the Apply button. 
 
After viewing the model: 

• Restore the view by rotating to the top view. 
• Access the Settings >> View Attributes dialog box from the Microstation command 

window and toggle Camera off (automatically toggled on during drive through process). 
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